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Welcome to DB2 Connect

This book provides you with an easy start to installing and using the basic functions of
DB2 Connect.

Part 1  gives an overview of DB2 and DB2
Connect products.

Part 2  provides information on planning for
and installing DB2 Connect on OS/2, Windows
32-bit operating systems or Windows 3.x
workstations.

Part 3  provides information on using the Data
Sources Setup tool or the Client Configuration
Assistant to configure communications
between DB2 Connect and host systems.

Part 4  describes how to configure SNA
software manually.

Part 5  describes how to install and configure
DB2 Clients.

Part 6  describes how to use DB2 Universal
Database.

Part 7  describes the unattended installation of
DB2 Connect.

Part 8  describes configuring DRDA hosts to
accept connections from DB2 Connect.

Part 9  contains reference information and
describes viewing, printing, and ordering the
manuals that are provided in online format.

DB2
Universal
Database

 Conventions

This book uses these highlighting conventions:

¹ Boldface type  indicates commands or graphical user interface (GUI) controls such
as names of fields, folders, icons, or menu choices.

¹ Italics indicates variables that you should replace with a value. It is also used to
indicate book titles and to emphasize words.

¹ Monospace indicates file names, directory paths, and examples of text you enter
exactly as shown.
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This is a fast path icon. It tells you if you can skip sections to get to the "how
to" information. It is shown to indicate where you should go next.

This icon marks a tip. It provides additional information that can help you
complete a task.

Road Map to DB2 Connect Information

Use the following table to quickly find the information you need.

If you want to... Refer to...
Required
Reading?

Understand the different
options for deploying DB2
Connect in your network,

Chapter 1, “About DB2 Connect” on page 3 and
Chapter 3, “How to Use DB2 Connect in Your Network”
on page 13.

Optional.

Confirm that your system
meets the DB2 Connect
software and hardware
prerequisites,

“Software Requirements” on page 23 and “Disk
Requirements” on page 22.

Recommended.

Install DB2 Connect, the installation chapter for your environment and your
workstation's operating system:

 ¹ For OS/2:

– Chapter 5, “Installing DB2 Connect on OS/2
Systems” on page 29

– Chapter 26, “Unattended DB2 Installation on
OS/2 or Windows 3.x Operating Systems” on
page 189

¹ For Windows 32-bit operating systems:

– Chapter 6, “Installing DB2 Connect on Windows
32-bit Operating Systems” on page 33

– Chapter 27, “Unattended DB2 Installation on
Windows 32-bit Operating Systems” on
page 199

¹ For Windows 3.x systems:

– Chapter 7, “Installing DB2 Connect for
Windows 3.x” on page 41

– Chapter 26, “Unattended DB2 Installation on
OS/2 or Windows 3.x Operating Systems” on
page 189

Required.
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If you want to... Refer to...
Required
Reading?

Create SNA connections to
DRDA databases,

the chapter that applies to your workstation's operating
system and SNA communications subsystem:

 ¹ For OS/2:

– Chapter 9, “Configuring Host and AS/400
Connections on OS/2 and Windows NT
Workstations” on page 53

– Chapter 11, “Configuring Communications
Server for OS/2 for DB2 Connect for OS/2” on
page 61

¹ For Windows 32-bit operating systems:

– Chapter 9, “Configuring Host and AS/400
Connections on OS/2 and Windows NT
Workstations” on page 53

– Chapter 12, “Configuring Integrated SNA
Support Manually on Windows Workstations” on
page 77

– Chapter 14, “Configuring IBM Communications
Server for Windows NT” on page 93

– Chapter 15, “Configuring IBM Communications
Server for Windows NT SNA Client” on
page 105

– Chapter 16, “Configuring Microsoft SNA Server
Version 4.0 for Windows NT” on page 113

– Chapter 17, “Configuring Microsoft SNA Client”
on page 121

¹ For Windows 3.x:

– Chapter 8, “Configuring Host and AS/400
Connections on Windows 3.1 or 3.11
Workstations” on page 49

– Chapter 12, “Configuring Integrated SNA
Support Manually on Windows Workstations” on
page 77

– Chapter 17, “Configuring Microsoft SNA Client”
on page 121

Required.

Configure DB2 Connect
Personal Edition to
communicate with DB2
Universal Database servers,

Chapter 19, “Configuring Access to a Remote DB2
Server Using the Client Configuration Assistant” on
page 133.

Required, if you
will access DB2
Universal
Database
servers.

Use the DB2 components, Chapter 21, “Getting Started with DB2 Universal
Database” on page 141.

Recommended.
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If you want to... Refer to...
Required
Reading?

Control access,
authentication, passwords,
and user ID or username
management,

“Working with the System Administrative Group” on
page 143.

Recommended.

Use clients, Chapter 22, “Running Your Own Applications” on
page 147.

Recommended.

Bind applications and utilities
to DB2 for MVS/OS390, DB2
for AS/400, or DB2 for VM &
VSE to give applications
access to host data,

“Binding Database Utilities” on page 147. Required by you
or your database
administrator.

Set up a DB2 Call Level
Interface or ODBC
environment to enable ODBC
applications such as Lotus
Approach to access DB2
data,

“Running CLI/ODBC Programs” on page 149. Recommended if
you will use this
function.

Use the DB2 Command
Center or the DB2 command
line processor to enter SQL
statements or DB2
commands interactively,

Chapter 23, “Entering DB2 Commands and SQL
Statements” on page 161.

Recommended.

Prepare DRDA hosts to
accept connections from DB2
Connect,

Chapter 29, “Configuring DRDA Hosts for DB2 Connect”
on page 231.

Recommended
for your DRDA
and network
administrators.

Configure TCP/IP
connections to DB2 for
OS/390 databases,

“Configuring TCP/IP for DB2 for OS/390” on page 240

Print or view online
documentation,

“Printing the PostScript Books” on page 259 or “Viewing
Online Books” on page 258.

Recommended.

Learn about last-minute
changes to the product,

The Installation Notes that are on the CD-ROM or the
Release Notes that are installed with the products.

Recommended.
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Chapter 1. About DB2 Connect

DB2 is a relational database management system that is web-enabled with Java
support; scalable from single processors to clusters of symmetric multiprocessors; and
multimedia capable with image, audio, video, and text support.

IBM's DB2 for OS/390, DB2 for AS/400, and DB2 for VSE & VM databases continue to
be the systems of choice for managing most critical data for the world's largest
organizations. While these host and AS/400 databases manage the data, there is a
great demand to integrate this data with applications running on PCs, UNIX
workstations, and Apple Macintosh workstations.

| DB2 Connect Personal Edition, formerly known as DDCS Single User, enables
| applications on your OS/2, Windows 3.x, Windows 32-bit operating systems to directly
| access host databases stored on:

| ¹ DRDA servers: DB2 for MVS/ESA, DB2 for AS/400, DB2 for OS/390, DB2 for VSE
| & VM systems
| ¹ DB2 Universal Database servers, which are available for OS/2, Windows NT, and
| several UNIX systems.

DB2 Connect provides access to those databases in a cost-effective way by using a
standard architecture for managing distributed data, known as Distributed Relational
Database Architecture (DRDA). Use of DRDA allows your applications to establish a
fast connection to host and AS/400 databases without expensive host components or
proprietary gateways. DB2 Connect products provide a DRDA Application Requester
that can access DRDA Application Servers running on MVS, AS/400, OS/390, VM, and
VSE systems.

DB2 Connect products provide a run-time environment for database applications that
are written in C, C++, Java, COBOL, FORTRAN, SmallTalk, REXX, and other
programming languages. Programmers can use the latest tools, such as Microsoft
Visual Studio, Borland Delphi, and many others, to develop database applications using
the following Application Programming Interfaces (APIs):

 ¹ Microsoft ODBC
¹ DB2 Embedded SQL (both static and dynamic)
¹ DB2 Call Level Interface

|  ¹ Java Support(JDBC)
| ¹ Embedded SQL for Java (SQLJ)

This allows you to use a wide range of off-the-shelf or custom-developed database
applications, and provides application programmers with a broad selection of tools and
functions. For example, you can use DB2 Connect products with:

¹ Spreadsheets, such as Lotus 1-2-3 and Microsoft Excel, to analyze real-time data
without having the cost and complexity of data extract and import procedures.
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¹ Decision support tools, such as Business Objects, Intersolv Q+E Database Editor,
and Crystal Reports, to provide real-time information.

¹ Database products, such as Lotus Approach and Microsoft Access.

| ¹ Development tools, such as PowerSoft PowerBuilder, Microsoft VisualBasic, and
| Borland Delphi, to create client/server solutions.

DB2 Connect Personal Edition provides an integrated package that gives all of the tools
you need to be productive quickly. DB2 Connect Personal Edition includes:

¹ Direct host access without gateways or host components.

¹ Integrated SNA Support (except on OS/2), which gives you out-of-the-box
connectivity without the need to purchase extra network components.

¹ Highly optimized ODBC and JDBC drivers for instant support of thousands of
client-server and Java applications.

¹ A complimentary copy of the award-winning Lotus Approach to help you quickly
turn your host and AS/400 data into information you can use.

| Each copy of DB2 Connect Personal Edition provides separate versions of the code
| optimized for OS/2 and Windows 32-bit operating systems, as well as 16-bit versions
| for Windows 3.x. This means the copy of DB2 you purchased will serve you no matter
| which operating system you are using today or plan to move to in the future.

DB2 Connect Personal Edition is a member of the DB2 family of products, which
includes relational database systems, middleware, and application development tools.
The following is a list of other DB2 family products that are available separately:

DB2 Universal Database Workgroup Edition
| A relational database management system that enables local and remote client
| applications to create, update, control, and manage relational databases using

Structured Query Language (SQL), ODBC, JDBC, or CLI.

| This product is available for OS/2, Windows NT, and SCO UnixWare 7 only.

DB2 Universal Database Enterprise Edition
| A relational database management system that enables local and remote client
| applications to create, update, control, and manage relational databases using

Structured Query Language (SQL), ODBC, JDBC, or CLI. This product also includes
support for host and AS/400 connectivity. This product provides its users with access to
DB2 databases that reside on host systems such as MVS/ESA, OS/390, AS/400, VM,

| and VSE. This product is available for AIX, HP-UX, OS/2, SCO UnixWare 7, Solaris
| and Windows NT.

DB2 Application Developer's Kit
Contains a collection of DB2 Universal Database products, clients, DB2 Connect
products, DB2 Software Developer's Kits, and application development tools for all
supported operating systems.

The Application Developer's Kit gives you all the tools that you need to create
multimedia database applications that can run on a variety of platforms and can
connect to any DB2 server, including mainframe and AS/400 databases.

4 DB2 Connect Personal Edition Quick Beginnings  



DB2 Universal Database Personal Edition
Allows you to create and use local databases. DB2 Personal Edition can also act as
client to access remote DB2 servers. This product is available for the OS/2 and
Windows 32-bit operating systems only.

DB2 Connect Enterprise Edition
Provides access from clients on a network to DB2 databases residing on host systems
such as AS/400, MVS/ESA, OS/390, VM, and VSE. DB2 Connect Enterprise Edition is
available for the AIX, HP-UX, OS/2, Solaris, SCO UnixWare 7, and Windows NT. This
product was formerly known as DDCS Multi-User Gateway.

| DB2 Workgroup Edition, DB2 Enterprise Edition, DB2 Personal Edition, and
| DB2 Extended Enterprise Edition are commonly referred to as DB2 server
| or DB2 Universal Database throughout this book.

|  
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| Chapter 2. What's New in DB2 Connect
| Version 5.2?

| DB2 Connect Version Version 5.2 includes the following enhancements for the host and
| AS/400 DRDA functions:

| ¹ DCE Cell Directory support

| Users working with host and AS/400 databases servers now have additional
| options for providing database location information when using DCE Cell Directory
| support for implementations from IBM and Gradient. Refer to the Administration
| Guide for additional information.

| ¹ Enhanced password management

| DB2 Connect now permits users to change their passwords without having to log
| on to their database server. Users can now change their passwords in any one of
| four ways: by using the SQL CONNECT statement from the DB2 Command Line
| Processor, by requesting a password change from within the ODBC login dialog,
| by using the password change option of the Client Configuration Assistant, or by
| using the ATTACH command.

| In addition, application programmers can now take advantage of DB2 Connect
| enhanced password management to deliver more robust security mechanisms for
| their applications. The ability to change user passwords is provided for Embedded
| SQL, ODBC, and DB2 CLI, as well as for Java using both JDBC and SQLJ.

| For example, with this support, a user connected to a DB2 for OS/390 database
| server no longer has to sign on to TSO in order to change his or her password
| when it expires. Through DRDA, DB2 for OS/390 can change the password for
| you. The old password along with the new password and the verify password must
| be supplied by the user.

| If the security specified at the DB2 Connect EE gateway is DCS then a request to
| change the password is sent to the DRDA server. If the authentication specified is
| SERVER then the password on the gateway machine is changed.

| An additional benefit is that, with TCP/IP connections to the host, a separate LU
| definition is no longer required, as was the case with DB2 Connect Version 5.0.
| Refer to the DB2 Connect Enterprise Edition Quick Beginnings manual for
| additional information.

| ¹ Enhanced security failure notification

| Users connecting to host and AS/400 databases can now get additional information
| on the cause of security failures when they occur, for example as the result of an
| expired password. Refer to the DB2 Connect Quick Beginnings manuals for further
| information.
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| In addition, password change support is now supported through DRDA (see
| Enhanced password management above).

| ¹ Enhanced System/390 SYSPLEX exploitation

| DB2 Connect Enterprise Edition (EE), and the DB2 Connect component that is
| included in both DB2 UDB EE and DB2 UDB Extended - Enterprise Edition (EEE),
| can now provide enhanced load balancing and fault tolerance by routing
| connections to different nodes on a System/390 SYSPLEX. Some additional
| configuration considerations apply, and these are documented in the DB2 Connect
| Enterprise Edition Quick Beginnings manual.

| ¹ Optimized Catalog Access for ODBC and JDBC Applications

| A new tool db2ocat is provided on Windows 32-bit operating systems in order to
| assist customers to optimize system catalog searches for ODBC applications.

| DB2 Connect now offers a way to dramatically improve the performance of ODBC
| and JDBC applications that make extensive use of the system catalog. This
| improvement is provided using the CLISCHEMA parameter in the DB2CLI.INI file,
| which allows applications to use an ODBC-optimized catalog instead of the regular
| system catalog tables. In addition, a point-and-click utility that greatly simplifies the
| creation and maintenance of ODBC-optimized catalogs can be obtained by
| downloading db2ocat.zip from:

|  ftp://ftp.software.ibm.com/ps/products/db2/tools.

| ¹ Microsoft Transaction Server support

| DB2 family databases including host and AS/400 databases can now fully
| participate in distributed transactions managed by the Microsoft Transaction Server
| (MTS). Refer to the DB2 Connect Enterprise Edition Quick Beginnings manual for
| additional information.

| ¹ New BIND options (DYNAMICRULES)

| There are two new enumerated values for the DYNAMICRULES option of the BIND
| command. These two values: DEFINE, and INVOKE, are defined to specify the
| authorization identity to be used for the execution of a dynamic SQL statement in a
| user defined function (UDF) or in a stored procedure:

| DEFINE Indicates that the authorization identifier used for the execution of
| dynamic SQL is the definer of the UDF or stored procedure.

| INVOKE Indicates that the authorization identifier used for the execution of
| dynamic SQL is the invoker of the UDF or stored procedure.

| Refer to the Command Reference for further information.

| ¹ Set Client Information API enhancements

| A new Set Client Information API allows three-tier client/server or TP monitor
| applications to pass more specific information about the application end user to
| DB2 for OS/390.

| The new information includes the end user name supplied by server application,
| the workstation name, the application name, and the accounting string. This
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| information can now be reported by the DB2 for OS/390 DISPLAY THREAD
| command and it is available in DB2 for OS/390 accounting records. Previously, in
| three-tier environments, DB2 for OS/390 could only provide information about the
| server application and the individual authentication user ID , and not about the
| numerous end users who multiplex SQL queries on long-running connections.

| For additional information refer to the API Reference.

| ¹ SQLDescribeParam support for DB2 Connect

| With this enhancement, an application is now able to issue the SQLDescribeParam
| API call to retrieve parameter descriptions from a DB2 for OS/390 data source. For
| further information refer to What's New.

| ¹ Support for Bidirectional Languages

| DB2 Connect now provides support for bidirectional languages such as Arabic and
| Hebrew. Refer to the Administration Guide for more information about the nature of
| this support.

| For information on configuring DB2 Connect Version 5.2 for bidirectional languages
| please refer to the Release Notes for DB2 Connect Version 5.2.

| ¹ System Monitor enhancements

| The following System Monitor enhancements for DB2 Connect are provided in
| Version 5.2:

| 1. Enhancements to the sqlmonss API call and the LIST DCS APPLICATIONS
| command provide for the listing of seven new data elements: DCS application
| status, client login ID, client platform, client protocol, host CCSID, process ID
| of client application, and status change time.

| 2. New GET SNAPSHOT support for DB2 Connect at the database manager and
| application levels, where the application level reporting includes statement and
| transaction levels.

| 3. New SNAPSHOT support for DB2 Connect at the database level.

| Further information is provided in the DB2 Connect User's Guide .

| Information about detailed updates to the System Monitor Guide and Reference is
| contained in What's New.

| ¹ Two-phase commit support enhancements

| – In DB2 Connect Enterprise Edition Version 5.0, two-phase commit support
| over SNA connections using the DB2 Syncpoint Manager (SPM) was only
| available on AIX and OS/2. With DB2 Connect Enterprise Edition Version 5.2,
| this support is now extended to Windows NT. This support requires IBM
| eNetwork Communications Server for Windows NT Version 5.01 or higher.

| – Two-phase commit for XA applications was previously only supported over
| SNA connections, using the SPM. It is now also supported over TCP/IP
| connections using the SPM.

| Applications executed by Transaction Processing Monitors such as IBM
| TXSeries, CICS for Open Systems, Encina Monitor, and Microsoft Transaction
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| Server previously had to access host systems such as DB2 for OS/390 using
| SNA. With DB2 Connect Version 5.2, TCP/IP can now be used by these
| same applications. The DB2 Syncpoint Manager must be used to enable this
| new feature.

| For further information refer to your DB2 Connect Quick Beginnings manual.

| ¹ Simplified DB2 Syncpoint Manager Configuration

| DB2 Syncpoint Manager configuration has been simplified. Many steps are now
| automated or eliminated compared to previous releases. Please refer to your DB2
| Connect Quick Beginnings manual.

| ¹ Support for the SCO** operating system

| DB2 Connect Enterprise Edition Version 5.2 is available for the SCO operating
| system.

| ¹ Support for Big Integer, Large Object, Row ID, and User Defined Distinct data
| types.

| DB2 Connect Version 5.2 now provides support for Big Integer, Large Object, Row
| ID, and User Defined Distinct data types. Refer to the SQL Reference for more
| details.

| ¹ Enhancements to the Client Configuration Assistant:

| – In V5.2 you can use the Client Configuration Assistant (CCA) to configure
| TCP/IP connections to DB2 for VM and DB2 for AS/400 database servers.

| – You can also use the CCA to configure IBM Communications Server for NT
| (CS/NT) and IBM Personal Communications (PComm) SNA stacks if you are
| using an SNA network.

| DB2 Connect Version 5

| ¹ New easier to purchase packaging:

| – A single DB2 Connect Personal Edition package that contains OS/2, Windows
| 3.1, Windows 95, Windows 98 and Windows NT versions of the product. This
| package contains everything that is needed to get started, including a
| complimentary copy of Lotus Approach.

| – A single DB2 Connect Enterprise Edition package that contains OS/2,
| Windows NT, and all UNIX versions.

|  ¹ Capability:

| – New Level 3 ODBC driver with many improvements

| – Updated JDBC driver for better Java support
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| – Support for stored procedures that return multi-row result sets and multiple
| result sets (requires DB2 for OS/390 Version 5.1 or higher)

| – Built-in replication support

| – Generic bind option: you can specify any bind option supported by the host
| database.

| – SYSPLEX exploitation (DB2 Connect Enterprise Edition only; requires DB2 for
| OS/390 Version 5.1 or higher)

|  ¹ Usability:

| – New installation method

| – TCP/IP database connections are much easier to configure (requires DB2 for
| OS/390 Version 5.1 or higher, or DB2 for AS/400 Version 4.2)

| – Integrated SNA support with point-and click configuration (DB2 Connect
| Personal Edition only)

| – New point and click configuration utility for configuring host connections.

| – Much easier process for connecting desktop client systems to DB2 Connect
| Enterprise Edition servers. Clients can discover DB2 Connect servers and all
| of the databases that are defined on each server

| – Improved ODBC traces with detailed information for performance analysis

| – Control Center and other GUI tools that simplify several DBA tasks

|  ¹ Security:

| – DCE security (requires DB2 for OS/390 Version 5.1 or higher)

| – Ability to run ODBC applications without having to authorize each user to base
| tables. Users can now bind their ODBC driver in such a way as to allow
| applications to run under the authority of the person that bound the ODBC
| driver.

|  ¹ Performance:

| – Faster access to the DB2 catalog for ODBC applications

| – Reduced network traffic:

| - Early close for cursors

|  - Deferred prepare

| - Reduced byte count on Compound SQL

| - Several other network flow enhancements

| - Support for ASCII storage on the host (requires DB2 for OS/390 Version
| 5.1 or higher)

|  ¹ Connectivity:

| – Support for DRDA over TCP/IP connections to other IBM DRDA Application
| Servers, as they introduce support for TCP/IP.
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| – SNA over TCP/IP via integrated MPTN support (requires AnyNet on the host).

| – Support for additional SNA connectivity options:

| - IBM Communication Server for Windows NT

| - IBM Personal Communications

|  ¹ Other:

| – Ability to initiate 2-phase commit transactions over TCP/IP (requires DB2 for
| OS/390 Version 5.1 or higher)

| – Ability for desktop applications to participate in a 2-phase commit transactions
| without the need for a gateway (TCP/IP only, requires DB2 for OS/390 V5.1 or
| higher)

| – Ability to use DB2 for OS/390 for added reliability of transaction coordination
| (requires DB2 for OS/390 Version 5.1 or higher, and TCP/IP)

| – Numerous other enhancements and fixes affecting all aspects of system
| performance, reliability, and usability.
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Chapter 3. How to Use DB2 Connect in
Your Network

Go directly to Chapter 5, “Installing DB2 Connect on OS/2 Systems” on page 29 or Chapter 6,
“Installing DB2 Connect on Windows 32-bit Operating Systems” on page 33 if you want to start
installing the product immediately.

Your network is a complex combination of hardware and software components, set up
to best fit the needs of your organization. DB2 Connect products provide several ways
of connecting to S/370, S/390, and AS/400 database servers to enable you to choose
the best way to connect your workstations to your host databases. This chapter
describes the following network configurations:

¹ Direct SNA connection from DB2 Connect to a DRDA host, such as DB2 for
MVS/ESA, using DB2 Connect Personal Edition.

¹ Indirect connection from DB2 Connect to a DRDA host via a communications
gateway, such as IBM Communications Server or Microsoft SNA Server.

| ¹ Server-based connection from DB2 clients to DRDA hosts via a DB2 Connect
| Enterprise Edition server.

| In addition to access to mainframe and AS/400 databases, DB2 Connect products can
| provide access to DB2 Universal Database servers. This chapter provides a brief
| description of such a configuration.

Note:  If is important that you decide which of the network configurations applies to
your environment. This is a required step in setting up connectivity to your
database servers.

| Direct Connection to a Host or AS/400
| Server

| Direct connection without intermediate gateways and servers is a very convenient and
| desirable configuration. This is especially true for situations where the host or the
| AS/400 database supports TCP/IP connectivity (for example, DB2 for OS/390 V5.1 or
| later, or OS/400 V4 Release 2). In such a configuration, each DB2 Connect workstation
| establishes a direct TCP/IP connection to DB2 for OS/390 or, using the Integrated SNA
| Support, connects via APPC to DB2 for MVS and other host and AS/400 databases.
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| TCP/IP connectivity requires that the host database support TCP/IP. At this point, DB2
| for OS/390 V5.1, DB2/400 V4R2, and DB2 for VM V6.1 support native TCP/IP
| connections. An alternative to native TCP/IP is MPTN connectivity. MPTN connections
| require that IBM AnyNet products be installed on the target database system, but does
| not require the host database to provide native TCP/IP support.

Figure 1 shows workstations directly connected to a DRDA host. Each workstation has
DB2 Connect Personal Edition installed.

S/390, S/370

Windows 3.1 32-bit Windows

DB2 Connect Personal Edition

TCP/IP*

Asynch

SNA

Twinax**

Coax***
Ethernet

Token-ringSDLC

* Requires DB2 for
OS/390 V5.1

** For AS/400 only.

*** For host connections only.

**** APPC over TCP/IP (MPTN)
requires AnyNet on AS/400
or MVS host.

OS/2

MPTN****

DB2 for
VSE

DB2 for
OS/400

AS/400

DB2 for
VM

DB2 for
OS/390

Figure 1. Direct Connection Between DB2 Connect and a DRDA Host

In this environment, if you are using Windows 32-bit operating systems, you can use
the DB2 Connect Personal Edition Integrated SNA Support to connect directly to the
host servers. DB2 Connect Integrated SNA Support permits connections over a variety
of local and wide area networks, such as Token-Ring, Ethernet, SDLC, Twinax, Coax
and Asynchronous dial-up. The DB2 Connect Integrated SNA Support implements both
APPC and MPTN connections over networks using hosts and AS/400 systems that
have IBM AnyNet products installed. Users of OS/2 workstations can use IBM Personal
Communications for OS/2. IBM Communications Manager V1.11, or IBM
Communications Server for OS/2 to achieve direct APPC and MPTN connectivity.
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Connections via Communications Gateway

Some organizations prefer to concentrate access to SNA networks through dedicated
SNA Gateways , such as IBM Communications Server, Microsoft SNA Server, or Novell
Netware for SAA. DB2 Connect products support connections through gateways, so this
can be a good choice if you need terminal emulation and other SNA services not
provided by DB2 Connect. Figure 2 on page 15 illustrates such a situation.

AS/400S/390, S/370

DB2 Connect Personal Edition with SNA Gateway Client Software

* For AS/400 only.

** For host connections only.
SNA Gateway

Windows NT

IPX/SPX, NetBIOS
TCP/IP, APPC

Channel Asynch SNA

Twinax*

Coax**
Ethernet

Token-ring
SDLC

(for example,  IBM Commumication
Server for NT, or Microsoft SNA Server)

DB2 for
OS/390

DB2 for
OS/400

DB2 for
VSE

DB2 for
VM

Windows 3.1 32-bit Windows OS/2

Figure 2. Indirect Connection to DRDA Host via SNA Communications Gateway

Although you can use DB2 Connect Personal Edition with SNA gateways, you may find
DB2 Connect Enterprise Edition a better choice if you want to use many DB2 Clients.
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DB2 Connect Enterprise Edition can be installed on the same machine as IBM
Communications Server or Microsoft SNA Server, and in many cases it can provide a
less expensive and better-performing solution. Figure 3 on page 17 provides an
overview of the DB2 Connect Enterprise Edition gateway scenario.

Contact your authorized IBM reseller for additional information about DB2 Connect
Enterprise Edition.

Connections via a DB2 Connect Enterprise
Edition Server

Figure 3 on page 17 illustrates IBM's solution for environments in which you want to
use a DB2 Client Application Enabler making an indirect connection to a DRDA host
through DB2 Connect Enterprise Edition server.

| All DB2 and DB2 Connect products include a Client Application Enabler component. In
| addition, Client Application Enablers for AIX, DOS, HP-UX, Macintosh, OS/2, SCO Unix
| Ware, Silicon Graphics, SINIX, Solaris, and Windows 32-bit operating systems are
| provided on separate CD-ROMs with all DB2 products except the Personal Edition
| versions.

This type of connectivity is most appropriate for environments where large numbers of
workstations need well-managed, secure access to host and AS/400 databases. It
allows database administrators to concentrate all access to host data through one or
more DB2 Connect servers.

| This type of a configuration is required for supporting applications that exploit
| transaction monitors (e.g. CICS, Encina, Tuxedo) as well as applications that are
| implemented as Java applets. This configuration is also the right choice for multi-tier
| applications for both traditional client-server as well as web application server
| environments.

| Although the DB2 Connect EE Server is often installed in an intermediate server
| machine to connect the DB2 CAE clients to the host, it is also installed in machines
| where multiple local users want to access the host or AS/400 servers directly. For
| example, the DB2 Connect EE may be installed in a large UNIX machine with many
| local users. It may also be installed in a large NT or UNIX Web server, TP monitor, or
| other 3-tier application server machine with multiple local SQL applicaton
| processes/threads. In these cases, you can choose to install DB2 Connect EE in the
| same machine for simplicity, or in a separate machine to off-load the CPU cycle.
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AS/400S/390, S/370

DB2 for
OS/390

DB2 for
OS/400

DB2 for
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DB2 for
VM

Actual connectivity options depend on the platform chosen.

DB2 Connect Enterprise Edition

(Available for OS/2, Windows NT,

and several UNIX workstations.)

APPC, IPX/SPX, NetBIOS, TCP/IP

TCP/IP*
Asynch SNA

Twinax**
Coax***

Ethernet

Token-ringSDLC

*  Requires DB2 for OS/390 V5.1.

** For AS/400 only.

*** For host connections only.

X.25

OS/2

Windows NT

UNIX

DB2 CAE
for OS/2
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for Windows-based
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DB2 CAE
for DOS

DB2 CAE
for Macintosh
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for UNIX-based
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Figure 3. Indirect Connection to DRDA Host via DB2 Connect Enterprise Edition
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Connections to DB2 Universal Database
Servers

Figure 4 illustrates a direct connection between a DB2 Universal Database server and
the DB2 Client Application Enabler software that is included in DB2 Connect Personal
Edition. You can use these connections concurrently with connections to DRDA hosts.

DB2 Universal Database servers are available for AIX, HP-UX, OS/2, Solaris, and
Windows NT.

DB2 Connect Personal Edition

OS/2 NT UNIX

DB2
Universal
Database
Server

IPX/SPX, NetBIOS, TCP/IP, APPC

Windows 3.1 32-bit Windows OS/2

Figure 4. Connection between DB2 Connect Personal Edition and a DB2 Server

18 DB2 Connect Personal Edition Quick Beginnings  



Part 2. DB2 Connect: Planning and
Installation
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Chapter 4. Planning for Installation

If you know that your system meets DB2 Connect's hardware and software requirements, and you
want to start installing DB2 Connect right away, go directly to either Chapter 5, “Installing DB2
Connect on OS/2 Systems” on page 29, Chapter 6, “Installing DB2 Connect on Windows 32-bit
Operating Systems” on page 33, or Chapter 7, “Installing DB2 Connect for Windows 3.x” on
page 41 .

DB2 Connect provides many components that you might want to use in your
environment. Use the product and planning information in this section to confirm that
your system has the prerequisites, and to decide which components you want to install.

 Memory Requirements

If you want to access host data from your local machine, use the configuration shown in
Figure 5. The diagram shows DB2 Connect Personal Edition installed on the system
and various local applications able to access data from host databases.

DB2 Connect Personal Edition - Memory Requirements
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Figure 5. Configuration for Accessing Host Databases Using DB2 Connect Personal Edition

The amount of memory you need on your system depends on the applications you
intend to run. We suggest that you have a minimum of 32 MB to access host
databases using DB2 Connect Personal Edition. Use this guideline to determine the
amount of memory necessary in your environment.
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 Disk Requirements

| This section shows the minimum amount of disk space that is required to install DB2
| products and components. It does not include the disk requirements necessary for the

operating system, application development tools, and communications products.
Consult each product's documentation for these values. Estimates for disk space
requirements are listed here; the actual amounts required depend on the functions you
are using. Use this information to plan for systems with a large number of concurrent
clients or databases. For information about space requirements for data, refer to the
Administration Guide.

Estimating Fixed Disk Requirements
To estimate the disk requirements for a particular configuration, add the recommended
minimum disk sizes for the products and components that you want to install. Include
an allowance for your application data.

 Server Components
Use Table 1 on page 23 to estimate the amount of disk space you need to install DB2
and associated components on your operating system.
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Note:  The disk amounts listed are approximations.

Table 1. Estimating Disk Requirements

DB2 Connect Personal Edition for OS/2

DB2 Connect — this amount includes the following components: 100 MB
¹ Client Configuration Assistant 5 MB

 ¹ Graphical Tools 5 MB
 ¹ Control Center 30 MB
 ¹ Performance Monitor 10 MB
 ¹ Visual Explain 5 MB
 ¹ Windows Support 10 MB
¹ East Asian Conversion Support 5 MB

  
Online documentation in HTML format 30 MB

DB2 Connect Personal Edition for Windows 95, or Windows NT

DB2 Connect — this amount includes the following components: 70 MB
¹ Graphical Tools (Client Configuration Assistant, Control Center,

Performance Monitor, and Visual Explain)
35 MB

¹ East Asian Conversion Support 5 MB
  
Online documentation in HTML format 30 MB

DB2 Connect Personal Edition for Windows 3.x

DB2 Connect 50 MB

Online documentation in HTML format 30 MB

¹ East Asian Conversion Support 5 MB

 Software Requirements

The following sections outline the software that is required to run DB2 Connect
Enterprise Edition or DB2 Connect Personal Edition on each of the supported operating
systems.

DB2 Connect Personal Edition relies on network software to provide connectivity to host
and AS/400 databases as well as to DB2 Universal Database servers. Therefore, it is
important to establish which network software you will use before proceeding with the
installation.

DB2 Connect Personal Edition uses communication software for establishing host
connectivity and connectivity to DB2 Universal Database servers. For the host
connectivity, your software requirements will depend on:

¹ The protocol that you will be using (APPC, TCP/IP, or MPTN)
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¹ Whether you will be using direct connection (see “Direct Connection to a Host or
AS/400 Server” on page 13) or connections via SNA gateway (see “Connections
via Communications Gateway” on page 15).

Software Requirements for OS/2 Users
DB2 Connect Personal Edition can be used on machines running one of the following
levels of the OS/2 operating system:

¹ OS/2 Warp Version 3 and Version 4
¹ OS/2 Warp Connect Version 3
¹ OS/2 Warp Server Version 4
¹ OS/2 Warp Server Advanced V4

| ¹ OS/2 Warp Server with SMP Feature

Because of DB2 Connect Personal Edition's requirement for communications, versions
of OS/2 with built-in communications capabilities, such as OS/2 Warp Connect, OS/2
Warp Server, OS/2 Warp Server Advanced and OS/2 Warp Version 4 are
recommended.

 Host Communications
For direct connection to host and AS/400 databases via SNA (APPC), one of the
following communications products is required:

¹ IBM Communication Manager for OS/2 V1.11
¹ IBM Communication Server for OS/2 Version 4
¹ IBM Personal Communications for OS/2 V4.1

For direct connections to host databases via TCP/IP, no additional software is required
for network-enabled versions of OS/2. Users of OS/2 Warp Version 3 require IBM
TCP/IP for OS/2 Version 3.0 or later.

For connections via communications gateway, see “Connections via Communications
Gateway” on page 15 and the documentation for your SNA gateway product that
described the enablement of OS/2 clients for APPC (LU6.2) communications.

Software Requirements for Windows NT Users
DB2 Connect Personal Edition can be used on machines running Windows NT 3.51 or
later version of the operating system. Both Windows NT workstation and Windows NT
server are supported.

| Windows NT supplies all the communication support required to establish TCP/IP,
| NetBIOS, Named Pipe and IPX/SPX connectivity. Therefore, no additional software is
| required for connecting to DB2 Universal Database servers.
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 Host Communications
For direct connection to host and AS/400 databases via SNA (APPC), and MPTN, DB2
Connect Personal Edition provides an Integrated SNA support. Alternately, one of the
following communication products can be used for connecting DB2 Connect Personal
Edition to host databases via SNA (APPC):

| ¹ IBM Personal Communications for Windows NT V4.2 or later
¹ IBM Communication Server for Windows NT V5 or later
¹ Microsoft SNA Server V2.11 or later
¹ Wall Data Rumba
¹ Other communications products that provide APPC connectivity and fully comply

with WinCPI-C specification

| For direct connections to host and AS/400 databases via TCP/IP, no additional software
| is required as Windows NT provides built-in TCP/IP support.

For connections via SNA gateway, see “Connections via Communications Gateway” on
page 15 and the documentation for your SNA gateway product that describes the
enablement of Windows NT clients for APPC (LU6.2) communications.

Software Requirements for Windows 95 and
Windows 98 Users

DB2 Connect Personal Edition can be used on machines running the Windows 95 and
Windows 98 operating systems.

Windows 95 and Windows 98 supply all the communication support required to
establish TCP/IP, NetBIOS, and IPX/SPX connectivity. Therefore, no additional software
is required for connecting to DB2 Universal Database servers.

 Host Communications
For direct connection to host and AS/400 databases via SNA (APPC), and MPTN, DB2
Connect Personal Edition provides an Integrated SNA support. Alternately, one of the
following communication products can be used for connecting to host databases via
SNA (APPC):

| ¹ IBM Personal Communications for Windows 95 V4.2 or later
¹ Wall Data Rumba
¹ Other communications products that provide APPC connectivity and fully comply

with WinCPI-C specification

For direct connections to host databases via TCP/IP, no additional software is required
as Windows provides built-in TCP/IP support.
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For connections via SNA gateway, see “Connections via Communications Gateway” on
page 15 and the documentation for your SNA gateway product that describes the
enablement of Windows clients for APPC (LU6.2) communications.

Software Requirements for Windows 3.1 and
Windows for Workgroups 3.11 Users

DB2 Connect Personal Edition can be used on machines running the Windows 3.1 and
Windows for Workgroups 3.11.

Because Windows for Workgroups 3.11 provides communication support for TCP/IP,
NetBIOS, and IPX/SPX connectivity, this version of the 16-bit Windows operating
system is preferable to Windows 3.1. When using Windows for Workgroups 3.11, no
additional software is required for connecting to DB2 Universal Database servers.

Windows 3.1 workstations require the following connectivity software:

¹ IPX/SPX – Novell Requester for DOS
¹ NetBIOS – IBM LAN Support Program, IBM DOS LAN requester or other NetBIOS

connectivity software
¹ TCP/IP – IBM TCP/IP for DOS V2.1.1 or any other TCP/IP product that conforms

to the WinSOCK V1.1 specification.

 Host Communications
For direct connection to host and AS/400 databases via SNA (APPC), and MPTN, DB2
Connect Personal Edition provides an Integrated SNA support.

For direct connections to host databases via TCP/IP, no additional software is required
as Windows for Workgroups V3.11 users who have obtained TCP/IP communications
subsystem from Microsoft. Windows 3.1 users can use any WinSOCK V1.1-compliant
TCP/IP product, such as IBM TCP/IP for DOS V2.1.1.

For connections via SNA gateway, see “Connections via Communications Gateway” on
page 15 and the documentation for your SNA gateway product that describes the
enablement of Windows 3.1 clients for APPC (LU6.2) communications.
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 Security Requirements

Since you will be accessing data managed by other systems, you will require a user ID
and password so that you can be authenticated by the system. To obtain these,
contact the administrator responsible for the system where the data resides.

In addition, to access to the system, you will require authorization to access data
objects on the target database server; for example, tables, views, and program
packages. To obtain the appropriate authorization, contact your database administrator.

An additional DB2 security mechanism called binding allows database administrators to
limit access to specific applications. This mechanism is used to build program packages
or plans. The database administrator then grants authority to users to execute these
packages.

If you will be running an application developed using embedded SQL, a package will be
supplied with your application. You must bind this package to each database that the
application will access. Package files are usually supplied with the file type “bnd.”
ODBC users do not bind individual applications; instead, they must bind the ODBC
diver itself to each database that will be accessed.

To bind applications or the ODBC driver, you require the following privileges on each
database:

DB2 for OS/390 or DB2 for MVS
BINADD privilege, plus CREATE IN COLLECTION NULLID,
SYSCTRL, or SYSADM authority.

DB2 for VSE & VM
DBA authority

DB2/400
*CHANGE authority or higher on the NULLID collection.

If your database administrator will not grant you these privileges, another user (usually
the administrator) must perform the required binds.
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Chapter 5. Installing DB2 Connect on OS/2
Systems

If you need to install software on many OS/2 systems, see Chapter 26, “Unattended DB2
Installation on OS/2 or Windows 3.x Operating Systems” on page 189.

This chapter describes how to install DB2 Connect on an OS/2 workstation.

| Before You Begin Installing on OS/2
| Operating Systems

Before you begin the installation, be sure that you have the following items and
information:

¹ The type of host connectivity that you want to use (a direct connection using DB2
Connect Personal Edition or a connection that uses an SNA gateway).

¹ The protocol to be used for host connectivity:

 – APPC
 – TCP/IP
 – MPTN

¹ A user ID that has local administrator or administrator authority in User Profile
Management (UPM). The Administration Server uses this user ID to log on when it
is started.

If UPM is installed, the user ID you specify must have Administrator or Local
Administrator authority. Create a user ID with these characteristics if necessary;
see Chapter 25, “Administering and Using OS/2 User Profile Management on OS/2
Systems” on page 179 for more information.

When prompted for this user ID and password during install, the user ID will be
checked to ensure that it exists, can logon, and has administrative authority on the
system. If the checks fail, install will not continue until a user ID and password are
properly verified. You can minimize the install window if necessary to create the
user ID, but it is recommended that this be done prior to starting the install.

If UPM is not installed, DB2 will install it, and the user ID and password entered
will be used to create a user ID with the correct authorities so that the
Administration Server can be logged on and started when the system is booted.
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¹ The names of the products you want and are licensed to install (see Table 2 on
page 30). To see descriptions of each of the products, see Chapter 1, “About DB2
Connect” on page 3.

¹ If you decide to install the Control Center, you must also decide whether you want
the Control Center to autostart. The Control Center is a graphical tool used to
perform the following DB2 administration tasks: managing databases, tables and
views; configuring systems; performing database backup and recovery; scheduling
jobs; and replicating data.

Selecting Products and Components
The following table lists the products and selectable components that you can install
with DB2 Connect Personal Edition.

Table 2. Products and Components for DB2 Connect Personal Edition

Product Components

DB2 Connect Personal Edition ¹ DB2 Connect Personal Edition
 ¹ Graphical Tools
¹ Client Configuration Assistant

 ¹ Control Center
 ¹ Performance Monitor
 ¹ Visual Explain
 ¹ Windows Support
 ¹ Documentation
¹ Japanese Conversion Support
¹ Korean Conversion Support
¹ Simplified Chinese Conversion Support
¹ Traditional Chinese Conversion Support

Ensure that you select DB2 Connect Personal Edition, not DB2 Universal
Database Personal Edition.

Performing the Installation on OS/2

 To install DB2 from CD-ROM, do the following:

1 Insert the CD-ROM in the drive.

2 There are two ways to begin the DB2 installation. These are:

¹ If you have the OS/2 Warp Server installed, double-click on the Server
Installation  icon located in the Server  folder on the desktop.

30 DB2 Connect Personal Edition Quick Beginnings  



OR

¹ Open an OS/2 windows and set the drive to x:, where x: represents your
CD-ROM drive.

¹ Set the current directory to \db2\language\install, where language is the

two-character country code that represents your language (for

example, EN for English). Table 16 on page 264 lists the codes for each
available language.

¹ Enter the command install .

3 The IBM DB2 for OS/2 Version 5 Installation window opens. Select the product
that you want to install on your system. Select the Install  radio button and then
click on the Continue  push button. Following is a sample of the window:

4 In the Update CONFIG.SYS File window, indicate whether or not you want to
update the config.sys file as part of the installation.

¹ If you want the config.sys file updated, click on OK. A backup copy of your
existing file is kept as config.0xx.

¹ If you do not want the config.sys file updated, clear the Update
CONFIG.SYS check box and click on OK. You will need to manually update
your config.sys file with the values that are stored in the config.add file that
will be created in the root directory of your boot drive.

You can invoke the install command with optional parameters to create error
and history log files. See “Step 3. Run the CMD/BAT File from the Remote
Workstation” on page 193 for more information.

  Chapter 5. Installing DB2 Connect on OS/2 Systems 31



5 The Install - Directories window provides a list of the product's components. You
can choose which of the components you want to install on your system.

For the Install - Directories window, complete the entries as follows:

a Select each of the components you want to install.

b Click on the Descriptions  button for a brief description of the selected
components.

c In the File directory  field, type the directory where you want the product
installed. The default value is c:\sqllib.

Note:  If a DB2 Version 5 product is already installed on the workstation,
you must install on the same drive and directory.

d Click on the Disk Space  button to see how much space you have on each
of the drives on your machine and to change disks if necessary.

e Click on the Install  button to continue.

6 The product and components you have chosen are installed on your system. A
progress window appears until the installation is complete.

7 A message appears when the installation is complete. Click on OK to dismiss the
message, shut down and reboot your system.

This completes the installation.

If DB2 fails to start after you reboot your system, see the file db2cnfg.out in
the x:\sqllib\misc directory, where x: is the drive where you installed
DB2. This file contains the results of database manager configuration
updates, and other actions necessary for automated startup upon reboot.

To set up connections to DRDA databases, see Chapter 9, “Configuring Host and AS/400
Connections on OS/2 and Windows NT Workstations” on page 53 or Chapter 11, “Configuring
Communications Server for OS/2 for DB2 Connect for OS/2” on page 61.
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Chapter 6. Installing DB2 Connect on
Windows 32-bit Operating Systems

If you need to install software on many 32-bit Windows systems, see Chapter 27, “Unattended
DB2 Installation on Windows 32-bit Operating Systems” on page 199.

This chapter describes how to install DB2 Connect on Windows 32-bit operating
systems.

Before You Begin Installing on Windows NT
and Windows 95

Read and perform the steps in this section before you begin the installation to ensure
that you have the items and information that you will need.

You need to ensure that you know the type of host connectivity that you want to use (a
direct connection using DB2 Connect Personal Edition or a connection that uses an
SNA gateway), and the protocol to be used for host connectivity:

 ¹ APPC

 ¹ TCP/IP

 ¹ MPTN

Creating Usernames for DB2 Installation and
Operation

This section describes the usernames required to install the DB2 product and its
components.
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Creating a Username for Installing DB2
Products

| Windows 95 and Windows 98
The username must be a valid DB2 username.

A valid DB2 username is eight characters or less, and complies with DB2's naming
rules. For more information on DB2's naming rules, see Appendix C, “Naming Rules”
on page 269.

Windows NT
You need to have a username that will be used to install DB2. The username may
belong to the Domain or local Administrators group.

This username will be removed from the system when the installation is
complete.

Selecting Products and Components

Choosing Which Optional Components to
Install
DB2 Connect offers the option of using APPC, TCP/IP, or MPTN protocols for host
connectivity. For your convenience, DB2 Connect Personal Edition includes an
Integrated SNA Support that provides APPC and MPTN connectivity. If you plan to use
only TCP/IP for your host connectivity, you do not need to install the Integrated SNA
Support. If you do choose to install Integrated SNA Support, you must ensure that you
have the Microsoft DLC driver installed on your workstation. See “Ensuring DLC is
Installed on Windows NT Workstations” on page 35 for instructions on installing the
DLC driver.

Note:  DB2 Connect Personal Edition for Windows NT and Windows 95 offers you the
option of installing Integrated SNA Support. If your workstation has SNA support
already installed, do not install Integrated SNA Support. Products that can
provide SNA support include:

¹ IBM Communications Server for NT V5

¹ IBM Communications Server for NT SNA Client

¹ PCOMM AS/400 and 3270 V4.1 or later

¹ Wall Data Rumba
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¹ Microsoft SNA Server

¹ Microsoft SNA Client.

The following table lists the products and selectable components that you can install on
DB2 Connect Personal Edition. For information on the products and components, see
Chapter 1, “About DB2 Connect” on page 3. The marks in the columns for Typical
Install  and Compact Install  indicate the components that are installed when these
types of install are used. If you want to install specific components and subcomponents,
you can choose the Compact Install  type. See “Performing the Installation on a
Windows 95 or Windows NT Workstation” on page 36 for more information on install
types.

Table 3. Products and Components for DB2 Connect Personal Edition for Windows 32-bit operating systems

Product Components and Subcomponents Typical
Install

Compact
Install

DB2 Connect Personal
Edition (Host Connect)

Ø Graphical Tools

Ø Client Configuration Assistant

Ø Control Center

Ø Performance Monitor

Ø Visual Explain

Ø Integrated SNA Support

Ø DB2 ODBC Driver

Ø East Asian Conversion Support

 Ø Documentation

 √

 √

 

 

 

 √

 √

 

 √

 

 

 

 

 

 

 √

 

 

Ensuring DLC is Installed on Windows NT
Workstations
If you plan to install the Integrated SNA Support, you need to ensure that DLC is
already installed before you install DB2 Connect on your Windows NT workstation:

1 Click on Start  and select Settings ->Control Panel .

2 Double-click on the Network  icon.

3 Select the Protocols  tab.

4 In the Protocols  field, see if DLC is listed.

¹ If DLC is listed, you can install the DB2 Connect software.

¹ If DLC is not listed, install it as follows:

a On the Network Protocols window, click on the Add  push button.
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b Select the DLC Protocol  option.

c Insert your original Windows NT operating system CD-ROM into the
CD-ROM drive.

| d Click on the Have Disk  push button, and provide the CD-ROM driver
| letter and path to the Windows NT installation directory.

e Click on OK to return to the Network Protocol window.

f Click on OK.

g Close the Network folder.

h Reboot you workstation when prompted.

Performing the Installation on a Windows 95
or Windows NT Workstation

To install DB2 Connect Personal Edition on a Windows 95 or Windows NT workstation:

1 If you are installing on a Windows NT workstation, log on as a user that meets
the requirements for installing DB2. For more information, see “Creating
Usernames for DB2 Installation and Operation” on page 33.

2 Shut down any other programs so that the setup program can update files as
required.

3 Insert the CD-ROM into the drive. The auto-run feature automatically starts the
setup program. The setup program will determine the system language, and
launch the setup program for that language. If you want to run the setup program
in a different language, see the tip that follows.

To manually invoke the setup program, do the following:

1 Click on Start  and select the Run  option.

2 Type the following in the Open  field:

x:\setup /i language

where:

¹ x: represents your CD-ROM drive
¹ language represents the two-character country code for your

language (for example, EN for English). Table 16 on page 264
lists the code for each available language.

3 Click on OK.
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4 The Welcome window opens. Click on the Next  push button to open the Select
Products window, as shown below. Select the product that you want to install and
click on the Next  push button.

5 You can select the installation type you prefer by clicking on the appropriate push
button:

Typical Install:  Installs those DB2 components that are used most often,
including all required components, ODBC support, documentation, and
commonly used DB2 tools such as the Information Center, and the Client
Configuration Assistant. The DB2 instance is created.

 
Compact Install:  Installs only required DB2 components and ODBC support.
The DB2 instance is created.

 
Custom Install:  Installs only those components that you select. The DB2
instance is created. The default for a Custom install is to install those
components and subcomponents you would get in a Typical install.
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To not install a particular component, such as the Integrated SNA Support,
choose a Custom installation and deselect the components you do not require.

Note:  You cannot selectively uninstall components after the setup program
completes the installation.

6 Respond to the setup program's prompts. Online help is available to guide you
through the remaining steps. Invoke online help by clicking on the Help  push
button at any time.

You can click on the Cancel  push button at any time to end the installation.

7 After you install the product, you must reboot your workstation before you can
begin to use it. Select a reboot option and click on the Finish  push button.

The installation program has:

¹ Created DB2 program groups and items (or shortcuts).

¹ Registered a security service.

¹ Updated the Windows registry.

| ¹ Created a default instance named DB2.

8 If you have installed DB2 Connect on a Windows 95 workstation, you must now
install DLC software:

a From the Control Panel, double-click on the Network  icon.

b Click on the Add  push button.

c Double-click the Protocol  icon.

d Insert your original Windows 95 operating system CD-ROM into the
CD-ROM drive.

e Click on the Have Disk  push button, then enter:

 x:\install_dir\sna\ms32dlc

The Client Configuration Assistant (CCA) component makes it easy for you
to configure and administer connections to databases and to bind
application and utilities to a database. See Chapter 28, “Using the Client
Configuration Assistant” on page 217 for a complete description of the
CCA's features.

If the CCA is not installed, you will need to use the command line processor
to configure connections to a database.

For information on errors encountered during installation, see the db2.log

file. The db2.log file stores general information and error messages
resulting from installation and uninstall activities. By default, the db2.log file
is located in the x:\db2log directory; where x: is the drive on which your
operating system is installed.
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where x is the installation drive and install_dir is the installation directory
(usually \sqllib).

f Click on OK.

g Click on OK to return to the original panel.

h Follow the instructions that appear. When you are instructed to do so, use
your original Windows 95 operating system CD-ROM to install the
remainder of the required files.

i Reboot your workstation when prompted.

To set up connections to DRDA databases, see one of the following chapters:

¹ Chapter 9, “Configuring Host and AS/400 Connections on OS/2 and Windows NT
Workstations” on page 53

¹ Chapter 12, “Configuring Integrated SNA Support Manually on Windows Workstations” on
page 77

¹ Chapter 14, “Configuring IBM Communications Server for Windows NT” on page 93

¹ Chapter 15, “Configuring IBM Communications Server for Windows NT SNA Client” on
page 105

¹ Chapter 16, “Configuring Microsoft SNA Server Version 4.0 for Windows NT” on page 113

¹ Chapter 17, “Configuring Microsoft SNA Client” on page 121.
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Chapter 7. Installing DB2 Connect for
Windows 3.x

If you need to install software on many Windows 3.x systems, see Chapter 26, “Unattended DB2
Installation on OS/2 or Windows 3.x Operating Systems” on page 189.

This chapter describes how to install DB2 Connect on a Windows 3.x workstation.

Before you begin, ensure that you know the type of host connectivity that want to use
(a direct connection using DB2 Connect Personal Edition or a connection that uses an
SNA gateway), and the protocol to be used for host connectivity:

 ¹ APPC

 ¹ TCP/IP

 ¹ MPTN

Performing the Installation on Windows 3.x

Read this section if you are installing DB2 Connect Personal Edition on a workstation
that runs Windows 3.x.

Choosing Which Optional Components to Install
DB2 Connect Personal Edition for Windows 3.x offers you the option of installing the
following components:
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DB2 Connect offers the option of using APPC, TCP/IP, or MPTN protocols for host
connectivity. For your convenience, DB2 Connect Personal Edition includes an
Integrated SNA Support that provides APPC and MPTN connectivity. If you plan to use
only TCP/IP for your host connectivity, you do not need to install the Integrated SNA
Support. If you do choose to install the Integrated SNA Support, you must ensure that
you have the Microsoft DLC driver installed on your workstation. See “Step 1. Ensure
DLC is Installed” on page 43 for instructions on installing the DLC driver.

Note: 

Integrated SNA Support
Do not install Integrated SNA Support if your workstation has SNA
support already installed. SNA support is already installed if your
workstation has, for example:

¹ Wall Data Rumba
¹ Microsoft SNA Client.

Data Sources Setup Tool
Install the Data Sources Setup Tool if you want to configure the
SNA provided with:

¹ PCOMM AS/400 and 3270 V4.1 or later
¹ Integrated SNA Support
¹ Wall Data Rumba
¹ Microsoft SNA Client
¹ Other products that conform to the IBM CPI-C specification

with Microsoft WinCPI-C extensions.

You can also install the Data Sources Setup Tool if you want to
configure DB2 using a GUI, rather than by issuing commands from
a command line.

Table 4. Products and Components for DB2 Connect Personal Edition for Windows 3.x

Product Components

DB2 Connect Personal Edition ¹ DB2 Connect Personal Edition
¹ Integrated SNA Support (see the

note, below)
¹ Data Sources Setup tool (see the

note, below)
 ¹ Documentation
¹ Japanese Conversion Support
¹ Korean Conversion Support
¹ Simplified Chinese Conversion

Support
¹ Traditional Chinese Conversion

Support
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Step 1. Ensure DLC is Installed
If you choose to install the Integrated SNA support on either Windows 3.1 and Windows
for Workgroups 3.11, DLC must be installed on the workstation before DB2 Connect is
installed:

On Windows 3.1
To determine if DLC is installed, examine the autoexec.bat file or the config.sys file
for a reference to msdlc.exe.

¹ If DLC is already installed, go to “Step 2. Ensure Win32s is Installed” on page 44.

¹ If it is not, you need to acquire DLC from the manufacturer of your workstation's
communications adapter. For example, if you are using an IBM network adapter,
you should obtain IBM DOS LAN Support Program Version 1.33 or higher, and
install it by following the instructions provided.

On Windows for Workgroups 3.11

1 From the Program Manager, double-click on the Network icon.

2 In the Network folder, double-click on the Network Setup icon.

3 In the Network Setup window, see if DLC is listed in the Network Drivers field.

¹ If it is, go to “Step 2. Ensure Win32s is Installed” on page 44.

¹ If it is not listed:

a Obtain DLC from Microsoft.

Microsoft distributes the DLC driver wfwdlc.exe free of charge. You can
obtain it from the Microsoft Download Service either by calling (206)
936–6735 or by going to the Microsoft home page on the Internet
(http://www.microsoft.com).

b On the Network Setup window, select Drivers ->Add
Protocol ->Microsoft DLC .

c Click on OK.

d Enter the path to the installation media.

e Click on OK->Close ->OK.

f Reboot your workstation.
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Step 2. Ensure Win32s is Installed
To determine if Win32s is installed, check to see if the \windows\system\win32s

directory exists.

¹ If it does, go to “Step 3. Install DB2 Connect for Windows 3.1.”

¹ If it does not:

1 Insert the DB2 Connect Personal Edition CD-ROM into the CD-ROM drive.

2 From the Program Manager, select File ->Run .

3 In the Command Line  field, enter:

 x:\language\win16\win32s\setup

 where language is the two-character country code that represents your
language (for example, EN for English). Table 16 on page 264 lists the codes
for each available language.

Step 3. Install DB2 Connect for Windows 3.1
To install DB2 Connect Personal Edition on Windows 3.x:

1 Insert the DB2 Connect Personal Edition CD-ROM into the CD-ROM drive.

2 From the Program Manager, select File ->Run .

3 In the Command Line  field, enter:

 x:\language\win16\install

where language is the two-character country code that represents your language
(for example, EN for English). Table 16 on page 264 lists the codes for each
available language.

4 The Welcome screen appears, followed shortly by the first install window.

5 Select OK to update AUTOEXEC.BAT and to continue.

6 On the Install-directories window, select DB2 Connect Personal Edition, and any
other options you want to install.

You should install the Documentation, the DB2 Data Sources Setup tool, and
Integrated SNA Support, in addition to DB2 Connect Personal Edition.

Important:  You should not install the DB2 Connect Integrated SNA Support if
your DB2 Connect workstation already has another SNA product installed.

See “Choosing Which Optional Components to Install” on page 34.

7 Select your preferred install drive and path; if necessary, select the Disk Space
button to check available disk space.
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8 Select the Install  button to continue.

9 If your system already had Wall Data Rumba software installed, you need to copy
the file \Rumba_root_dir \system\cpic.dll to
\Rumba_root_dir\system\wincpic.dll. By replacing wincpic.dll with cpic.dll,
you enable both your original applications and DB2 Connect to work together.

10 After the DB2 Connect software is installed:

a Restart your workstation.

b Open the DB2 folder.

c Click on the Logon  icon to start DB2 Connect. (You need to perform this
step before you can use the Data Sources Setup tool to define a connection
to a DRDA database.)

Check the README files!:  Read the two README files by clicking on their
icons in the DB2 folder.

To set up connections to DRDA databases, see Chapter 8, “Configuring Host and AS/400
Connections on Windows 3.1 or 3.11 Workstations” on page 49 or Chapter 12, “Configuring
Integrated SNA Support Manually on Windows Workstations” on page 77.
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Part 3. Configuring Access to Host and
AS/400 Databases
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| Chapter 8. Configuring Host and AS/400
| Connections on Windows 3.1 or 3.11
| Workstations

For an application to work with DB2 data, it must be able to refer to that data using a
symbolic name. Applications using ODBC refer to the data by using a Data Source
Name (DSN). Applications developed using Embedded SQL refer to data by using an
alias. Therefore, the goal of configuring a host connection is to create both a database
alias as well as an ODBC data source name that can be used by applications running
on the DB2 Connect workstation.

The DB2 Data Sources Setup tool is an easy-to-use utility that greatly simplifies the
task of defining aliases and ODBC data sources for DB2 databases. It provides a
point-and-click interface that guides you through the process of creating an APPC or a
TCP/IP connection and cataloging the nodes and databases. It also enables you to
perform such functions as binding DB2 utilities and testing connectivity. If you have an
organization that has many DB2 Connect Personal Edition workstations, you can share
definitions you have created by exporting them to a file and having other users import
those definitions.

This chapter describes how you:

¹ Create a DB2 data source definition for your workstation (see “Defining a DB2 Data
Source Definition”)

¹ Create a DB2 data source definition for another workstation (see “Exporting DB2
Data Source Definitions” on page 50)

¹ Use a DB2 data source definition created by others (see “Importing DB2 Data
Source Definitions” on page 51).

Defining a DB2 Data Source Definition

| 1 In the DB2 for Windows folder, double-click on the DB2 Data Sources Setup
| icon. The DB2 Data Sources window opens.

| On Windows 3.1 systems, if the DB2 Data Sources window open briefly
| then disappears, this indicates that Win32s is not installed. See “Step 2.
| Ensure Win32s is Installed” on page 44 for installation instructions.
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| The Configured DB2 data sources  area lists the DB2 data sources that your
| workstation is currently able to access.

| To add a new data source, click on the Add  push button. A screen containing a
| series of panels appears.

2 Fill in the information, moving from panel to panel by clicking on the Next  push
button. When you are finished, click on Done . The data source that you defined
appears in the list.

3 If you want to test the connection:

| a Click on the DB2 data source definition that you just created. The Test  push
| button becomes selectable.

b Click on Test .

c In the screen that appears, enter your user identifier and password, then
click on OK. The test results appear on the screen.

Note:  The initial connection may take a minute to establish. (Subsequent
tests of that connection will take less time).

4 Once you have connected successfully, bind utilities, such as ODBC/CLI support,
to the target DB2 database. To do this, click on the Show Administrator
Functions  push button, then click on the Bind  push button.

By defining the data source, you have configured your DB2 Connect workstation to
access a host database. You can now provide that data source definition to other DB2
Connect workstations (as described in “Exporting DB2 Data Source Definitions”).

Exporting DB2 Data Source Definitions

The Data Sources Setup tool enables you to create DB2 data source definitions that
you can provide to other DB2 Connect users. The instructions that follow assume that
you start with a working DB2 data source definition, which you can create by following
the instructions in “Defining a DB2 Data Source Definition” on page 49.

| 1 Click on the Data Sources Setup tool  icon in the DB2 folder. The DB2 Data
| Sources window opens, listing the available data sources.

2 Click on the DB2 data source definition that you want to make available.

3 If you want to modify an existing definition, click on the Setup  push button and
follow the instructions on the screen to complete your modifications. When you
are finished, click on OK.

4 If you want to test the connection, click on Test .
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5 To save the data source definition to a file, click on the Show Administrator
Functions  push button, then click on the Export  push button. When you choose
the location for the definition file, remember that it must be made available to the
users who will import it.

Note:  The Export function implicitly captures many elements of your data source
setup, including performance-enhancing settings such as any ODBC
customization that you may have performed on the DB2 Connect workstation
that you are exporting from. Such settings are applied automatically to the DB2
Connect workstation that imports your exported definition.

By exporting the data source definition, you can now provide that data source definition
to other DB2 Connect workstations (as described in “Importing DB2 Data Source
Definitions”).

Importing DB2 Data Source Definitions

The Data Sources Setup tool enables an administrator to create DB2 data source
definitions that can be imported on other DB2 Connect Personal Edition workstations
(as described in “Exporting DB2 Data Source Definitions” on page 50.) The instructions
that follow assume that an Administrator has supplied you with the location of the DB2
data source definition, whether on a shared drive or on a diskette.

To apply a previously-created DB2 data source definition to your DB2 Connect
workstation:

| 1 Click on the Data Sources Setup tool  icon in the DB2 folder. The first Data
| Sources Setup tool window, DB2 Data Sources , opens.

| 2 Click on the Import  push button. The Import DB2 Data Source Definitions
| screen appears.

3 Click on the Browse  push button.

4 Click on the file which contains the DB2 data source definitions, as instructed by
your administrator.

5 Click on OK.

6 Click on the data source that you want to add to your workstation from the list of
data sources contained in the definition file.

¹ If the data source definition is complete, the DB2 Connect workstation is
configured.

¹ If the data source definition is incomplete, a screen will appear showing
which information is missing. Provide the missing information, then click on
the Done  push button.
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Your DB2 Connect workstation will be configured to access the selected data
source automatically. The imported data source definition may contain
performance enhancing information such as ODBC customization settings. In
this case, the additional information will be applied to your DB2 Connect
workstation automatically.

To test the connection, from the Data Sources Setup tool:

1 Click on the DB2 data source definition from the list.

The Test  push button becomes selectable.

2 If your host has been configured to permit a connection from your workstation,
click on Test .

3 In the screen that appears, enter your user identifier and password, then click on
OK. The test results appear on the screen.

| The initial connection may take several minutes to establish, but subsequent
| connection will take less time. You can now use applications to access data at the
| target database.
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| Chapter 9. Configuring Host and AS/400
| Connections on OS/2 and Windows NT
| Workstations

| If you have installed the Client Configuration Assistant on your workstation, you can use
| this tool to configure your DB2 Connect workstation to access host or OS/400
| databases. Although the Client Configuration Assistant provides three methods to
| configure connection to DB2 Universal Database databases, you must use the "Manual"
| method to define a connection to a DRDA database. Perform the following steps:

| 1 If the Client Configuration Assistant is not already running, start it. For OS/2 ,
| start the Client Configuration Assistant. In Windows, click on Start  and select
| Programs ->DB2 for Windows ->Client Configuration Assistant . You are
| presented with a Welcome panel.

| Note:  The Welcome panel appears whenever you use the Client Configuration
| Assistant and have no databases cataloged.

| 2 Click on the Add Database  push button to configure connections using the Add
| Database SmartGuide.

| 3 Select the Manually configure a connection to a DB2 database  radio button,
| then click on the Next  push button.

| 4 Choose the protocol you want to use, either APPC or TCP/IP:

| ¹ If you want to use APPC:

| a Select APPC as the protocol for the connection, then select the Target
| Operating System  for the host to which you want to connect. Click on
| the Next  push button.

| b In the next panel you are presented with two Symbolic destination
| fields. The first field is mandatory; the second is required only if you
| wish to do password maintenance on the host. For the Connection
| field, follow these guidelines:

| – If you have already defined a symbolic destination (also known as
| the CPI-C side information), for the database to which you will be
| connecting, type in the Symbolic destination  name. If you would
| like to configure a symbolic destination name for your database,
| type in the name you want and click on the configure  push button.
| You do not have to type in the symdestname before clicking on the
| Configure  push button. Once you are done with the configuration,
| the program will provide you with a symdestname.

| – If the Configure  push button is greyed and cannot be selected, it
| means that the CCA cannot guide you through the process of
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| defining a symbolic destination name for your database, and you
| will need to configure this manually. If your SNA product is one of
| those described in this manual, go to those configuration
| instructions now. (Refer to Chapter 10, “Configuring
| Communications to Host and AS/400 Databases Manually” on
| page 59 for a list of the SNA products that are described.)
| Otherwise, you need to use the documentation supplied with your
| SNA product to configure the CPI-C name (symbolic destination).
| When you have defined the symbolic destination for the database,
| come back to this CCA page and type in the name. Then skip to
| step 5.

| – If you wish to do password maintenance, enter the symbolic
| destination name used by the host for password maintenance in
| the second field. If the Configure  push button is enabled, you can
| click it to bring up another dialog box where you can fill in the new
| password maintenance LU. Once you are done with the
| configuration, the program will provide you with a symdestname.

| – Select either the APPC (SNA)  radio button or the APPC over
| TCP/IP radio button, then click on the Next  push button. You are
| presented with two new pages.

| – Fill in the fields on the This PC  page and the Server  page. (In
| most situations you do not need to fill in values for the Session
| section.) Click on the Done  push button.

| ¹ If you want to use TCP/IP:

| a Select TCP/IP as the protocol for the connection, then select the Target
| Operating System  for the host to which you want to connect.

| b Click on the Next  push button.

| c Fill in the Hostname  and Port Number  fields. Optionally, fill in the
| Service Name  field. Click on the Next  push button.

| 5 On the Target Database page, fill in the requested value, then click on the Next
| push button.

| 6 Fill in values for the Alias page, and, if you want to run ODBC applications, the
| ODBC page. Click on the Done  push button to complete the definition.

| 7 Click on the Test Connection  push button to test the connection to the specified
| database.

| 8 Enter your user ID and password if needed to access the database and click on
| the OK push button. If the connection is successful, a message confirming the
| connection appears. If not, refer to the Troubleshooting Guide for possible
| causes. You are now able to use the database.

| 9 It is strongly recommended that you bind DB2 utilities to the database you just
| defined. To do this:
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| a. Select the database to which you want to bind the utilities.

| b. Click on the Bind  push button.

| c. Select whether you want to bind utilities or applications.

| d. Click on the Continue  push button.

| e. Enter a user ID and password to connect to the database. The user ID must
| have the authority to bind new packages against the database.

| f. Select the utilities you want to bind and click on OK.

| If you want to access another database, select the Add Another  push button.

Now that you have configured host connections, go to Chapter 19, “Configuring Access to a
Remote DB2 Server Using the Client Configuration Assistant” on page 133 to configure access to
DB2 Universal Database servers (if required), or to Chapter 21, “Getting Started with DB2
Universal Database” on page 141.
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Part 4. Configuring Other Connectivity
Options
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 Chapter 10. Configuring Communications
to Host and AS/400 Databases Manually

This section describes how to configure manually the DB2 Connect workstation to use
the following SNA communications subsystems:

¹ IBM Communications Server for OS/2 or Communications Manager for OS/2 (see
Chapter 11, “Configuring Communications Server for OS/2 for DB2 Connect for
OS/2” on page 61).

¹ DB2's integrated SNA (see Chapter 12, “Configuring Integrated SNA Support
Manually on Windows Workstations” on page 77).

| ¹ IBM Personal Communications for Windows NT (see Chapter 13, “Configuring IBM
| Personal Communications for Windows 32-Bit Operating Systems” on page 83).

¹ IBM Communications Server for NT (see Chapter 14, “Configuring IBM
Communications Server for Windows NT” on page 93).

¹ IBM Communications Server for NT SNA Client (see Chapter 15, “Configuring IBM
Communications Server for Windows NT SNA Client” on page 105).

¹ Microsoft SNA Server (see Chapter 16, “Configuring Microsoft SNA Server Version
4.0 for Windows NT” on page 113).

¹ Microsoft SNA Client (see Chapter 17, “Configuring Microsoft SNA Client” on
page 121).

You can find more information in the following publications:

¹ For more information about SNA Server for AIX, refer to the IBM SNA Server for
AIX User's Guide.

¹ For information on how to configure DRDA hosts for DB2 Connect, refer to:

– Chapter 29, “Configuring DRDA Hosts for DB2 Connect” on page 231 in this
manual

– The online DB2 Connectivity Supplement (which is installed with the DB2
Connect software)

– The Distributed Relational Database Architecture Connectivity Guide,
SC26-4783.

– The DB2 for OS/390 V5 Installation Guide, GC26-8970.

 Copyright IBM Corp. 1993, 1998  59



60 DB2 Connect Personal Edition Quick Beginnings  



 Chapter 11. Configuring Communications
Server for OS/2 for DB2 Connect for OS/2

Most users will find it easiest to use the DB2 Client Configuration Assistant tool to configure
Communications Server for OS/2 or Communications Manager for OS/2, as described in
Chapter 9, “Configuring Host and AS/400 Connections on OS/2 and Windows NT Workstations”
on page 53. However, if you need to perform a manual configuration, read this chapter.

This chapter tells you how to manually configure APPC communications between your
DB2 Connect for OS/2 workstation and DRDA servers. Before you begin, ensure that
your workstation has IBM Communications Server or Communications Manager for
OS/2 installed. (The steps in this section describe how to use Communications Server
Version 4. If you have Communications Manager for OS/2 V.1.x, the steps you perform
are similar, but the interface and menu names are different.) Note that in the examples
in this chapter, a Token Ring network is used as the communications medium.

Fill in the Worksheet

Before you configure the DB2 Connect workstation, have your host-side administrator
and LAN administrator fill in copies of the worksheets that follow for each host to which
you want to connect:

¹ For OS/390, MVS, VM, and VSE hosts, use Table 5 on page 62
¹ For AS/400, use Table 6 on page 64 

To help you fill in the worksheets, Figure 6 illustrates a sample network that has DB2
Connect running on an OS/2 system and uses APPC to connect to DB2 for OS/390.
The values shown in this diagram correspond to the Sample Value entries in the
worksheet.

After you fill in the Your Value entries, you can use the worksheet to configure IBM
Communications Server. As you configure Communications Server, replace the sample
values that appear in the configuration instructions with your values from the worksheet.
Use the boxed numbers .1/ to relate the configuration instructions to the worksheet
values.

In the configuration instructions, the .*/ symbol denotes entries that need to be
changed but do not have a representation on the worksheet.
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APPC Local LU Properties

DB2 CONNECT TO NYC3 USER <USERID> USING <PASSWORD>

NCP

Node Directory

System Database Directory

DCS Directory

Node name

Symbolic dest name

Security
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Network ID

Local node name

Local node ID

Mode definition

Local LU

Connection to a host/ peer node

LAN destination addr.

Partner node name

Partner LUs

CPI communications side information

Symbolic dest. name

Qualified partner LU

Mode name

NETID

APPL

PU

LU

SSCP

MODEENT

IDBLK=
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SPIFNET

NYM2DB2

NYX1
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NYM2DB2

DB2 for OS390

DB2DB
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NYC3

DB2DB

DB2NODE

DCS

DB2NODE

DB2CPIC

PROGRAM

Communications Server VTAM

SPIFNET.NYM2DB2

IBMRDB

Figure 6. Configuration on the DRDA Server and DB2 Connect Workstation

Table 5 (Page 1 of 2). Worksheet for Planning OS/390, MVS, VM, or VSE Host Connections

Ref. CS/2 Name VTAM Name Sample Value Your Value

Network Elements at the Host

.1/ Host Name Network name SPIFNET

.2/ Partner LU Name Application Name NYM2DB2

.3/ Network ID SPIFNET

.4/ Partner Node Name SSCP Name NYX
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Table 5 (Page 2 of 2). Worksheet for Planning OS/390, MVS, VM, or VSE Host Connections

Ref. CS/2 Name VTAM Name Sample Value Your Value

.5/ Database name OS/390 or MVS:
Location
Name

VM/VSE: RDB_Name

NEW_YORK3

.6/ Mode Name IBMRDB

Network Connection Information

.7/ Connection name (Link
name)

LINKHOST

.8/ LAN destination address 400009451902

Network Elements at the DB2 Connect Workstation

.9/ Network ID or C&SM LAN
ID

SPIFNET

.10/ Local Node name or Local
PU Name

NYX1

.11/ (Local) LU name NYX1GW01

.12/ (Local LU) alias NYX1GW01

.13/ Local Node or Node ID ID BLK 05D

.14/ ID NUM 27509

.15/ Mode name IBMRDB

.16/ Symbolic Destination name DB2CPIC

.17/ (Remote) Transaction
program (TP) name

| X'QCNTEDDM'

| (or RDB_NAME
| for VM, AXE
| transactions
| name for VSE,
| or DB2DRDA for
| MVS or OS/390)

DB2 Directory Entries (at the DB2 Connect workstation)

.18/ Node name db2node

.19/ Security program

.20/ Database name db2db

.21/ Database alias nyc3

Notes:

1. The Local LU NYX1GW01 should be the LU for the SPM. If you use the SPM with
this LU, you cannot use this LU to be the Control Point LU.

2. For a connection to an OS/390, MVS, VSE, or VM system, you must know the
local node name of your machine. You can find this by reviewing the Local Node
Characteristics specification in your existing Communications Server configuration.
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Table 6. Worksheet for Planning OS/400 Connections

Ref. CS/2 Name Network Name Sample Value Your Value

Network Elements at the Host

.1/ Host name Local Network ID SPIFNET

.2/ Partner LU Name Application Name NYM2DB2

.3/ Network ID SPIFNET

.4/ Partner Node name Local CP Name SYD2101A

.5/ Database name Relational Database
Name

NEW_YORK3

.6/ Link Name or Mode
Name

IBMRDB

Network Connection Information

.7/ Connection name (Link
name)

LINKHOST

.8/ Remote Network
address

Local Adapter Address 400009451902

Network Elements at the DB2 Connect Workstation

.9/ Network ID or C&SM
LAN ID

SPIFNET

.10/ Local Node Name or
Local PU Name

NYX1

.11/ (Local) LU name NYX1GW01

.12/ (Local LU) alias NYX1GW01

.13/ Local Node or Node ID ID BLK 05D

.14/ ID NUM 27509

.15/ Mode name IBMRDB

.16/ Symbolic Destination
name

DB2CPIC

.17/ (Remote) Transaction
program (TP) name

X'QCNTEDDM'

DB2 Directory Entries (at the DB2 Connect workstation)

.19/ Node name db2node

.19/ Security program

.20/ Database name db2db

.21/ Database alias nyc3

Note:  You can determine some of the above values by running commands at the DB2
for AS/400 system:

¹ To find the values for .1/, (known at the OS/400 as the local network ID),
and for .4/, (the local control point name), enter: DSPNETA

¹ To find the value for .8/, (known at the OS/400 as the local adapter
address), enter: WRKLIND *TRLAN

Next, enter option 5 (Display ) at the _ when prompted:
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 Opt Line Type Text

 _ TRNLINE *TRLAN

In the screen that appears one of the lines will be similar to this:

Local adapter address ........: 400009451902

¹ To generate a list of mode names for .15/, enter: WRKMODD

¹ To find the value for .5/, (known at the OS/400 as the relational database
name), enter: DSPRDBDIRE

Use the RDB name associated with the entry containing *LOCAL in the
Remote Location column. If no *LOCAL entry exists, either have one
created or use the Current System Name displayed when you run the
DSPNETA command. If the user profile under which the initial connect is
made has authority to run the ADDRBDIRE command, the *LOCAL entry
will be created automatically using that user profile's name on the connect
attempt.

Configuring APPC Using Communications
Server

Most users will find it easiest to use the DB2 Client Configuration Assistant tool to configure
Communications Server for OS/2 or Communications Manager for OS/2, as described in
Chapter 9, “Configuring Host and AS/400 Connections on OS/2 and Windows NT Workstations”
on page 53.

These instructions describe how to create new profiles within a new configuration. If
you are modifying an existing configuration, you may need to delete some profiles
before you can verify the configuration.

Begin to configure your DB2 Connect system with the following steps:

1 Double-click on the Communications Server  icon.

2 Double-click on the Communications Manager Setup  icon.

3 On the Communications Server Setup panel, click on the Setup  push button.

4 On the Open Configuration panel:

a Specify the name of an existing configuration file if you have one, or provide
a name for a new file to be created.

b Click on the OK push button to proceed to the Communications Server
Configuration Definition panel.
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5 The Configuration Definition panel opens.

a Select the Commonly used definitions  radio button.

b In the Communications Definitions window, select the protocol that you want
to use. These examples use APPC APIs over Token-Ring.

c Click on the Configure  push button to proceed.

If this is a new configuration file, the next panel displayed will be the APPC
APIs over Token-Ring panel. Otherwise the next panel displayed will be the
Communications Server Profile List panel.

6 The APPC APIs over Token-Ring panel opens.

a Enter your values for:

¹ Network ID .9/
¹ Local node name .10/

b Click on the End node  push button that your network administrator advises
you to use.

c Click on the Advanced  push button. The Communication Manager Profile
List window opens.

You can select either the End node - to a network node server  radio
button or the End node - no network node server  radio button. A network
node server is used when many users are routed through the same
connection. The example here presumes no network node server is used.
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Subsequent steps begin from this panel. You will return to this panel when each
step is complete.

Preparing the LAN DLC Profile
From the Communications Server Profile List panel, prepare a LAN DLC profile as
follows:

1 Select DLC - Token ring or other LAN types ->Configure .

2 Enter your value for Network ID  or C&SM LAN ID . .9/

3 Check that the other values are appropriate for your environment. The values in
the example are default values.

4 Click on OK to return to the Communications Server Profile List panel.

Updating the SNA Local Node Characteristics
Update SNA Local Node Characteristics as follows:

1 On the Communications Server Profile List panel, select SNA local node
characteristics ->Configure . The Local Node Characteristic panel opens.
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2 Enter your value for Network ID  .9/.

3 The Local node name  was probably set when Communications Server was
installed. If you are not sure, consult your local network administrator.

4 Enter your value for Local node ID (hex)  .13/ and .14/.

5 Click on the Options  push button. The Local Node Options panel opens.

a Verify that the Activate Attach Manager at startup  check box is selected.

b Click on OK to return to the Local Node Characteristics panel.

6 Click on OK to return to the Communications Server Profile List panel.

The first part should be filled in for you already when you display the profile.
You only need to complete the second part.

Preparing the SNA Connection Profiles
Prepare the SNA connection profiles as follows:

1 From the Communications Server Profile List panel, select SNA
Connections ->Configure .

2 On the Connections List panel for Partner Type , select either the To peer node
radio button (normally used for OS/400 connections), or the To host  radio button
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(normally used for OS/390, MVS, VSE, and VM connections), and click on the
Create  push button.

3 The Adapter List window opens.

4 Select the Token-ring, or other LAN types  adapter type, and specify the same
adapter number  that you specified in the DLC profile.

5 Click on the Continue  push button to proceed to the Connection to a Peer Node
panel or the Connection to a Host panel.

Connection to a Peer or Host Node
The Connection to a Peer Node or Connection to a Host Node windows opens.

  Chapter 11. Configuring Communications Server for OS/2 for DB2 Connect for OS/2 69



At the Connection to a Peer Node panel or the Connection to Host panel:

1 Specify the Link name  value that you wrote in item .7/ of the worksheet.

2 On the Connection to Host panel, select Additional parameters  push button and
change the Local PU name  field to your value for .10/.

3 Change the node ID field to your values for .13/ and .14/.

4 Change LAN destination address  field to your value for .8/.

5 Change Partner network ID  field to your value for .1/.

6 Change Partner node name  field to your value for .4/.

7 Select Define Partner LUs  push button on either the Connection to a Peer Node
panel or the Connection to Host panel to proceed.

 Partner LUs
Create a Partner LUs Profile as follows:

1 Enter your value for Network ID  .3/.

2 Enter your value for LU name  and Alias  (use .2/ for both).

3 Click on the Add  push button to add the partner LU profile to the connection
profile.

4 Click on OK to return to the previous panel.

5 On the Connection to Host panel, click on the Additional Parameters  push
button. The Partner LU window opens
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Additional Connection Parameters
If you have selected to configure connections to a host, the following window appears.

1 Verify that the Multiple PU Parameters  fields are filled in. This value is the Local
Node ID in hex, items .13/ and .14/ in the worksheet.

Local node ID 05D 27509

2 Click on OK to return to the Connection to a Host panel.

3 Click on OK to return to the Connections List panel.

4 Click on the Close  push button to return to the Communications Server Profile
List panel.
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Setting the SNA Features
On the Communications Server Profile List panel, select SNA features ->Configure .
Subsequent steps begin from the SNA Features List panel that appears, as follows:

Preparing a Local LU Profile
If the DB2 Connect workstation is defined as an independent LU, prepare a Local LU
Profile as follows. In most cases, a VTAM administrator on OS/390, MVS, VSE, or VM
would define an independent LU for DB2 Connect. For OS/400, the control point would
normally be used instead of an independent LU.

1 On the SNA Features List panel, click on Local LUs ->Create .

2 Enter your value for LU name  .11/.

3 Enter your value for alias  .12/.

4 For the NAU address  box, select the Independent LU  radio button.

5 Click on OK to return to the SNA Features List panel.

6 In order to use this local LU when the DB2 Connect workstation starts the APPC
connection, select the Use this local LU as your default local LU alias  check
box. By default, all APPC connections that are started from this DB2 Connect
workstation will use this local LU.
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Verifying the Partner LU Profile
The partner LU profile was configured in a previous step. To verify, select the Partner
LU Profile  option from the SNA Features List panel to see if a partner LU is defined.

Preparing a Mode Definition
From the SNA Features List panel, prepare a Mode Definition as follows:

 1 Select Modes ->Create .

2 Define your mode profile as follows:

a Enter your value for mode name  .15/. It must also match item .6/.
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b On the other lines, you can either specify values that match the mode
profile defined on your DRDA server systems, or tune the parameters.

3 Click on OK to finish the creation of the mode and to return to the SNA Features
List panel.

Creating the CPIC Side Information
On the SNA Features List panel, select CPI Communications Side
Information ->Create . The CPI Communications Side Information opens.

Complete the CPI Communications Side Information panel as follows:

1 Enter your value for Symbolic destination name  .16/.

2 Select the Alias  radio button. Click on the Alias  drop down box to view a list of
all defined aliases and choose the alias that corresponds to item .12/.

3 In the Partner TP  box, specify the remote Transaction Program (TP) name .17/.

Select the None  radio button as the Security type .

4 Enter your value for the Mode name  field .6/.

5 Click on OK to save the CPI side information profile and return to the SNA
Features List panel.

6 Click on Close  to return to the Communications Server Profile List panel.

This does not mean that you will have no security, you will specify the
security type later when you update the DB2 directories.
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Save Your Configuration

You are now ready to save your Communications Server configuration file:

1 Click on Close  to return to the Communications Server Configuration Definition
panel.

2 Click on Close  to automatically verify and save the new configuration file, and
leave the configuration panels.

3 Stop and start Communications Server. Click on Stop Communications
Normally ->Start Communications .

Update the DB2 Directories

To configure the DB2 directories, enter the following commands in the DB2 Connect
command line processor:

1 Catalog the DRDA server as an APPC node. The syntax of the command is:

catalog appc node node_name remote sym_dest_name security program

| For example:

catalog appc node DB2NODE remote DB2CPIC security program

2 Catalog the remote database as a Data Connection Services (DCS) database.
The syntax of the command is:

catalog dcs Database local_dbname as real_host_dbname

| For example:

| catalog dcs database DB2DB as NEW_YORK3

3 Catalog a database alias for the remote database. The syntax of the command is:

catalog db local_dbname as db_alias at node node_name authentication dcs

For example:

catalog db DB2DB as NYC3 at node DB2NODE authentication dcs

In the DB2 commands above:

¹ node_name can be any valid eight-character name

¹ sym_dest_name is the name of your Side Information Profile (.16/).

¹ local_dbname can be any valid eight-character name
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¹ db_alias can be any valid eight-character name

¹ real_host_dbname is the name of the database you want to connect to at the
DRDA server (.5/).

Test the Connection

Issue the following command from the command line processor window at the DB2
Connect server, remembering to substitute your db_alias value from the previous step:

connect to db_alias user userid using password

| For example:

| connect to NYC3 user userid using password

The user ID and password values required are those defined at the host or AS/400,
and must be provided to you by your DB2 Administrator.

Complete the Configuration

The steps you have just completed set up the DB2 Connect workstation to
communicate with the host. You must now bind the utilities and applications to the
DRDA server.

To bind the utilities and applications to the DRDA server, connect to the DRDA server
and use commands similar to the following:

connect to dbalias user userid using password

bind path/bnd/@ddcsmvs.lst blocking all sqlerror continue

messages mvs.msg grant public

 connect reset

where path corresponds to the DB2PATH registry value. These commands are
described in detail in the DB2 Connect User's Guide.

Once you have completed these steps, see Chapter 21, “Getting Started with DB2 Universal
Database” on page 141 for details on the many functions that are available to use with DB2.
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Chapter 12. Configuring Integrated SNA
Support Manually on Windows Workstations

| Read this chapter if you have a Windows NT, Windows 95, Windows 98 or Windows
| 3.1 workstation and you have installed the Integrated SNA Support option.

Although you should use the Data Sources Setup tool or the Client Configuration
Assistant wherever possible in order to configure communications with a host or AS/400
server, there are situations where these tools will perform only a portion of the required
configuration (for example, to configure an SDLC or twinax connection). This chapter
describes how you manually configure an SNA connection between a DB2 Connect
Personal Edition using Integrated SNA Support and a remote DRDA server in such
situations.

The example values used in this chapter are based on the scenario in Figure 6 on
page 62, except that Integrated SNA Support replaces Microsoft SNA Server as the
SNA subsystem at the DB2 Connect workstation.

Step 1. Start the APPC Configuration Utility

1 To start the APPC configuration utility:

¹ For 32-bit Windows, run the config  program. For example, if DB2 Connect is
installed in c:\sqllib, run:

 c:\sqllib\sna\system\config.exe

¹ For 16-bit Windows, From the Program Manager select File ->Run . In the
command window, enter:

 c:\sqllib\win\sna\system\config.exe

The APPC Configuration Utility panel appears.

2 Enter the Network Name  for the DB2 Connect Workstation.

3 Enter the Control Point Name  for the DB2 Connect Workstation.
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Step 2. Add a Connection

1 From the Action Bar, select Add .

 2 Select Connections .

3 From the Select a Connection pop-up menu, select the type of connection (for
example, Token Ring).

4 At the Token Ring Connection pop-up:

a Enter a Link Name .

b Assign values to the Options  parameters:

1 Enter Block ID .

2 Enter Node ID  (if provided by your VTAM or AS/400 administrator).

3 Enter Destination Address .

4 Both the Local  and the Remote SAP Addresses  can default to 4.
You may need to change this at a later stage, for example if you are
using another SNA application and you get a message indicating that
the Service Access Point (SAP) address is not available, either to DB2
Connect or to the other application.

c Select a choice from the Link Options .

d Click on the  Advanced  button.

e Confirm that the Adapter Selection  is correct (usually the primary).

f Leave the  Link Parameters  at the default value.

5 Click on  OK.

Step 3. Add a Mode

1 From the Action Bar, select Add .

2 Select the Mode  button.

3 At the Configure Modes pop-up, set the values as shown in the example:
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¹ On the Basic window, set the Mode name to be used (same as at the host of
AS/400 server).

¹ On the Limits window, set:

 Session limit 30

Automatic Activation Limit 0

Minimum Contention Winners 15

¹ On the Send window, set:

 RU Length 4096

 Pacing Count 0

¹ On the Receive window, set:

 RU Length 4096

 Pacing Count 0

Notes:

a. The RU Lengths given above assume a Token Ring LAN. For Ethernet, the
values must be no larger than 1517.

b. Check with your VTAM or AS/400 Administrator that the values you set are
compatible with those set at the host.

4 Click on OK.

Step 4. Add a Remote LU

1 From the Action Bar, select Add .

2 Select Remote LU .

3 At the Configure Remote LU's pop-up, enter:

¹ The LU Alias

¹ The LU Name

¹ The name of the Connection  to be used.

¹ The Network Name .

4 Click on OK.
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Step 5. Add a Local LU

1 From the Action Bar, select Add .

2 Select Local LU .

3 At the Configure Local LU's pop-up, enter:

¹ The LU Alias

¹ The LU Name

4 Click on Advanced .

5 Ensure the LU Address  is 00 (for an independent LU).

6 Click on OK.

Step 6. Define Side Information

1 Access the Side Info  panel:

¹ On a Windows 3.1 or Windows for Workgroups 3.11 system:

a From the Action Bar, select SideInfo .

 b Select New.

c Click on Edit .

| ¹ On a Windows NT, Windows 95 or Windows 98 system:

| a From the Action Bar, select Add .

| b Select Side Info .

2 Type in the SymDestName .

3 For Partner LU , select the Alias radio button, and the name you defined for the
Remote LU Alias.

4 For Local LU , select the name you defined for the Local LU name

5 For Mode Name , select the name you defined.

6 For Security , select None.

7 For Partner TP Name , use:
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¹ X'07F6C4C2' for DB2 for MVS/ESA or DB2 for AS/400. (You can also use
DB2DRDA for DB2 for OS/390 or DB2 for MVS.)

¹ The remote database name for DB2/VM or DB2/VSE (the default is
RDB_NAME. Ask your database administrator for the value you should use).

8 If the Partner TP Name is specified in Hex, select Hex TP Name .

9 If you want to review the options on the Advanced CPI-C Side Information panel:

a Click on the Advanced  push button.

b Click on the Cancel  push button.

10 Click on OK to save the Side Information profile.

Step 7. Save the Configuration

At the main Configuration Utility panel,

1 From the Action Bar, select File .

2 Select Save As .

3 Provide a name you will recognize later: for example, a name of the form
llllllxx, where llllll is the CP Name, and xx is an alphabetic or numeric
sequence, such as "AA" for the first, "BB" for the next, and so on.

4 Click on OK.

Step 8. Update the DB2 Directories

To configure the DB2 directories, enter the following commands in the DB2 Connect
command line processor:

1 Catalog the DRDA server as an APPC node. The syntax of the command is:

catalog appc node node_name remote sym_dest_name security program

For example:

catalog appc node DB2NODE remote DB2CPIC security program

Note:  The case of the sym_dest_name (DB2CPIC in this example) must match
the case of the SymDestName in the Side Information definition.
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2 Catalog the remote database as a Data Connection Services (DCS) database.
The syntax of the command is:

catalog dcs database local_dbname as real_host_dbname

For example:

| catalog dcs database DB2DB as NEW_YORK3

3 Catalog a database alias for the remote database. The syntax of the command is:

catalog db local_dbname as db_alias at node node_name authentication dcs

For example:

catalog db DB2DB as nyc3 at node DB2NODE authentication dcs

In the DB2 commands above:

¹ node_name can be any valid eight-character name

¹ sym_dest_name is the name of your Side Information Profile.

¹ local_dbname can be any valid eight-character name

¹ db_alias can be any valid eight-character name

¹ real_host_dbname is the name of the database you want to connect to at the
DRDA server.

Step 9. Test the Connection

Issue the following command from the command line processor window, remembering
to substitute your db_alias value from the previous step:

connect to db_alias user userid using password

For example:

connect to DB2DB user userid using password

The user ID and password values required are those defined at the host or AS/400,
and must be provided to you by your DB2 Administrator.
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| Chapter 13. Configuring IBM Personal
| Communications for Windows 32-Bit
| Operating Systems

| Read this chapter if you have a Windows NT, Windows 95 or Windows 98 workstation
| that has IBM Personal Communications for Windows NT or Windows 95 installed.

| Before you begin, ensure that the IBM Personal Communications for Windows NT or
| Windows 95 you installed:

| ¹ Is Version 4.2 or higher

| ¹ Has the IBM Personal Communications IEEE 802.2 LAN interface (this is an
| installation option for IBM Personal Communications)

| ¹ Has the LLC2 driver installed from the IBM Communications Server installation
| directory. To confirm this:

| 1 Click on the Start  button, then select Settings ->Control Panel .

| 2 Double-click on the Network  icon.

| 3 On the Network window, click on the Protocols  tab. IBM LLC2 Protocol
| must be one of the protocols listed. If it is not, you need to install this protocol
| from your IBM Personal Communications for Windows NT or Windows 95
| software. Refer to its documentation for instructions.

| Step 1. Fill In the Worksheet

| Before you configure the DB2 Connect workstation, have your host-side administrator
| and LAN administrator fill in copies of the following worksheet for each host to which
| you want to connect (see Table 7 on page 85).

| To help you fill in the worksheets, Figure 7 illustrates a sample network that has DB2
| Connect using APPC to connect to DB2 for OS/390. The values shown in this diagram
| correspond to the Sample Value entries in the worksheet.

| After you fill in the Your Value entries, you can use the worksheet to configure IBM
| Personal Communications for Windows NT or Windows 95. As you perform the
| configuration, replace the sample values that appear in the configuration instructions
| with your values from the worksheet. Use the boxed numbers .1/ to relate the
| configuration instructions to the worksheet values.
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APPC Local LU Properties

DB2 CONNECT TO NYC3
USER <USERID> USING <PASSWORD>

NCP

Node Directory

System Database Directory

DCS Directory

Node name

Symbolic dest name

Security

Local node characteristics

Network ID

Local CP name

Local node ID

Mode definition

Local LU name

LAN connection to a host

Destination addr.

Partner LU name

CPI communications side information

Symbolic dest. name

Qualified partner LU

Mode name

NETID

APPL

PU

IDBLK=

IDNUM=

LU

MODEENT

SPIFNET

NYM2DB2

NYX1

05D

27509

NYX1GW01

IBMRDB

400009451902

LOCADD=

SPIFNET

NYX1

05D 27509

IBMRDB

NYX1GW01

400009451902

NYM2DB2

DB2CPIC

DB alias

DB name

Node

Authentication

Database

Target DB name LOCATION

LUNAME

NEW_YORK3

NYM2DB2

DB2 for OS390

DB2DB

NEW_YORK3

NYC3

DB2DB

DB2NODE

DCS

DB2NODE

DB2CPIC

PROGRAM

Personal Communications VTAM

SPIFNET.NYM2DB2

IBMRDB

| Figure 7. Configuration on the DRDA Server and DB2 Connect Workstation

| Figure 7 illustrates the correspondences between information specified on the DRDA
| server system, information specified in Personal Communications, and information
| specified in DB2 directories. The values shown in the diagram are the example values
| used in the instructions in this chapter.
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| Table 7. Worksheet for Planning OS/390, MVS, VM, VSE, or OS/400 Connections

Ref.

Personal
Communications
Admin Name VTAM Name Sample Value Your Value

| Network Elements at the Host

| .1/| Host Name| Network name| SPIFNET

| .2/| Partner LU Name| Application Name| NYM2DB2

| .3/| Network ID| SPIFNET

| .4/| Control Point Name| OS/390, MVS, VM, VSE:
| SSCP Name

| OS/400: Local Control
| Point Name

| NYX

| .5/| Database name| OS/390 or MVS:
| Location
| Name

| VM/VSE: RDB_Name

| NEW_YORK3

| .6/| Mode Name| IBMRDB

| .7/| Link Station Name| LINKHOST

| Network Connection Information

| .8/| Destination address| 400009451902

| Network Elements at the DB2 Connect Workstation

| .9/| Network Name| SPIFNET

| .10/| Local Control Point
| Name
| NYX1

| .11/| Local LU name| NYX1GW01

| .12/| Local LU alias| NYX1GW01

| .13/| Local Node ID| Block ID| 05D

| .14/| Physical Unit ID| 27509

| .15/| Mode name| IBMRDB

| .16/| Symbolic Destination
| name
| DB2CPIC

| .17/| (Remote) Transaction
| program (TP) name
| X'07F6C4C2' (or
| RDB_NAME for
| DB2 for VSE &
| VM) (or
| DB2DRDA for
| DB2 for OS/390
| or DB2 for MVS)

| DB2 Directory Entries (at the DB2 Connect workstation)

| .18/| Node name| db2node

| .19/| Security| Program

| .20/| Database name| db2db

| .21/| Database alias| nyc3
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| Step 2. Configure the SNA Node

| To start IBM Personal Communications, click on the Start  button, then select
| Programs ->IBM Communications Server ->SNA Node Configuration . The IBM
| Personal Communications SNA Node Configuration screen appears.

| From the File  button on the menu bar, select New. The Define the Node  field appears.

| To configure the DB2 Connect workstation, you need to configure the following
| Configuration options :

|  ¹ “Configure Node”
|  ¹ “Configure Devices”
| ¹ “Configure Connections” on page 87
| ¹ “Configure Partner LU 6.2” on page 88
| ¹ “Configure Modes” on page 88
| ¹ “Configure Local LU 6.2” on page 88
| ¹ “Configure CPI-C Side Information” on page 89

| After each step, you return to the window that has the Configuration options  field.

|  Configure Node
| To configure the node:

| 1 In the Configuration options  field, select Configure Node , then click on the
| New button. The Define the Node window appears.

| 2 In the Fully qualified CP name  fields, type in the network name .9/ and the
| local control point name .10/ (SPIFNET.NYX1).

| 3 Optionally, in the CP alias  field, type in a CP alias. If you leave this blank the
| local control point name .10/ will be used (NYX1).

| 4 In the Local Node ID  fields, type in the block ID .13/ and the physical unit ID
| .14/ (05D 27509).

| 5 Click on OK.

|  Configure Devices
| To configure the device:

| 1 In the Configuration options  field, select Configure devices .
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| Figure 8. Configuration Screen for Personal Communications. 

| 2 Ensure that in the DLCs  field, the appropriate DLC is highlighted. For example,
| LAN .

| 3 Click on the New button. The appropriate window appears with default values
| displayed. For example, the Define a LAN device window.

| 4 Click on OK to accept the default values.

|  Configure Connections
| To configure the connections:

| 1 In the Configuration options  field, select Configure connections .

| 2 Ensure that in the DLCs  field, LAN  is highlighted.

| 3 Click on the New button. The Define a LAN connection window appears.

| 4 On the Basic tab panel:

| a In the Link station name  field, type in the name .7/ from the worksheet
| (LINKHOST).

| b In the Destination address  field, type in the address .8/ from the
| worksheet (400009451902).

| 5 On the Adjacent Node tab panel:

| a In the Adjacent CP name  fields, type in the network ID .3/ and the Control
| Point name .4/ (SPIFNET.NYX).
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| b In the Adjacent CP type  field, select Back-level LEN .

| c Ensure that TG number  is set to 0 (the default).

| d Click on OK.

| Configure Partner LU 6.2
| To configure the partner LU:

| 1 In the Configuration options  field, select Configure partner LU , then click on
| the New button. The Define a partner LU 6.2 window appears.

| 2 In the Partner LU name  fields, type in the network ID .3/ and the partner LU
| name .2/ (SPIFNET.NYM2DB2).

| 3 In the Partner LU alias  field, type in the partner LU name .2/ from the
| worksheet (NYM2DB2).

| 4 In the Fully-qualified CP name  fields, type in the network ID .3/ and the
| adjacent control point SSCP name .4/ (SPIFNET.NYX).

| Accept the defaults in the Advanced tab panel.

| 5 Click on OK.

|  Configure Modes
| To configure the mode:

| 1 In the Configuration options  field, select Configure modes , then click on the
| New button. The Define a mode window appears.

| 2 In the Mode name  field .6/ of the Basic tab panel, type in the mode name
| (IBMRDB).

| 3 Click on the Advanced  tab and ensure that the Class of Service Name  is set to
| #CONNECT.

| Accept the defaults for the other fields.

| 4 Click on OK.

| Configure Local LU 6.2
| To configure the local LU 6.2:

| 1 In the Configuration options  field, select Configure local LU 6.2 , then click on
| the New button. The Define a local LU 6.2 window appears.
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| 2 In the Local LU name  field, type in the name .11/ from the worksheet
| (NYX1GW01).

| 3 Type in a value for the LU session limit  field. The default, 0, specifies the
| maximum allowed value.

| Accept the defaults for the other fields.

| 4 Click on OK.

| Configure CPI-C Side Information
| To configure the CPI-C side information:

| 1 In the Configuration options  field, select Configure CPI-C side information ,
| then click on the New button. The Define CPI-C side information window appears.

| 2 In the Symbolic destination name  field, type in the name .16/ from the
| worksheet (DB2CPIC).

| 3 In the Mode name  field, type in the name .15/ from the worksheet (IBMRDB).

| 4 In the Partner LU Name  fields, type the Net ID .3/ in the first field, and the
| Partner LU Name .2/ (SPIFNET.NYM2DB2) in the second field.

| 5 Specify the TP name. In the TP name  field:

| ¹ To specify a non-service TP, in the TP name  field, type in the name of the
| non-service TP, for example DB2DRDA, and ensure that there is no  check mark
| in the Service TP  check box.

| ¹ To specify a service TP, in the TP name  field, type in the name of the
| service TP, for example 076DB, and ensure that there is  a check mark in the
| Service TP  check box.

| Accept the defaults for the other fields.

| 6 Click on OK.

| Save the Configuration
| To save the configuration:

| 1 From the File  button on the menu bar, select Save As . The Save As window
| appears.

| 2 Type in a file name, for example ny3.acg, then click on OK.

| 3 In the dialog box that appears, you are asked if you want this configuration to be
| the default. Click on the Yes button.
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| You now need to update the DB2 directories, test the connection, and bind utilities and
| applications to the server. The easiest way to do this is to use the CCA as described in
| Chapter 9, “Configuring Host and AS/400 Connections on OS/2 and Windows NT Workstations”
| on page 53. However, you can also perform these steps manually as described in the sections
| that follow.

| Update the Environment
| IBM Personal Communications uses an environment variable called appcllu  to
| communicate with DB2. You may set this variable on a per-session basis by opening a
| command window and typing set appcllu=local_lu_name, however you will probably
| find it more convenient to permanently set the variable. In order to permanently set the
| variable in Windows NT, do the following:

| 1. Click the Start  button and choose Settings ->Control Panel . Double-click on the
| System  icon. When the System Properties  window appears, select the
| Environment  tab.

| 2. Type appcllu in the Variable  field, and type your local LU name .11/ in the Value
| field.

| 3. Click Set to accept the changes then click OK to exit the System Properties
| window.

| The environment variable will now remain set for future sessions.

| Step 3. Start SNA Node Operations

| To start SNA node operations on your machine:

| 1. Click on the Start  button, then choose Programs ->IBM Personal
| Communications ->Administrative and PD Aids -> SNA Node Operations . The
| Personal Communications SNA Node Operations  window opens.

| 2. From the menu bar, click on Operations  and choose Start Node . In the dialog box
| that opens, select the configuration file you saved at the end of Step 2 (in our
| example, ny3.acg). Click OK.

| SNA node operations will now begin running.
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| Step 4. Update the DB2 Directories

| To configure the DB2 directories, do the following at the DB2 Connect workstation:

| 1 Catalog the DRDA server as an APPC node. The syntax of the command is:

| catalog appc node node_name remote sym_dest_name security program

| For example:

| catalog appc node DB2NODE remote DB2CPIC security program

| Note:  The case of the sym_dest_name (DB2CPIC in this example) must match
| the case of the Symbolic Destination Name in the CPI-C Symbolic
| Destination Name Properties definition.

| 2 Catalog a database alias for the remote database. The syntax of the command is:

| catalog db local_dbname as db_alias at node node_name authentication dcs

| For example:

| catalog db DB2DB as NYC3 at node DB2NODE authentication dcs

| 3 Catalog the remote database as a Data Connection Services (DCS) database.
| The syntax of the command is:

| catalog dcs db local_dbname as real_host_dbname

| For example:

| catalog dcs db DB2DB as NEW_YORK3

| In the DB2 commands above:

| ¹ node_name can be any valid eight-character name

| ¹ sym_dest_name is the name of your Side Information Profile (.16/)

| ¹ local_dbname can be any valid eight-character name

| ¹ db_alias can be any valid eight-character name

| ¹ real_host_dbname is the name of the database you want to connect to at the
| DRDA server (.5/).
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| Step 5. Test the Connection

| Issue the following command from the command line processor window at the DB2
| Connect server, remembering to substitute your db_alias value from the previous step:

| connect to db_alias user userid using password

| For example:

| connect to NYC3 user userid using password

| The user ID and password values required are those defined at the host or AS/400,
| and must be provided to you by your DB2 Administrator.

| Step 6. Bind the Utilities and Applications

| The steps you have just completed set up the DB2 Connect workstation to
| communicate with the host. You must now bind the utilities and applications to the
| DRDA server.

| To bind the utilities and applications to the DRDA server, connect to the DRDA server
| and use commands similar to the following:

| connect to dbalias user userid using password

| bind path/bnd/@ddcsmvs.lst blocking all sqlerror continue

| messages mvs.msg grant public

|  connect reset

| where path corresponds to the DB2PATH registry value. These commands are
| described in detail in the DB2 Connect User's Guide.

| Once you have completed these steps, see Chapter 21, “Getting Started with DB2 Universal
| Database” on page 141 for details on the many functions that are available to use with DB2.
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 Chapter 14. Configuring IBM
Communications Server for Windows NT

Read this chapter if you have a Windows NT workstation that has IBM Communications
Server for Windows NT installed.

Before you begin, ensure that the IBM Communications Server for Windows NT you
installed:

| ¹ is Version 5.0 or higher if you are planning to update multiple databases within the
| same transaction; if you are planning to use 2-phase commit then Version 5.01 of
| IBM Communication Server is required

¹ has the IBM Communications Server IEEE 802.2 LAN interface (this is an
installation option for Communications Server)

| ¹ has the LLC2 driver installed from the IBM Communications Server installation
| directory. During installation CS/NT asks if you want to install LLC2. If you are not
| sure whether LLC2 was installed with your copy of CS/NT, you can find out as
| follows:

| 1 Click on the Start  button, then select Settings ->Control Panel .

| 2 Double-click on the Network  icon.

| 3 On the Network window, click on the Protocols  tab. IBM LLC2 Protocol
| must be one of the protocols listed. If it is not, you need to install this protocol
| from your IBM Communications Server for Windows NT software. Refer to its
| documentation for instructions.

Step 1. Fill In the Worksheet

Before you configure the DB2 Connect workstation, have your host-side administrator
and LAN administrator fill in copies of the following worksheet for each host to which
you want to connect (see Table 8 on page 95).

To help you fill in the worksheets, Figure 9 illustrates a sample network that has DB2
Connect using APPC to connect to DB2 for OS/390. The values shown in this diagram
correspond to the Sample Value entries in the worksheet.

After you fill in the Your Value entries, you can use the worksheet to configure IBM
Communications Server for Windows NT. As you perform the configuration, replace the
sample values that appear in the configuration instructions with your values from the
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worksheet. Use the boxed numbers .1/ to relate the configuration instructions to the
worksheet values.

System Database Directory

DCS Directory

APPC Local LU Properties

Communications Server VTAM

DB2 CONNECT TO NYC3 USER <USERID> USING <PASSWORD>

NCP

Node name

Symbolic dest name

Security

DB2NODE

DB2CPIC

PROGRAM

Node Directory

DB alias

DB name

Node

Authentication

NYC3

DB2DB

DB2NODE

DCS

Database

Target DB name

DB2DB

NEW_YORK3

Local node characteristics

Network ID

Local CP name

Local node ID

Mode definition

Local LU name

LAN connection to a host

Destination addr.

Partner LU name

CPI communications side information

Symbolic dest. name

Qualified partner LU

Mode name

SPIFNET

NYX1

05D 27509

IBMRDB

NYX1GW01

400009451902

NYM2DB2

DB2CPIC

SPIFNET.NYM2DB2

IBMRDB

NETID

APPL

PU

IDBLK=
IDNUM=

LU

MODEENT

SPIFNET

NYM2DB2

NYX1

05D
27509

NYX1GW01

IBMRDB

LOCADD=
400009451902

DB2 for OS390NEW_YORK3

NYM2DB2
LOCATION
LUNAME

Figure 9. Configuration on the DRDA Server and DB2 Connect Workstation

Figure 9 illustrates the correspondences between information specified on the DRDA
server system, information specified in Communications Server, and information
specified in DB2 directories. The values shown in the diagram are the example values
used in the instructions in this chapter.
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Table 8. Worksheet for Planning OS/390, MVS, VM, VSE, or OS/400 Connections

| Ref.| CS/NT Admin Name| VTAM Name| Sample Value| Your Value

Network Elements at the Host

.1/ Host Name Network name SPIFNET

.2/ Partner LU Name Application Name NYM2DB2

.3/ Network ID SPIFNET

.4/ Control Point Name OS/390, MVS, VM, VSE:
SSCP Name

OS/400: Local Control
Point Name

NYX

.5/ Database name OS/390 or MVS:
Location
Name

VM/VSE: RDB_Name

NEW_YORK3

.6/ Mode Name IBMRDB

.7/ Link Station Name LINKHOST

Network Connection Information

.8/ Destination address 400009451902

Network Elements at the DB2 Connect Workstation

.9/ Network Name SPIFNET

.10/ Local Control Point
Name

NYX1

.11/ Local LU name NYX1GW01

.12/ Local LU alias NYX1GW01

.13/ Local Node ID Block ID 05D

.14/ Physical Unit ID 27509

.15/ Mode name IBMRDB

.16/ Symbolic Destination
name

DB2CPIC

.17/ (Remote) Transaction
program (TP) name

| X'07F6C4C2' (or
| RDB_NAME for
| VM, AXE
| transaction name
| for VSE,
| DB2DRDA for
| MVS or OS/390,
| QCNTEDDM for
| AS/400)

DB2 Directory Entries (at the DB2 Connect workstation)

.18/ Node name db2node

.19/ Security Program

.20/ Database name db2db

.21/ Database alias nyc3

  Chapter 14. Configuring IBM Communications Server for Windows NT 95



Step 2. Configure the SNA Node

To start IBM Communications Server for NT, click on the Start  button, then select
Programs ->IBM Communications Server ->SNA Node Configuration . The IBM
Communications Server SNA Node Configuration screen appears.

From the File  button on the menu bar, select New->Advanced . The Configuration
options  field appears.

To configure the DB2 Connect workstation, you need to configure the following
Configuration options :

¹ “Configure Node” on page 97
¹ “Configure Devices” on page 98
¹ “Configure the Gateway” on page 98 (used with Communications Server for

Windows NT SNA Client only)
¹ “Configure Connections” on page 98
¹ “Configure Partner LU 6.2” on page 99
¹ “Configure Modes” on page 99
¹ “Configure Local LU 6.2” on page 100
¹ “Configure CPI-C Side Information” on page 100

After each step, you return to the window that has the Configuration options  field.

96 DB2 Connect Personal Edition Quick Beginnings  



 Configure Node
To configure the node:

1 In the Configuration options  field, select Configure Node , then click on the
New button. The Define the Node window appears.

2 In the Fully qualified CP name  fields, type in the network name .9/ and the
local control point name .10/ (SPIFNET.NYX1).

3 Optionally, in the CP alias  field, type in a CP alias. If you leave this blank the
local control point name .10/ will be used (NYX1).

4 In the Local Node ID  fields, type in the block ID .13/ and the physical unit ID
.14/ (05D.27509).

| 5 Select the appropriate node type. The default is to select the End Node  radio
| button.

6 Click on OK.
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 Configure Devices
To configure the device:

1 In the Configuration options  field, select Configure devices .

2 Ensure that in the DLCs  field, the appropriate DLC is highlighted. For example,
LAN .

3 Click on the New button. The appropriate window appears with default values
displayed. For example, the Define a LAN device window.

4 Click on OK to accept the default values.

Configure the Gateway
You need to perform this step only if you are setting up Communications Server to
accept requests from Communications Server for Windows NT SNA Client, as
described in Chapter 15, “Configuring IBM Communications Server for Windows NT
SNA Client” on page 105. To configure the gateway:

1 In the Configuration options  field, select Configure the Gateway , then click on
the New button. The Define Gateway window appears.

| 2 Click on the SNA Clients  tab.

3 Ensure that there is a check mark in the Enable SNA API Client Services  check
box.

4 Click on OK to accept the default values.

 Configure Connections
To configure the connections:

1 In the Configuration options  field, select Configure connections .

2 Ensure that in the DLCs  field, LAN  is highlighted.

3 Click on the New button. The Define a LAN connection window appears.

4 On the Basic tab panel:

a In the Link station name  field, type in the name .7/ from the worksheet
(LINKHOST).

b In the Destination address  field, type in the address .8/ from the
worksheet (400009451902).

5 On the Security tab panel:
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a In the Adjacent CP name  fields, type in the network ID .3/ and the Control
Point name .4/ (SPIFNET.NYX).

| b In the Adjacent CP type  field, select the appropriate CP type (eg.
| Back-level LEN ).

c Ensure that TG number  is set to 0 (the default).

d Click on OK.

Configure Partner LU 6.2
To configure the partner LU:

1 In the Configuration options  field, select Configure partner LU , then click on
the New button. The Define a partner LU 6.2 window appears.

2 In the Partner LU name  fields, type in the network ID .3/ and the partner LU
name .2/ (SPIFNET.NYM2DB2).

3 In the Partner LU alias  field, type in the partner LU name .2/ from the
worksheet (NYM2DB2).

4 If you are configuring Communications Server for SNA Clients, in the
Fully-qualified CP name  fields, type in the network ID .3/ and the adjacent
control point SSCP name .4/ (SPIFNET.NYX).

Leave the other fields blank.

5 Click on OK.

 Configure Modes
To configure the mode:

1 In the Configuration options  field, select Configure modes , then click on the
New button. The Define a mode window appears.

2 In the Mode name  field .6/, type in the mode name (IBMRDB).

3 Click on the Advanced  tab and ensure that the Class of Service Name  is set to
#CONNECT.

Accept the defaults for the other fields.

4 Click on OK.
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Configure Local LU 6.2
To configure the local LU 6.2:

1 In the Configuration options  field, select Configure local LU 6.2 , then click on
the New button. The Define a local LU 6.2 window appears.

2 In the Local LU name  field, type in the name .11/ from the worksheet
(NYX1GW01).

3 Type in a value for the LU session limit  field. The default, 0, specifies the
maximum allowed value.

Accept the defaults for the other fields.

4 Click on OK.

Configure CPI-C Side Information
To configure the CPI-C side information:

1 In the Configuration options  field, select Configure CPI-C side information ,
then click on the New button. The Define CPI-C side information window appears.

2 In the Symbolic destination name  field, type in the name .16/ from the
worksheet (DB2CPIC).

3 In the Mode name  field, type in the name .15/ from the worksheet (IBMRDB).

4 Click on the radio button beside Use Partner LU alias  and select a Partner LU
alias.

5 Specify the TP name. In the TP name  field:

¹ To specify a non-service TP, in the TP name  field, type in the name of the
non-service TP, for example DB2DRDA, and ensure that there is no  check mark
in the Service TP  check box.

¹ To specify a service TP, in the TP name  field, type in the name of the
service TP, for example 076DB, and ensure that there is  a check mark in the
Service TP  check box.

Accept the defaults for the other fields.

6 Click on OK.
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Save the Configuration
To save the configuration:

1 From the File  button on the menu bar, select Save As . The Save As window
appears.

2 Type in a file name, for example ny3.acg, then click on OK.

3 In the dialog box that appears, you are asked if you want this configuration to be
the default. Click on the Yes button.

You now need to update the DB2 directories, test the connection, and bind utilities and
applications to the server. The easiest way to do this is to use the CCA as described in
Chapter 9, “Configuring Host and AS/400 Connections on OS/2 and Windows NT Workstations”
on page 53. However, you can also perform these steps manually as described in the sections
that follow.

| Update the Environment
| IBM Personal Communications uses an environment variable called appcllu  to set the
| default APPC Local LU. You may set this variable on a per-session basis by opening a
| command window and typing set appcllu=local_lu_name, however you will probably
| find it more convenient to permanently set the variable. In order to permanently set the
| variable in Windows NT, do the following:

| 1. Click the Start  button and choose Settings ->Control Panel . Double-click on the
| System  icon. When the System Properties  window appears, select the
| Environment  tab.

| 2. Type appcllu in the Variable  field, and type your local LU name .11/ in the Value
| field.

| 3. Click Set to accept the changes then click OK to exit the System Properties
| window.

| The environment variable will now remain set for future sessions.
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| Step 3. Start SNA Node Operations

| To start SNA node operations on your machine:

| 1. Click on the Start  button, then choose Programs ->IBM Communication
| Server ->SNA Node Operations . The SNA Node Operations  window opens.

| 2. From the menu bar, click on Operations  and choose Start Node . In the dialog box
| that opens, select the configuration file you saved at the end of Step 2 (in our
| example, ny3.acg). Click OK.

| SNA node operations will now begin running.

Step 4. Update the DB2 Directories

To configure the DB2 directories, do the following at the DB2 Connect workstation:

1 Catalog the DRDA server as an APPC node. The syntax of the command is:

catalog appc node node_name remote sym_dest_name security program

For example:

catalog appc node DB2NODE remote DB2CPIC security program

Note:  The case of the sym_dest_name (DB2CPIC in this example) must match
the case of the Symbolic Destination Name in the CPI-C Symbolic
Destination Name Properties definition.

| 2 Catalog a database alias for the remote database. The syntax of the command is:

| catalog db local_dbname as db_alias at node node_name authentication dcs

| For example:

| catalog db DB2DB as NYC3 at node DB2NODE authentication dcs

| 3 Catalog the remote database as a Data Connection Services (DCS) database.
| The syntax of the command is:

| catalog dcs db local_dbname as real_host_dbname

| For example:

| catalog dcs db DB2DB as NEW_YORK3

In the DB2 commands above:

¹ node_name can be any valid eight-character name

¹ sym_dest_name is the name of your Side Information Profile (.16/)
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¹ local_dbname can be any valid eight-character name

¹ db_alias can be any valid eight-character name

¹ real_host_dbname is the name of the database you want to connect to at the
DRDA server (.5/).

Step 5. Test the Connection

Issue the following command from the command line processor window at the DB2
Connect server, remembering to substitute your db_alias value from the previous step:

connect to db_alias user userid using password

For example:

connect to nyc3 user userid using password

The user ID and password values required are those defined at the host or AS/400,
and must be provided to you by your DB2 Administrator.

Step 6. Bind the Utilities and Applications

The steps you have just completed set up the DB2 Connect workstation to
communicate with the host. You must now bind the utilities and applications to the
DRDA server.

To bind the utilities and applications to the DRDA server, connect to the DRDA server
and use commands similar to the following:

connect to dbalias user userid using password

bind path/bnd/@ddcsmvs.lst blocking all sqlerror continue

messages mvs.msg grant public

 connect reset

where path corresponds to the DB2PATH registry value. These commands are
described in detail in the DB2 Connect User's Guide.

Once you have completed these steps, see Chapter 21, “Getting Started with DB2 Universal
Database” on page 141 for details on the many functions that are available to use with DB2.
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 Chapter 15. Configuring IBM
Communications Server for Windows NT
SNA Client

Read this chapter if you have a Windows NT workstation that has IBM Communications
Server for Windows NT SNA Client Version 5.0 or higher installed and you want to
connect to an IBM Communications Server for Windows NT server.

The Communications Server for Windows NT server and its SNA Client act as a split
client. This configuration requires that you have an APPC-enabled application (such as
DB2 Connect) running on the SNA Client workstation.

Note:  The instructions in this chapter describe how to configure the SNA Client portion
of the split client. See Chapter 14, “Configuring IBM Communications Server for
Windows NT” on page 93 to configure the server portion of the split client.

The instructions in this chapter use a Windows NT client. The instructions for
other supported operating systems are similar; refer to your Communications
Server for Windows NT documentation for more information.

Step 1. Fill In the Worksheet

Before you configure the DB2 Connect workstation, have your host-side administrator
and LAN administrator fill in copies of the following worksheet for each host to which
you want to connect (see Table 9 on page 106).

After you fill in the Your Value entries, you can use the worksheet to configure IBM
Communications Server for Windows NT SNA Client. As you perform the configuration,
replace the sample values that appear in the configuration instructions with your values
from the worksheet. Use the boxed numbers .1/ to relate the configuration instructions
to the worksheet values.
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Table 9. Worksheet for Planning SNA Client Connections to Communications Server/NT

Ref. SNA Client Name Sample Value Your Value

Network Elements at the Host

.1/ Host Name SPIFNET

.2/ Partner LU Name NYM2DB2

.3/ Network ID SPIFNET

.4/ Control Point Name NYX

.5/ Database name NEW_YORK3

.6/ Mode Name IBMRDB

.7/ Link Station Name LINKHOST

Network Connection Information

.8/ Destination address 400009451902

Network Elements at the DB2 Connect Workstation

.9/ Network Name SPIFNET

.10/ Local Control Point Name NYX1

.11/ Local LU name NYX1GW01

.12/ Local LU alias NYX1GW01

.13/ Block ID 05D

.14/ Physical Unit ID 27509

.15/ Mode name IBMRDB

.16/ Symbolic Destination
name

DB2CPIC

.17/ (Remote) Transaction
program (TP) name

| X'07F6C4C2' (or
| RDB_NAME for
| VM, AXE
| transaction name
| for VSE, or
| DB2DRDA for
| MVS or OS/390)

DB2 Directory Entries (at the DB2 Connect workstation)

.18/ Node name db2node

.19/ Security Program

.20/ Database name db2db

.21/ Database alias nyc3

Elements at the Communications Server

.22/ User name CSNTUS1

.23/ Password ********

.24/ IP address 123.123.123.123
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Step 2. Create a User Name on the
Communications Server for Windows NT
Server

On the Communications Server for Windows NT server, you need to create a user
name that permits the SNA client to access the server. To create a user name:

1 Click on the Start  button, then select Programs ->Administrative Tools
(Common) ->User Manager . The User Manager window appears.

2 On the User Manager's menu bar, select Users ->New User . The New User
window appears.

3 Type in values for the following fields:

User Name CSNTUS1

Full Name CS/NT Client 1

Description  optional

Password  ********

Confirm Password ********

4 Click on the Groups  button. The Group Memberships window appears. By
default, the user name you are defining is a member of only the Users  group.

5 Make your new user name a member of each of the following groups by selecting
the group name, then clicking on the Add  button:

¹ The Administrators  group

¹ The IBMCSADMIN  group

¹ The IBMCSAPI  group.

6 Click on OK.

Step 3. Configure the SNA Client

| To configure the IBM Communications Server for Windows NT SNA Client, at the client
| workstation click on the Start  button, then select Programs ->IBM Communications
| Server SNA Client ->Configuration . The Configuration File (*.acg) – CS/NT SNA Client
| Configuration window appears.

  Chapter 15. Configuring IBM Communications Server for Windows NT SNA Client 107



To configure the client workstation, you need to configure the following options:

¹ “Configure Global Data”
¹ “Configure APPC Server List” on page 109
¹ “Configure CPI-C Side Information” on page 109
¹ “Configure Transaction Programs” on page 109

After each step, you return to the CS/NT SNA Client Configuration window.

Configure Global Data
To configure the global data:

1 In the Configuration options  field, select Configure Global Data , then click on
the New button. The Define Global Data window appears.

2 In the User name  field, type in the name .22/ from the worksheet (CSNTUS1). This
is the user name that was defined in “Step 2. Create a User Name on the
Communications Server for Windows NT Server” on page 107.
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3 In the Password  and Confirm Password  fields, type in the password .23/ that
was defined in “Step 2. Create a User Name on the Communications Server for
Windows NT Server” on page 107.

4 Click on OK.

Configure APPC Server List
To configure the APPC Server list:

1 In the Configuration options  field, select Configure APPC Server List , then
click on the New button. The Define APPC Server list window appears.

2 Type in the IP address .24/ of the server (123.123.123.123).

3 Click on OK.

Configure CPI-C Side Information
To configure the CPI-C side information:

1 In the Configuration options  field, select Configure CPI-C side information ,
then click on the New button. The Define CPI-C side information window appears.

2 In the Symbolic destination name  field, type in the name .16/ from the
worksheet (DB2CPIC).

3 In the Local LU alias  field, type in the name .12/ from the worksheet (NYX1GW01).

Note:  Ensure that this Transaction Program has a check mark in the For SNA
API Client use  check box.

4 In the Mode name  field, type in the name .15/ from the worksheet (IBMRDB).

5 In the TP name  field, type in the name .17/ from the worksheet (DB2DRDA).

6 In the Partner LU name  field, type in the network ID .3/ and the partner LU
name .2/ from the worksheet (SPIFNET.NYM2DB2), or type in the Partner LU alias .

7 Click on OK.

Configure Transaction Programs
To configure a transaction program:

1 In the Configuration options  field, select Configure Transaction Programs ,
then click on the New button. The Define a Transaction Program window appears.
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2 In the Transaction Program  field, type in the name .17/ from the worksheet
(DB2DRDA).

3 In the Local LU alias  field, type in .12/ from the worksheet (NYX1GW01).

4 If the Transaction Program you specified is a service TP, ensure that there is a
check mark in the Service TP  check box. The example TP DB2DRDA is not a
service TP.

5 Ensure that there is no  check mark in the Attach Manager started  check box.

| 6 Ensure that the Background Process  box is checked.

7 Click on OK.

Save the Configuration
To save the configuration:

1 From the File  button on the menu bar, select Save As . The Save As window
appears.

2 Type in a file name, then click on Save.

Step 4. Update the DB2 Directories

To configure the DB2 directories, do the following at the SNA client workstation:

1 Catalog the DRDA server as an APPC node. The syntax of the command is:

catalog appc node node_name remote sym_dest_name security program

For example:

catalog appc node DB2NODE remote DB2CPIC security program

Note:  The case of the sym_dest_name (DB2CPIC in this example) must match
the case of the Symbolic Destination Name in the CPI-C Symbolic
Destination Name Properties definition.

| 2 Catalog a database alias for the remote database. The syntax of the command is:

| catalog db local_dbname as db_alias at node node_name authentication dcs

| For example:

| catalog db DB2DB as NYC3 at node DB2NODE authentication dcs
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| 3 Catalog the remote database as a Data Connection Services (DCS) database.
| The syntax of the command is:

| catalog dcs db local_dbname as real_host_dbname

| For example:

| catalog dcs db DB2DB as NEW_YORK3

In the DB2 commands above:

¹ node_name can be any valid eight-character name

¹ sym_dest_name is the name of your Side Information Profile (.16/).

¹ local_dbname can be any valid eight-character name

¹ db_alias can be any valid eight-character name

¹ real_host_dbname is the name of the database you want to connect to at the
DRDA server (.5/).

You now need to update the DB2 directories, test the connection, and bind utilities and
applications to the server. The easiest way to do this is to use the CCA as described in
Chapter 8, “Configuring Host and AS/400 Connections on Windows 3.1 or 3.11 Workstations” on
page 49 or Chapter 9, “Configuring Host and AS/400 Connections on OS/2 and Windows NT
Workstations” on page 53. However, you can also perform these steps manually as described in
the sections that follow.

Step 5. Test the Connection

Issue the following command from the command line processor window at the SNA
Client, remembering to substitute your db_alias value from the previous step:

connect to db_alias user userid using password

For example:

connect to nyc3 user CSNTUS1 using password

The user ID and password values required are those defined at the host or AS/400,
and must be provided to you by your DB2 Administrator.
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Step 6. Bind the Utilities and Applications

The steps you have just completed set up the DB2 Connect workstation to
communicate with the host. You must now bind the utilities and applications to the
DRDA server.

To bind the utilities and applications to the DRDA server, connect to the DRDA server
and use commands similar to the following:

connect to dbalias user userid using password

bind path/bnd/@ddcsmvs.lst blocking all sqlerror continue

messages mvs.msg grant public

 connect reset

where path corresponds to the DB2PATH registry value. These commands are
described in detail in the DB2 Connect User's Guide.

Once you have completed these steps, see Chapter 21, “Getting Started with DB2 Universal
Database” on page 141 for details on the many functions that are available to use with DB2.
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| Chapter 16. Configuring Microsoft SNA
| Server Version 4.0 for Windows NT

Read this chapter if you have a Windows NT Server system that has Microsoft SNA
Server Version 4.0 installed. Although Microsoft SNA Server will run on Windows NT
4.0 Workstation, Windows NT 4.0 Server is recommended.

Note:  You must have Windows NT Fix Pack 3 installed in order to run SNA Server
Version 4.0.

Step 1. Fill in the Worksheet

Before you configure the system for DB2 Connect, have your host-side administrator
and LAN administrator fill in copies of the following worksheet for each host to which
you wish to connect.

To help you fill in the worksheet, Figure 10 on page 116 illustrates a sample network
that has DB2 Connect running on an OS/2 system and uses APPC to connect to DB2
for OS/390. The values shown in this diagram correspond to the Sample Value entries
in the worksheet.

After you fill in the Your Value entries, you can use the worksheet to configure
Microsoft SNA Server. As you configure Microsoft SNA Server, replace the sample
values that appear in the configuration instructions with your values from the worksheet.
Use the boxed numbers (eg. .1/) to relate the configuration instructions to the
worksheet values.

In the configuration instructions, the .*/ symbol denotes entries that need to be
changed but do not have a representation on the worksheet.
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| Table 10. Worksheet for Planning OS/390, MVS, VM, VSE, or OS/400 Connections

Ref.
SNA Server Admin
Name VTAM Name Sample Value Your Value

| Network Elements at the Host

| .1/| Host Name| NETID| SPIFNET

| .2/| Remote LU Name| APPL| NYM2DB2

| .3/| Network ID| SPIFNET

| .4/| Control Point Name| OS/390, MVS, VM, VSE:
| SSCP Name

| OS/400: Local Control
| Point Name

| NYX

| .5/| Database name| OS/390 or MVS:
| Location
| Name

| VM/VSE: RDB_Name

| NEW_YORK3

| .6/| Mode Name| IBMRDB

| .7/| Connection Name| LINKHOST

| Network Connection Information

| .8/| Remote Network
| address
| 400009451902

| Network Elements at the DB2 Connect Workstation

| .9/| NETID| SPIFNET

| .10/| Local Control Point
| Name
| PU Definition| NYX1

| .11/| (Local) LU name| LU Definition| NYX1GW01

| .12/| (Local) LU alias| Modeent| NYX1GW01

| .13/| Local Node ID| ID BLK| 05D

| .14/| ID NUM| 27509

| .15/| Mode name| IBMRDB

| .16/| Symbolic Destination
| name
| DB2CPIC

| .17/| (Remote) Transaction
| program (TP) name
| X'07F6C4C2' (or
| RDB_NAME for
| VM, AXE
| transaction name
| for VSE, or
| DB2DRDA for
| MVS or OS/390)

| DB2 Directory Entries (at the DB2 Connect workstation)

| .18/| Node name| db2node

| .19/| Security| Program

| .20/| Database name| db2db

| .21/| Database alias| nyc3

For an OS/390, MVS, VSE, or VM connection, you need the control point name of your
DB2 Connect workstation. Your network administrator can provide you with this
information.
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Step 2. Define Server Properties

You can define the properties of your SNA connections in the Microsoft SNA Server
Manager. To access the manager, click on the Windows NT Start button, then select
Programs->Microsoft SNA Server->Manager.

The Microsoft SNA Server Manager uses an interface similar to that of the Windows NT
Explorer. Figure 10 on page 116 shows the interface. There are two panes in the main
window of the Manager. All the configuration options we will be using can be accessed
by clicking the right mouse button on objects in the left-hand pane of the window. Every
object has a context menu that you can access by right-clicking on the object.

Define Control Point Name
The first step to configuring Microsoft SNA Server for DB2 Connect is to define the
correct Control Point Name for your NT Server. Do the following:

1. Right-click on SNA Service and select Properties. The Properties dialog box
appears.

2. Enter the correct NETID .9/ and Control Point Name  .4/ in the corresponding
fields of the dialog box.

3. Click OK to accept the changes.

Define Link Service (802.2)
Your next step is to set the properties of the link server. Perform the following steps:

1. Open the Servers folder in the left pane of the Manager by clicking the mouse on
the plus sign next to the Server folder icon.

2. Click the right mouse button (right-click) on the server icon nested underneath the
Servers folder.

3. Select Insert->Link Service. The Insert Link Service  pop-up window appears.

4. Select DLC 802 2 Link Service. Press Add, then Finish.

Define Connection Properties
To specify the type of connection DB2 Connect will be using, do the following:

1. Right-click on SNA Service and select Insert->Connection->802.2. The Connection
Properties  dialog box appears.
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Figure 10. The Microsoft SNA Server Manager. 

2. Under the General  tab, enter a connection name .7/ in the Name field.

3. Choose the Link Service Type  (SnaDlc1).

4. Set the Remote End  radio button to Host System .

a. Set the Allowed Directions  radio button to Both Directions .

b. Set the Activation  radio button to On Server Startup .

5. Select the Address  tab and fill in the Remote Network Address  .8/ field. Accept
the default numbers in the other fields.

6. Select the System Identification  tab. Enter the following information

a. For the Local Node Name , add the NETID .1/, the Control Point Name  .4/,
and the Local Node ID  (.13/ plus .14/). Accept the XID Type  default.

b. For the Remote Node Name , add the NETID .1/ and the Control Point
Name .4/. Accept the other defaults

7. Click OK to exit.
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Define Local LU
To define the properties of the Local LU, do the following:

1. Right-click on SNA Service  and select Insert->APPC->Local Lu. The Local APPC
LU Properties  dialog box appears.

2. Under the General  tab, enter the following information:

a. The LU Alias  .12/.

b. The NETID .9/.

c. The LU Name  .11/.

3. Select the Advanced  tab, and select Member of Default Outgoing Local APPC
LU Pool . Accept the other defaults.

4. Click OK to exit.

Define Remote LU
To define the properties of the Remote LU, do the following:

| 1. Right-click on SNA Services  and select Insert->APPC->Remote LU.

| 2. Under the General  tab, select Connection  and enter the LU Alias  .2/. The other
| fields will be filled in by the program.

| Note:  If your LU alias is not the same as your LU Name, make sure you specify
| the LU Name in the appropriate field. The program will fill it in
| automatically, but it will be incorrect if the alias and the name are not the
| same.

3. Click OK to exit.

 Define Mode
To define the properties of the APPC Mode, do the following:

| 1. Right-click on the APPC Modes  folder icon, and select Insert->APPC->Mode
| Definition.

2. Under the General  tab, enter the Mode Name .6/.

3. Select the Limits  tab, and enter appropriate numbers for the Parallel Session
Limit  (eg. 30) and Minimum Contention Winner Limit  (eg. 15). Your Host-Side
or LAN administrator should be able to supply you with the numbers if you do not
know the limits you should place here.

4. Accept the other defaults, and click OK to exit.
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Define the CPIC Name Properties
To define the properties of the CPIC Name, do the following:

1. Right-click on CPIC Symbolic Name  and select Insert->APPC->CPIC Symbolic
Name. The CPIC Name Properties  dialog box appears.

2. Under the General  tab, enter the Symbolic Destination Name .16/ in the Name
field. Select a Mode Name  of IBMRDB. Accept the other defaults.

3. Select the Partner Information  tab.

a. Under Partner TP Name , select the SNA Service TP (in hex)  radio button.

b. Under Partner LU Name , select Fully Qualified  and enter the fully-qualified
Partner LU Name (.1/ and .2/) or alias.

4. Click OK to exit.

Step 3. Save the Configuration

Once you have entered all the settings for your SNA connection to DB2 Connect, click
on the File menu of the Server Manager window and select Save. The Save File dialog
box appears. Type a unique name for your configuration into the File Name field and
click Save. Your configuration is now saved.

Step 4. Update the DB2 Directories

To configure the DB2 directories, do the following at the DB2 Connect workstation:

1 Catalog the DRDA server as an APPC node. The syntax of the command is:

catalog appc node node_name remote sym_dest_name security program

For example:

catalog appc node DB2NODE remote DB2CPIC security program

Note:  The case of the sym_dest_name (DB2CPIC in this example) must match
the case of the Symbolic Destination Name in the CPI-C Symbolic
Destination Name Properties definition.

2 Catalog the remote database as a Data Connection Services (DCS) database.
The syntax of the command is:

catalog dcs db local_dbname as real_host_dbname
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For example:

catalog dcs db nyc3 as NEW_YORK3

3 Catalog a database alias for the remote database. The syntax of the command is:

catalog db local_dbname as db_alias at node node_name authentication dcs

For example:

catalog db DB2DB as nyc3 at node DB2NODE authentication dcs

In the DB2 commands above:

¹ node_name can be any valid eight-character name

¹ sym_dest_name is the name of your Side Information Profile (.16/).

¹ local_dbname can be any valid eight-character name

¹ db_alias can be any valid eight-character name

¹ real_host_dbname is the name of the database you want to connect to at the
DRDA server (.5/).

Step 5. Test the Connection

Issue the following command from the command line processor window at the DB2
Connect server, remembering to substitute your db_alias value from the previous step:

connect to db_alias user userid using password

For example:

connect to DB2DB user userid using password

The user ID and password values required are those defined at the host or AS/400,
and must be provided to you by your DB2 Administrator.

Step 6. Bind the Utilities and Applications

The steps you have just completed set up the DB2 Connect workstation to
communicate with the host. You must now bind the utilities and applications to the
DRDA server.

To bind the utilities and applications to the DRDA server, connect to the DRDA server
and use commands similar to the following:
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connect to dbalias user userid using password

bind path/bnd/@ddcsmvs.lst blocking all sqlerror continue

messages mvs.msg grant public

 connect reset

where path corresponds to the DB2PATH registry value. These commands are
described in detail in the DB2 Connect User's Guide.

Once you have completed these steps, see Chapter 21, “Getting Started with DB2 Universal
Database” on page 141 for details on the many functions that are available to use with DB2.
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Chapter 17. Configuring Microsoft SNA
Client

| Read this chapter if you have a Windows 3.1, Windows NT workstation that has DB2
| Connect installed. This chapter provides step-by-step instructions for setting up the
| communications between your DB2 Connect workstation and a Windows NT
| workstation that has Microsoft SNA Server V2.11 (or later) installed.

Figure 11 on page 122 illustrates the example DB2 Connect Server scenario.

 Assumptions

The rest of this chapter assumes:

1 The Microsoft SNA Server has already been configured for APPC
communications with the host, and is enabled for ODBC and DRDA. Refer to the
Microsoft SNA Server documentation for further information.

2 Microsoft SNA Client Version 2.11 is not already installed on your DB2 Connect
workstation.

Step 1. Obtain Required Information

For your Microsoft SNA client software to function properly you must have access to a
properly-configured Microsoft SNA Server. Request that your SNA Server administrator:

1 Obtain the proper license for you to use Microsoft SNA Client on your workstation.

2 Define a user ID for you on the SNA Server domain.

3 Define connections to the host and AS/400 databases that you need to access,
as described in Chapter 16, “Configuring Microsoft SNA Server Version 4.0 for
Windows NT” on page 113.

4 Provide you with the symbolic destination name to use for each database
connection defined in the previous step.
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Figure 11. DB2 Connect Server Scenario Using DB2 Connect, MS SNA Client, and MS SNA Server

If you plan to change host passwords, the SNA administrator will also need to
provide you with symbolic destination names for password management tasks on
each host. See Appendix E, “Changing Your MVS Password” on page 277 for
more information on changing host passwords.

Your host or AS/400 database administrator will need to:

1 Define a user ID and password on the host or AS/400 security system for you to
use.

2 Make sure that your user ID is granted proper access to database objects that
you will be working with.
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3 Provide you with the database name:

Location name on DB2/MVS or DB2 for OS/390

RDB on AS/400

DBNAME on DB2 for VM/VSE (SQL/DS)

Step 2. Install SNA Client on the DB2
Connect Workstation

1 Obtain the Microsoft SNA Client software, and follow the instructions provided
with it to start the installation program. For example, if you are installing from a
Microsoft SNA Server V2.11 CD-ROM, you will need to execute setup.exe in the
sna/clients/win3x subdirectory to install on a Windows 3.1 or Windows for
Workgroups 3.11 workstation.

| 2 Follow the instructions on the screen to complete the installation. Choose your
| SNA Server domain name and communication protocol according to the
| instructions provided by your SNA Server administrator.

3 When you reach the Optional Components panel deselect Install ODBC/DRDA
driver so that it will not be installed.

Step 3. Install DB2 Connect for Windows

| 1 Install DB2 Connect.

2 When the installation is completed, reboot.

3 Open the DB2 Folder, and click on the Client Configuration Assistant  (or, on
Windows 3.1, the Data Sources Setup  tool) to start the configuration dialog.

4 You need to provide the following information:

a The Symbolic Destination Name defined at the Microsoft SNA Server for the
Partner LU of the target DRDA host. This is .7/ on the example worksheet
for this configuration (Table 11 on page 124), and .24/ on the worksheet
provided for use with SNA Server (Table 10 on page 114 ).

b The real database name, for example the DB2 for OS/390 or DB2 for
MVS/ESA “LOCATION NAME.” This is .12/ on both worksheets.
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Table 11. Example Worksheet for Microsoft SNA Client Users

No. Description Sample Value Your Value

User Information

.1/ User Name A.D.B.User

.2/ Contact Info (123)-456-7890

Location

MS SNA Server Information  (provided by SNA Server administrator)

.3/ MS SNA Server domain name ACCOUNTS

.4/ Protocol used for communicating with SNA
Server (TCP/IP, NetBEUI, IPX/SPX)

NetBEUI

.5/ User ID used to login to the MS SNA Server
domain

ADBUSER

.6/ Password used to login to the MS SNA
Server domain

XXXXXXX

.7/ Database CPI-C symbolic destination name
(defined to MS SNA Server).

DB2CPIC

.8/ Password management CPI-C symbolic
destination name

DB2PEM

Database Information  (provided by host or AS/400 administrator)

.9/ Alias NYC3

.10/ Description New York DB
#3

.11/ Database Type DB2 for
MVS/ESA or
DB2 for
OS/390

.12/ Host database name NEW_YORK3

.13/ User ID assigned to you on your host or
AS/400 system

ADBUSER

.14/ Password to be used to connect to your host
or AS/400 system

XXXXXXXX

Update the DB2 Directories
To configure the DB2 directories, enter the following commands in the command line
processor:

1 Catalog the DRDA server as an APPC node. The syntax of the command is:

catalog appc node node_name remote sym_dest_name security program

For example:

catalog appc node DB2NODE remote DB2CPIC security program

Note:  The case of the sym_dest_name (DB2CPIC in this example) must match
the case of the Symbolic Destination Name that you defined when you
installed MS Client.
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| 2 Catalog the remote database as a Data Connection Services (DCS) database.
| The syntax of the command is:

| catalog dcs db local_dbname as real_host_dbname

| For example:

| catalog dcs db DB2DB as NEW_YORK3

3 Catalog a database alias for the remote database. The syntax of the command is:

catalog db local_dbname as db_alias at node node_name authentication dcs

For example:

catalog db DB2DB as nyc3 at node DB2NODE authentication dcs

In the DB2 commands above:

¹ node_name can be any valid eight-character name

¹ sym_dest_name is the name of your Side Information Profile.

¹ local_dbname can be any valid eight-character name

¹ db_alias can be any valid eight-character name

¹ real_host_dbname is the name of the database you want to connect to at the
DRDA server.

Test the Connection
Issue the following command from the command line processor window, remembering
to substitute your db_alias value from the previous step:

connect to db_alias user userid using password

| For example:

| connect to NYC3 user userid using password

The user ID and password values required are those defined at the host or AS/400,
and must be provided to you by your DB2 Administrator.
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| Chapter 18. Enabling Multisite Updates
| (Two-Phase Commit)

| This chapter provides an overview of the multisite update function as it applies to
| scenarios that involve host and AS/400 database servers. It describes products and
| components needed to implement PC, UNIX and web applications that update multiple
| DB2 databases in the same transaction.

| Multisite update, also known as Distributed Unit of Work (DUOW) and Two-Phase
| Commit, is a function that enables your applications to update data in multiple remote
| database servers with guaranteed integrity. A good example of a multisite update is a
| banking transaction that involves transfer of money from one account to another in a
| different database server. In such a transaction it is critical that updates that implement
| debit operation on one account do not get committed unless updates required to
| process credit to the other account are committed as well. The multisite update
| considerations apply when data representing these accounts is managed by two
| different database servers.

| DB2 products provide comprehensive support for multisite update. This support is
| available for applications developed using regular SQL as well as applications that
| utilize Transaction Monitor products that implement X/Open XA interface specification.
| Examples of such Transaction Monitor products include IBM TxSeries (CICS and
| Encina), Message and Queuing Series, Component Broker Series, San Francisco
| Project as well as Microsoft Transaction Server (MTS), BEA Tuxedo, NCR TopEnd and
| several others. There are different setup requirements depending on whether native
| SQL multisite update or TP Monitor multisite upate is used.

| Both the native SQL and TP Monitor multi-site update programs must be precompiled
| with the CONNECT 2 SYCNCPOINT TWOPHASE options. Both can use the SQL Connect
| statement to indicate which database they want to be used for the SQL statements that
| follow. If there is no TP Monitor to tell DB2 it is going to coordinate the transaction (as
| indicated by DB2 receiving the xa_open calls from the TP monitor to establish a
| database connection), then the DB2 software will be used to coordinate the transaction.

| When using TP monitor multi-site update, the application must request commit or
| rollback by using the TP monitor's API, e.g. CICS SYNCPOINT, Encina Abort(), MTS

| SetAbort(). When using native SQL muilti-update, the normal SQL COMMIT and
| ROLLBACK must be used.

| TP Monitor multi-site update can coordinate a transaction that accesses both DB2 and
| non-DB2 resource managers such as Oracle, Informix, SQLServer, etc. Native SQL
| multisite update is used with DB2 servers only.

| For a multisite update transaction to work each of the databases participating in a
| distributed transaction must be capable of supporting Distributed Unit of Work. At the
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| time of this writing the following DB2 servers provided DUOW support that enabled
| them to participate in distributed transactions:

| ¹ DB2 Common Server V2

| ¹ DB2 Universal Database V5

| ¹ DB2 for MVS/ESA V3.1 and 4.1

| ¹ DB2 for OS/390 V5.1

| ¹ DB2 Universal Database for OS/390 V6.1

| ¹ DB2/400 V3.1 or later

| ¹ DB2 Server for VM and VSE V5.1

| A distributed transaction can update any mix of supported database servers. For
| example, your application can update several tables in DB2 UDB on Windows NT, a
| DB2 for OS/390 database and a DB2/400 database all within a single transaction.

| Host and AS/400 database servers require DB2 Connect to participate in a distributed
| transaction originating from PC, UNIX, and web applications. In addition many of the
| multisite update scenarios that involve host and AS/400 database servers require that
| Syncpoint Manager (SPM) component be configured. The need for SPM is dictated by
| the choice of protocol (SNA vs. TCP/IP) and use of a TP monitor. See Table ?? on
| page 129 for a summary of scenarios that require use of the SPM. The table shows
| that DB2 Connect is required for any access to the host or AS/400 from Intel or UNIX
| machines. In addition, for multisite updates, the SPM component of DB2 Connect is
| required if the access is via SNA or uses a TP monitor.
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| Host and AS/400 multisite update scenarios that require SPM.

| TP Monitor Used?| Protocol| SPM Needed?| Product Required
| (choose One)
| Host and AS/400
| Database
| Supported

| Yes| TCP/IP| Yes|  ¹ DB2 Connect
| Enterprise
| Edition

|  ¹ DB2 UDB
| Enteprise
| Edition

|  ¹ DB2 UDB
| Extended
| Enterprise
| Edition

|  ¹ DB2 for
| OS/390 V5.1

| ¹ DB2 UDB for
| OS/390 V6.1

| Yes| SNA| Yes|  ¹ DB2 Connect
| Enterprise
| Edition*

|  ¹ DB2 UDB
| Enterprise
| Edition*

|  ¹ DB2 UDB
| Extended
| Enterprise
| Edition*

| Note:  *AIX, OS/2
| and
| Windows
| NT
| platforms
| only.

|  ¹ DB2 for
| MVS/ESA
| V3.1 and 4.1

|  ¹ DB2 for
| OS/390 V5.1

| ¹ DB2 UDB for
| OS/390 V6.1

|  ¹ DB2/400 V3.1
| or later

|  ¹ DB2 Server
| for VM or VSE
| V5.1

| No| TCP/IP| No|  ¹ DB2 Connect
| Personal
| Edition

|  ¹ DB2 Connect
| Enterprise
| Edition

|  ¹ DB2 UDB
| Enterprise
| Edition

|  ¹ DB2 UDB
| Extended
| Enterprise
| Edition

|  ¹ DB2 for
| OS/390 V5.1

| ¹ DB2 UDB for
| OS/390 V6.1
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| No| SNA| Yes|  ¹ DB2 Connect
| Enterprise
| Edition*

|  ¹ DB2 UDB
| Enterprise
| Edition*

|  ¹ DB2 UDB
| Extended
| Enterprise
| Edition*

| Note:  *AIX, OS/2
| and
| Windows
| NT
| platforms
| only

|  ¹ DB2 for
| MVS/ESA
| V3.1 and 4.1

|  ¹ DB2 for
| OS/390 V5.1

| ¹ DB2 UDB for
| OS/390 V6.1

|  ¹ DB2/400 V3.1
| or later

|  ¹ DB2 Server
| for VM and
| VSE V5.1

| Note: 

| For more information about DUOW refer to the DB2 Connect User's Guide.

| For additional information about DB2 Connect two-phase commit support, as
| well as instructions for setting up for several popular TP monitors, please see
| the Administration Guide or access the DB2 Product and Service Technical
| Library on the World Wide Web:

| 1. Set your Web browser to the following URL:

|  http://www.software.ibm.com/data/db2/library/

| 2. Select "DB2 Universal Database".

| 3. Search for "Technotes" using the search keywords "DDCS", "SPM", "MTS",
| "CICS", and "ENCINA".
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Part 5. Configuring Access to DB2
Universal Database Servers

 Copyright IBM Corp. 1993, 1998  131



132 DB2 Connect Personal Edition Quick Beginnings  



| Chapter 19. Configuring Access to a
| Remote DB2 Server Using the Client
| Configuration Assistant

The information in this section describes how to use the Client Configuration Assistant to
configure OS/2 and Windows 32-bit operating systems to access remote DB2 Universal Database
servers.

To configure communications to remote DB2 Universal Database servers without using the Client
Configuration Assistant, refer to the online Installing and Configuring DB2 Clients manual located
in x:\doc\language\html\db2iyx50.htm, where x is the letter that designates your CD-ROM and
language is the two-character country code that represents your language (for example, EN for
English). For more information on country codes, see Table 16 on page 264.

Use the Client Configuration Assistant to configure your OS/2 and Windows 32-bit
operating systems to access remote DB2 servers. The Client Configuration Assistant
provides three configuration methods:

¹ One method makes use of a server's access profile

¹ One method searches the network for databases

¹ One method requires that you enter the database name and the communication
protocol parameters for the DB2 server.

Perform the following steps to configure your workstation to access remote servers:

1 Start the Client Configuration Assistant.

For OS/2:
Double-click on the Client Configuration Assistant  icon, located in the DB2 for
OS/2 folder.

For Windows 32-bit operating systems:
Click on Start  and select Programs ->DB2 for Windows ->Client Configuration
Assistant .

The Welcome panel opens each time you start the CCA, until you have added at
least one database to your client.

2 Click on the Add Database  or Add  push button to configure connections using
the Add Database SmartGuide. Choose one of the following configuration
methods:

¹ If your administrator provided you a server profile, select the Use an access
profile  radio button and click on the Next  push button.
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a Click on the Browse  push button and select the appropriate access
profile.

b You are presented with a list of systems, instances, and databases.
Select the database that you want to add and proceed to Step 3.

¹ If you want to search the network for databases, select the Search the
network  radio button and click on the Next  push button.

a Click on the [+]  sign beside the Known Systems  icon to list all the
systems known to your workstation.

b Click on the [+]  sign beside a system to get a list of the instances and
databases on it. Select the database that you want to add and proceed
to Step 3.

c If the system that contains the database that you want to add is not
listed, click on the [+]  sign beside the Other Systems (Search the
network)  icon to search the network for additional systems. Click on
the [+]  sign beside a system to get a list of the instances and
databases in it. Select the database that you want to add and proceed
to Step 3.

| d If the system you want is still not listed, it can be added to the list of
| systems by clicking on the Add System  push button. Enter the required
| communication protocol parameters for the remote Administration
| Server and click on OK. For more information, click on the Help  push
| button.

| Select the database that you want to add and proceed to Step 3.

The Other Systems (Search the network)  icon will only appear if the
client's DISCOVER parameter is set to SEARCH (this is the default setting).
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¹ If you have the protocol information for the database that you want to connect
to, select the Manually configure a connection to a DB2 database  radio
button and click on the Next  push button.

a Select the radio button that corresponds to the protocol that you want to
| use from the Protocol  list and click on the Next  push button. If you
| selected the TCP/IP or APPC radio button, select the radio button that
| corresponds to the type of system where the database that you are
| trying to connect to resides.

b Enter the required communication protocol parameters and click on the
Next  push button. For more information, click on the Help  push button.

| c Enter the database alias name of the database that you want to
| connect to in the Target database  field and click on the Next  push
| button.

| 3 To specify a local database alias name or to add a description, click on the Next
| push button. If you do not want to specify a database alias name, or add a
| description, click on the Done  push button. If you do not specify a database alias
| name, the default will be the same as the remote database alias name.

| The Client Configuration Assistant may be unable to detect the remote
| system if:

| ¹ The Administration Server DISCOVER configuration parameter on the
| remote system is set to DISCOVER=DISABLE.

| ¹ The DB2COMM registry value and the DISCOVER_COMM
| configuration parameter are not configured on the Administration Server
| of the remote system with a discovery protocol being used on the client
| (the client discovery protocol is specified by the DISCOVER_COMM
| configuration parameter in the client's configuration).

| ¹ The Administration Server is not running on the remote system.

| ¹ By default, the Discovery function will search the network for 40
| seconds; this may not be long enough to detect the remote system.
| You can configure the DB2DISCOVERYTIME registry value to specify a
| longer period of time.

| ¹ The network that the Discovery request is running on may have been
| configured so that the Discovery request does not reach the remote
| system desired.

| ¹ If you are using NetBIOS as the Discovery protocol, you may need to
| configure the DB2NBDISCOVERRCVBUFS registry value to a larger
| value to enable the client to receive more concurrent Discovery replies.

| When a database is created on the remote server, if a database alias is not
| specified during database creation, the database is created with a database
| alias=database_name; otherwise, the database alias is the name specified.
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4 If you want to run ODBC-enabled applications, click on the Next  push button. If
you do not plan to use ODBC, click on the Done  push button to finish using the
Add Database SmartGuide and proceed to Step 6.

5 If you are using ODBC applications:

| a Select the Register this database for ODBC  check box, if it is not
| pre-selected.

| b Select the radio button that describes the type of data source that you want
| to register this database as. For more information, click on the Help  push
| button.

| c Click on the Application  drop down box and select the application that you
| want to use.

| d Click on the Done  push button to finish using the Add Database
| SmartGuide and add the database that you selected.

6 The Confirmation window opens. Click on the Test Connection  push button to
test the connection to this database.

7 Enter your user ID and password to access the database and click on OK. If the
connection is successful, a message confirming the connection appears. If the
connection fails, click on the Help  push button for more information. If you require
additional information, refer to the Troubleshooting Guide.

8 You are now able to use this database. If you want to access another database,
click on the Add Another  push button. To finish using the Add Database
SmartGuide, click on the Close  push button.
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Part 6. Using DB2 Universal Database
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 Chapter 20. Sending Accounting
Information to a DB2 for OS/390 Server

Many mainframe customers consider detailed accounting for resources used by
different applications to be an important part of their operational procedures. DB2 for
OS/390 provides extensive facilities for producing accounting reports that allow
information systems departments to charge individual user departments for the
mainframe resources they use. This is often called "charge-back accounting." DB2
Connect products allow for accurate accounting for the host resources used by the PC
and UNIX applications using existing accounting reports and procedures.

DB2 Connect implements this feature in a flexible way by providing:

¹ A default accounting string for all usage generated by a particular DB2 Connect
Enterprise Edition server.

¹ Two mechanisms for individual users or applications to specify the account to
which their usage should be charged.

Setting the Accounting String

The default accounting string is set by the DB2 Connect workstation's dft_account_str
configuration parameter. This default mechanism is useful for database clients that do
not have the capability to forward an accounting string to DB2 Connect (for example,
applications developed prior to Version 2 products). See the DB2 Connect User's Guide
for additional information on accounting strings.

There are two ways for client applications to override the default accounting string set
at the DB2 Connect server:

¹ Using the Set Accounting String API: sqlesact()

The SQLESACT() API is called before the application connects to a database.
You should use this method because:

– Calling an API does not incur the cost of reading a registry value.
– You do not need to call this API again unless you want to use a new

accounting string for future connect requests. If you are using the registry
value, you need to end the application process, redefine DB2ACCOUNT, and
then restart the process.

Refer to the API Reference for details on using this API.
¹ Using the DB2ACCOUNT registry value at the client workstation.
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If the sqlesact()  API is not called prior to the first database connect request, the
DB2ACCOUNT registry value is read. The accounting string is used for all
subsequent database connect requests. See Chapter 24, “Controlling Your DB2
Environment” on page 165 for information on setting registry values.

Note:  When defining the accounting string, you should observe the following rules:

1. Use the characters A-Z, 0-9, or '_' (underscore).
2. Limit the accounting string to 199 bytes—longer strings are truncated.
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Chapter 21. Getting Started with DB2
Universal Database

 This section describes how to use DB2 Universal Database in a variety of ways.

Go to the section that gives instructions for the tasks that you want to perform.

¹ “Logging on to the System.”

¹ “Connecting to a Database” on page 142.

¹ “Working with the System Administrative Group” on page 143.

¹ “Software Registration” on page 144.

¹ “Upgrading from a Try-and-Buy License” on page 144.

Logging on to the System

To use DB2, log on with a valid DB2 user ID that has the appropriate authority level for
the commands you want to execute. If the sysadm_group parameter is defined in the
database manager configuration file, the user performing administration tasks (such as
cataloging) must belong to the System Administrative (SYSDAM) group.

The sysadm_group parameter is not set when DB2 is first installed; therefore, the
following criteria are used to determine default SYSADM authority:

OS/2
Any valid DB2 user ID which belongs to the UPM Administrator or Local Administrator
group.

| Windows 95 and Windows 98
| Any Windows 95 or Windows 98 username that is a valid DB2 user ID.

Windows NT
Any valid DB2 user account which belongs to the local Administrators group.

See Appendix C, “Naming Rules” on page 269 for a list of naming restrictions.

As well as using the local operating system security to authenticate users, there is also
the option of using DCE security. Refer to the Administration Guide for information on
DCE security.

 Copyright IBM Corp. 1993, 1998  141



Connecting to a Database

You need to connect to a database before you can use SQL statements to query or
update it. The CONNECT statement associates a database connection with a user ID.

A database is created in an instance using one of three different authentication types:
CLIENT, SERVER, or DCS. If an authentication type is not specified when the instance
is created, the default SERVER authentication is used. Depending on the authentication
type and where the database resides, you connect to remote databases differently.

| While DCE authentication is an option, you cannot specify it when you create an
| instance. Refer to Administration Guide for more information on all authentication
| types.

Connecting to a local database

To connect to a local database called SAMPLE, enter the following command in the
Command Center or the command line processor:

connect to sample

Connecting to a remote database

¹ To connect a client to a remote database called SAMPLE, using SERVER
authentication, enter the following command in the Command Center or the
command line processor:

connect to sample user userid using password

(Be sure to choose values for userid and password that are valid on the server
system.

¹ To connect a client to a remote database called SAMPLE, using CLIENT
authentication, enter the following command in the Command Center or the
command line processor:

connect to sample

When a successful connection is made, a message similar to the following is displayed:

If you are connecting to the database from an OS/2 client, and are not
currently logged on, you will be prompted to log on using a user ID and
password.

If you are connecting to a database from a Windows NT client using
CLIENT authentication, and you provide a user ID and password on the
connect  command, you must start the DB2 for Windows NT Security
Service on the system. The Security Service is installed by DB2 and set up
to run as a Windows NT service; however, it is not started automatically. To
start the DB2 Security Service, enter the net start db2ntsecserver
command.
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Database product = DB2/NT 5.2.0

SQL authorization ID = USERID

Local database alias = SAMPLE

| Database Server = DB2/6000 5.2.0

| SQL authorization ID = USERID

| Local database alias = SAMPLE

If you receive an error message, make sure that the SAMPLE database exists on the
server and the database manager was started on the server.

Refer to the Administration Guide for more information on authentication.

Working with the System Administrative
Group

By default, System Administrative (SYSADM) authority is granted to the following:

OS/2
Any valid DB2 user ID which belongs to the Administrator or Local Administrator group.

| Windows 95 and Windows 98
| Any Windows 95 or Windows 98 user.

Windows NT
Any valid DB2 user account which belongs to the local Administrators group.

You can change the users who have SYSADM privileges for each DB2 instance by
changing the sysadm_group parameter; but before you do, ensure that the group
exists.

| Granting Users Authorization
| For applications to access databases, DB2 performs two types of checking:

| Authentication Ensures that the user account and password are valid.

| Authorization Ensures that the user has sufficient authority to perform a task.

| This section discusses the authorization process used in a Windows NT domain
| environment. For more information on authentication and authorization, refer to the
| Administration Guide.

| When performing administration tasks (such as cataloging the database directory or
| creating a database) System Administrative (SYSADM) authority is required. By default,
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| any user belonging to the Administrators group where the user account is defined has
| SYSADM authority.

| In a Windows NT domain environment, only domain users that belong to the
| Administrators group at the Primary Domain Controller (PDC) have SYSADM authority.
| Adding a domain user to the local Administrators group on the server machine does not
| grant the domain user SYSADM authority, since DB2 always performs authorization at
| the machine where the account is defined. To avoid adding a domain user to the
| Administrators group of the Primary Domain Controller, perform the following steps:

| 1. Create a new global group. The name of the global group must be eight characters
| or less and comply with DB2's naming rule. For more information, see Appendix C,
| “Naming Rules” on page 269.

| 2. Add a domain user to this global group.

| 3. Grant SYSADM authority to this global group by entering the following command:

| db2 update database manager configuration using sysadm_group global_group_name

| where global_group_name is the name of the global group that you created.

 Software Registration

The Registration  icon, located in the DB2 folder, is used to access and update the
IBM Software Customer Profile and to register IBM Software with IBM.

| 1 Click on Start , and select Programs->DB2 for Windows NT->Registration .

| The customer profile contains identification and demographic information about
| the user of each IBM software product. The software registration tool contains
| information and instructions on how to register IBM software by modem,
| telephone, Internet, FAX, or postal service.

| 2 Enter the appropriate information and complete the IBM Software Registration
| Smart Guide. Click on Help  push button if you need assistance.

Upgrading from a Try-and-Buy License

| Try-and-Buy versions are available for some DB2 products. If you install a product
| originally as Try-and-Buy, you do not need to reinstall the same product to upgrade the
| license. Simply add the license from the DB2 CD-ROM that comes in the product box.
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| If you install a DB2 product as Try-and-Buy, and you buy a different product, you must
| uninstall the Try-and-Buy product and then install the new one that you have
| purchased. For example, if you install DB2 Workgroup Edition as a Try-and-Buy and
| then purchase DB2 Enterprise Edition, you must uninstall DB2 Workgroup Edition and
| then install DB2 Enterprise Edition. At installation time, the program will automatically
| install the required license.

Note:  Your Proof of Entitlement and License Information booklets identify the products
for which you are licensed.

The following steps describe how to upgrade a license:

| 1 Click on Start  and select Programs ->License Use Runtime -> Nodelock
| Administration Tool  to start the Nodelock Administration Tool.

| 2 Select Products ->New from the menu toolbar.

| 3 Click on the Import  push button.

| 4 Select the license file that corresponds to the specific product that you have
| purchased and installed on your system. It can be found in the x:\db2\licence

| directory, where x: represents the CD-ROM drive.

| db2conpr.lic DB2 Connect Personal Edition

| Click on OK.

| 5 Click on OK to return to the main screen.
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Chapter 22. Running Your Own
Applications

Various types of applications can access DB2 databases:

¹ Applications developed using the DB2 Software Developer's Kit that include
embedded SQL, APIs, stored procedures, user-defined functions or calls to the
DB2 CLI.

¹ ODBC applications such as Lotus Approach.

¹ JDBC applications and applets.

¹ Net.Data macros containing HTML and SQL.

An application on a DB2 client can access a remote database without knowing its
physical location. The DB2 client determines the location of the database, manages the
transmission of the requests to the database server, and returns the results.

In general, to run a database client application, use the following steps:

1 Ensure the server is configured and running.

Be sure that the database manager is started on the database server to which the
application program is connecting. If it is not, you must issue the db2start
command at the server before starting the application.

2 Ensure that you can connect to the database that the application uses.

3 Bind the utilities and the applications to the database. See “Binding Database
Utilities” for information about binding the utilities.

4 Run the application program.

Binding Database Utilities

| You must bind the database utilities (import, export, reorg, the command line processor)
| and DB2 CLI bind files to each database before they can be used with that database.

In a network environment, if you are using multiple clients that run on different
| operating systems or are at different versions or service levels of DB2, you must bind

the utilities once for each operating system and DB2-version combination.

Binding a utility creates a package, which is an object that includes all of the
information that is needed to process specific SQL statements from a single source file.
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The bind files are grouped together in different .lst files in the bnd directory, under the
installation directory (typically sqllib\win on Windows 3.x systems and sqllib for
OS/2, and Windows 32-bit operating systems). Each file is specific to a server.

Binding to Host Databases
To bind the utilities and applications to the DRDA server, connect to the DRDA server
and use commands similar to the following:

connect to dbalias user userid using password

bind path/bnd/@ddcsmvs.lst blocking all sqlerror continue

messages mvs.msg grant public

 connect reset

where path corresponds to the DB2PATH registry value. These commands are
described in detail in the DB2 Connect User's Guide.

Binding to DB2 Universal Databases
How you bind the database utilities to a database depends on your workstation's
operating system:

¹ On OS/2 and Windows 32-bit operating systems, you can use the Client
Configuration Assistant:

1 Start the Client Configuration Assistant (CCA).

2 Select the database to which you want to bind the utilities.

3 Click on the Bind  push button.

4 Select the Bind DB2 Utilities  radio button.

5 Click on the Continue  push button.

6 Enter a user ID and password to connect to the database. The user ID must
have the authority to bind new packages against the database.

7 Select the utilities you want to bind and click on OK.

¹ On all operating systems, you can use the command line processor:

1 Change to the bnd directory, which is x:\sqllib\bnd, where x: is the drive
where you installed DB2.

2 Connect to the database using the command:

connect to database_alias

where database_alias is the name of the database to which you want to
connect.
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3 Enter the following commands in the Command Center or the command line
processor:

"bind @db2ubind.lst messages bind.msg grant public"

"bind @db2cli.lst messages clibind.msg grant public"

| In this example, bind.msg and clibind.msg are the output message files, and
| EXECUTE and BINDADD privileges are granted to public.

4 Reset the connection to the database by entering the following command:

 connect reset

For more information on the bind  command, refer to the Command
Reference.

Notes:

1. The db2ubind.lst file contains the list of bind (.bnd) files required to create the
packages for the database utilities. The db2cli.lst file contains the list of bind
(.bnd) files required to create packages for the DB2 CLI and the DB2 ODBC driver.

2. Binding may take a few minutes to complete.

| 3. If you have BINDADD authority, the first time you use the DB2 CLI or ODBC driver,
| the DB2 CLI packages will be bound automatically.

If the applications that you are using require binding to the database, you
can use the Client Configuration Assistant's Bind facility, or the command
line processor, to perform the bind action.

Running CLI/ODBC Programs

The DB2 Call Level Interface (CLI) run-time environment and the ODBC driver are
included with the DB2 Client Application Enabler. This is contained on the DB2 Client
Application Enablers CD-ROM or can be downloaded from the Web page at
http://www.software.ibm.com/data/db2.

This support enables applications developed using ODBC and DB2 CLI APIs to work
with any DB2 server. DB2 CLI application development support is provided by the DB2
Software Developer's Kit (DB2 SDK) which is part of the separately orderable DB2
Application Development Kit product.

Before DB2 CLI or ODBC applications can access DB2, the DB2 CLI packages must
be bound on the server. Although this will occur automatically on the first connection if
the user has the required authority to bind the packages, it is recommended that the
administrator do this first with each version of the client on each platform that will
access the server. See “Binding Database Utilities” on page 147 for specific details.
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The following general steps are required on the client system to give DB2 CLI and
ODBC applications access to DB2 databases. These instructions assume that you have
successfully connected to DB2 using a valid user ID and password. Depending on the
platform many of these steps are automatic. For complete details, see the section that
deals specifically with your platform.

1 Use the CCA to add the database (if you have separate client and server
machines) so that its instances and databases can be made known to the Control
Center, then add the instances and databases for that system. (Your local system
is represented by Local  icon.) If you do not have access to this program you can
use the catalog  command in the command line processor.

2 On all platforms other than OS/2 and Windows 3.x, the DB2 CLI/ODBC driver is
automatically installed when the DB2 Client Application Enabler is installed, and
therefore nothing needs to be done. On OS/2 and Windows 3.x you must use the
Install ODBC Driver  icon to install both the DB2 CLI/ODBC driver and the ODBC
driver manager.

3 To access the DB2 database from ODBC:

a The Microsoft, Visigenic, or other ODBC Driver Manager must already be
installed (this is done by default during the installation of DB2).

b The DB2 databases must be registered as ODBC data sources. The ODBC
driver manager does not read the DB2 catalog information; instead it
references its own list of data sources.

c If a DB2 table does not have a unique index then many ODBC applications
will open it as read-only. A unique index should be created for each DB2
table that is to be updated by an ODBC application. Refer to the CREATE
INDEX statement in the SQL Reference. Using the Control Center you
would alter the settings of the table, then select the Primary Key  tab and
move one or more columns from the available columns list over to the
primary key columns list. Any column you select as part of the primary key
must be defined as NOT NULL.

4 Various CLI/ODBC Configuration Keywords can be set to modify the behavior of
DB2 CLI/ODBC and the applications using it.

5 If you followed the above steps to install ODBC support, and added DB2
databases as ODBC data sources, your ODBC applications will now be able to
access them.

Platform Specific Details for CLI/ODBC Access
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The platform specific details on how to give DB2 CLI and ODBC applications access to DB2 are
divided into the following categories:

¹ “Windows 3.x, Windows 95, Windows 98, and Windows NT Client Access to DB2 using
CLI/ODBC” on page 151

¹ “OS/2 Client Access to DB2 using CLI/ODBC” on page 153

Windows 3.x, Windows 95, Windows 98, and
Windows NT Client Access to DB2 using
CLI/ODBC
Before DB2 CLI and ODBC applications can successfully access a DB2 database from
a Windows client, perform the following steps on the client system:

1 The DB2 database (and node if the database is remote) must be cataloged. To
do so, use the CCA (or the command line processor). See “Configuring Database
Connections” on page 218 for more details.

For more information refer to the on-line help in the CCA (or the CATALOG
DATABASE  and CATALOG NODE  commands in the Command Reference).

2 Verify that the Microsoft ODBC Driver Manager and the DB2 CLI/ODBC driver are
installed. On Windows 32-bit operating systems they are both installed with DB2
unless the ODBC component is manually unselected during the install. On
Windows 3.x you must use the Install ODBC Driver  icon to install the Microsoft
ODBC Driver Manager and the DB2 CLI/ODBC driver.

To verify that they both exist on the machine:

a Run the Microsoft ODBC Administrator from the icon in the Control Panel,
or issue the appropriate command from the command line: odbcad32.exe
for Windows 32-bit operating systems, odbcadm.exe  on Windows 3.x.

b Click on the Drivers  push button, or the ODBC Drivers  tab (depending on
the platform).

c Verify that "IBM DB2 ODBC Driver" is shown in the list.

If either the Microsoft ODBC Driver Manager or the IBM DB2 CLI/ODBC driver is
not installed, then rerun the DB2 install and select the ODBC component on
Windows 32-bit operating systems, or double-click on the Install ODBC Driver
icon in the DB2 program group in Windows 3.x.

3 Register the DB2 database with the ODBC driver manager as a data source. On
Windows 32-bit operating systems you can make the data source available to all
users of the system (a system data source), or only the current user (a user data
source). Use either of these methods to add the data source:
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¹ Using the CCA:

a Select the DB2 database alias that you want to add as a data source.

b Click on the Properties  push button. The Database Properties window
opens.

c Select the Register this database for ODBC  check box.

d On Windows 32-bit operating systems you can use the radio buttons to
add the data source as either a user or system data source.

¹ Using the Microsoft 32-bit ODBC Administration tool , which you can
access from the icon in the Control Panel or by running odbcad32.exe  from
the command line:

a On Windows 32-bit operating systems the list of user data sources
appears by default. If you want to add a system data source click on
the System DSN  button, or the System DSN  tab (depending on the
platform).

b Click on the Add  push button.

c Double-click on the IBM DB2 ODBC Driver in the list.

d Select the DB2 database to add and click on OK.

¹ On Windows 32-bit operating systems there is a command that can be issued
in the command line processor to register the DB2 database with the ODBC
driver manager as a data source. An administrator could create a command
line processor script to register the required databases. This script could then
be run on all of the machines that require access to the DB2 databases
through ODBC.

The Command Reference contains more information on the CATALOG
command:

CATALOG [ user | system ] ODBC DATA SOURCE

4  Optional: Configure the DB2 CLI/ODBC driver using the CCA:

a Select the DB2 database alias you want to configure.

b Click on the Properties  push button. The Database Properties window
opens.

c Click on the Settings  push button. The CLI/ODBC Settings window opens.

d Click on the Advanced  push button. You can set the configuration
keywords in the window that opens. These keywords are associated with
the database alias name, and affect all DB2 CLI/ODBC applications that
access the database. The online help explains all of the keywords, as does
an appendix in the Installing and Configuring DB2 Clients manual.

5 Optional: Using 16-bit ODBC applications:
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Although not directly related to DB2, some users have experienced problems
when running 16-bit ODBC applications on Windows 32-bit operating systems.

Both 16- and 32-bit applications use the same 32-bit IBM DB2 CLI/ODBC Driver.
The Microsoft ODBC Driver Manager takes care of the conversion between the
16-bit application and the 32-bit ODBC driver.

Some 16-bit applications were shipped with an old set of 16-bit Driver Manager
DLLs (that is, before 1995). These DLLs do not function well in the 32-bit
environment. The following symptoms may occur when running the old DLLs:

¹ Traps occur in odbc.dll or other ODBC related DLLs.
¹ 16-bit applications do not see data sources cataloged using the 32-bit ODBC

Administrator (from the Control Panel).

If (and only if) you are experiencing these problems you may want to update the
Microsoft 16-bit ODBC Driver Manager DLLs. These files are provided with DB2
in the SQLLIB\MSODBC16 subdirectory. Use these new DLLs to replace the older
versions that are located in the system subdirectory of the Windows operating
system directory.

6 If you have installed ODBC access (as described above), you can now access
DB2 data using ODBC applications. Start the ODBC application and go to the
Open window. Select the ODBC databases  file type. The DB2 databases that
you added as ODBC data sources will be selectable from the list. Many ODBC
applications will open the table as read-only unless a unique index exists.

OS/2 Client Access to DB2 using CLI/ODBC
Before DB2 CLI and ODBC applications can successfully access a DB2 database from
an OS/2 client, perform the following steps on the client system:

1 The DB2 database (and node if the database is remote) must be cataloged. To
do so, use the CCA (or the command line processor).

For more information see the on-line help in the CCA or “Configuring Database
Connections” on page 218.

2 If you are using ODBC applications to access DB2 data, perform the following
steps. (If you are using only CLI applications, skip this step and go to the next
step.)

a Check that the ODBC Driver Manager (Visigenic or Intersolv) and the DB2
CLI/ODBC driver are installed:

1 Run the ODBC Administration tool in one of two ways:

¹ Double-click on the Control Panel  icon from the Main  Folder in
WIN-OS/2 or the ODBC Folder in OS/2, and double-click on the
ODBC Administrator  icon.

¹ Run odbcadm.exe  from the command line.

The Data Sources window opens.
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2 Click on the Drivers  push button. The Drivers window opens.

3 Verify that "IBM DB2 ODBC Driver" is shown in the list.

If either the ODBC Driver Manager or the IBM DB2 CLI/ODBC driver is not
installed then double-click on the Install ODBC Driver  icon in the DB2
folder to install both the DB2 CLI/ODBC driver and the ODBC driver
manager.

b Register the DB2 database with the ODBC driver manager as a data source
using either of these methods:

¹ Using the CCA:

1 Select the DB2 database alias that you want to add as a data
source.

2 Click on the Properties  push button.

3 Select the Register this database for ODBC  check box.

¹ Using the Visigenic ODBC Administration tool , which you can access
from the ODBC folder or by running odbcadm.exe  from the command
line:

1 Click on the Add  push button from the Data Sources window. The
Add Data Source Window opens.

2 Double-click on the IBM DB2 ODBC Driver in the list.

3 Select the DB2 database to add and click on OK.

3 Optional: Configure the DB2 CLI/ODBC driver using the CCA:

a Select the DB2 database alias you want to configure.

b Click on the Properties  push button. The Database Properties window
opens.

c Click on the Settings  push button. The CLI/ODBC Settings window opens.

d Click on the Advanced  push button. You can set the configuration
keywords in the window that appears. These keywords are associated with
the database alias name, and affect all DB2 CLI/ODBC applications that
access the database. The online help explains all of the keywords, as does
an appendix in the Installing and Configuring DB2 Clients manual.

4 If you have installed ODBC access (as described above), you can now access
DB2 data using ODBC applications. Start the ODBC application and go to the
Open window. Select the ODBC databases  file type. The DB2 databases that
you added as ODBC data sources will be selectable from the list. Many ODBC
applications will open the table as read-only unless a unique index exists.
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Detailed Configuration Information
The section “Platform Specific Details for CLI/ODBC Access” on page 150 should
provide you with all of the information you require. Installing and Configuring DB2
Clients includes additional information on setting up and using DB2 CLI and ODBC
applications. (The online Installing and Configuring DB2 Clients manual is located in the
directory x:\doc\EN\html, where x is the letter that designates your CD-ROM and EN is
the two-character country code that represents your language, for example EN for
English.) This information is useful where DB2 tool support is not available, and for
administrators who require more detailed information.

The following topics are covered in the Installing and Configuring DB2 Clients manual:

¹ How to Bind the DB2 CLI/ODBC Driver to the Database
¹ How to Set CLI/ODBC Configuration Keywords

 ¹ Configuring db2cli.ini

Running Java Programs

You can develop Java programs to access DB2 databases with the appropriate Java
Development Kit (JDK) on AIX, HP-UX, OS/2, SCO UnixWare, Solaris, or Windows
32-bit operating systems. The JDK includes Java Database Connectivity (JDBC), a
dynamic SQL API for Java.

DB2 JDBC support is provided by the DB2 Client Application Enabler (DB2 CAE). With
DB2 JDBC support you can build and run JDBC applications and applets. These
contain dynamic SQL only, and use a Java call interface to pass SQL statements to
DB2.

The DB2 Software Developer's Kit (DB2 SDK) provides support for Java embedded
SQL (SQLJ). With DB2 SQLJ support and DB2 JDBC support you can build and run
SQLJ applications and applets. These contain static SQL and use embedded SQL
statements that are bound to the DB2 database.

Java can also be used on the server to create JDBC and SQLJ stored procedures and
user-defined functions (UDFs).

Building and running different types of Java programs requires support from different
components of DB2:

¹ JDBC applications do not require any other component of DB2 on the client to be
built. To run JDBC applications requires the DB2 Client Application Enabler (CAE)
to connect to DB2.
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¹ To build SQLJ applications requires the DB2 SDK. To run SQLJ applications
requires the DB2 CAE to connect to DB2.

¹ JDBC applets do not require any other DB2 component on the client to be built or
run.

¹ SQLJ applets require the DB2 SDK to be built. They do not require any other DB2
component to be run on the client.

For detailed information on building and running JDBC and SQLJ programs on UNIX
platforms see Building Applications for UNIX Environments. Detailed information on
building and running JDBC programs on Windows and OS/2 can be found in Building
Applications for Windows and OS/2 Environments. Building and running SQLJ
programs on Windows and OS/2 is explained in the What's New book. For more
information on DB2 programming in Java, refer to the Embedded SQL Programming
Guide, chapter 15, "Programming in Java". This covers creating and running JDBC
applications, applets, stored procedures and UDFs. Information on SQLJ applications,
applets, stored procedures and UDFs can be found in the What's New book.

For the latest, updated DB2 Java information, visit the Web Page at:

 http://www.software.ibm.com/data/db2/java

Configuring the Environment
To build and run DB2 Java programs, you need to install and configure the appropriate
version of the Java Development Kit (JDK) on your development machine:

AIX: The Java Development Kit (JDK) Version 1.1 for
AIX from IBM.

HP-UX: The HP-UX Developer's Kit for Java Release 1.1
from Hewlett-Packard.

OS/2: The Java Development Kit (JDK) Version 1.1 for
OS/2 from IBM.

SCO UnixWare: No installation necessary: Java Development Kit
(JDK) Version 1.1.3 for SCO UnixWare is already
installed in /usr/java.

Solaris: The Java Development Kit (JDK) Version 1.1.4 for
Solaris, and the Solaris Native Thread pack, from
Sun Microsystems.

Windows 32-bit operating systems:
The Java Development Kit (JDK) Version 1.1 for
Win32 from Sun Microsystems.

For information on installing and configuring any of the above JDKs, please refer to:

 http://www.software.ibm.com/data/db2/java
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For all supported platforms, you must also install and configure the DB2 Client
Application Enabler for your platform from the DB2 Client Pack. It must be Version
2.1.2 or later, except for SCO UnixWare which must be Version 5.2 or later.

To run DB2 Java stored procedures or UDFs, you also need to update the DB2
database manager configuration to include the path where the JDK version 1.1 is
installed on your development machine. You can do this by entering the following on
the command line:

db2 update dbm cfg using JDK11_PATH /home/smith/jdk11

where /home/smith/jdk11 is the path where the JDK version 1.1 is installed.

You can check the DB2 database manager configuration to verify the correct value for
the JDK11_PATH field by entering the following command:

db2 get dbm cfg

You may want to pipe the output to a file for easier viewing. The JDK11_PATH field
appears near the beginning of the output. For more information on these commands,
see the Command Reference.

Note:  On Solaris, some Java Virtual Machine implementations do not work well in
programs that run in a "setuid" environment. The shared library that contains the
Java interpreter, libjava.so, may fail to load. As a workaround, you can create
symbolic links for all needed JVM shared libraries in /usr/lib, with a command
similar to the following (depending on where Java is installed on your machine):

ln -s /opt/jdk1.1.3/lib/sparc/native_threads/*.so /usr/lib

For more information on this and other workarounds available, please visit:

http://www.software.ibm.com/data/db2/java/v5/faq.html

To run Java programs, the following environment variables are automatically updated
during DB2 installation on Windows and OS/2, and during instance creation on UNIX
platforms.

On UNIX platforms :

¹ CLASSPATH includes "." and the file sqllib/java/db2java.zip

¹ On AIX, SCO UnixWare, and Solaris: LD_LIBRARY_PATH includes the directory
sqllib/lib; on HP-UX: SHLIB_PATH includes the directory sqllib/lib

¹ On Solaris only: THREADS_FLAG is set to "native"

On Windows and OS/2 platforms :

¹ CLASSPATH includes "." and the file %DB2PATH%\java\db2java.zip

In order to build and run SQLJ programs, CLASSPATH is also automatically updated to
include these files:
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On UNIX platforms :

¹ sqllib/java/sqlj.zip (required to build SQLJ programs)

¹ sqllib/java/runtime.zip (required to run SQLJ programs)

On Windows and OS/2 platforms :

¹ %DB2PATH%\java\sqlj.zip (required to build SQLJ programs)

¹ %DB2PATH%\java\runtime.zip (required to run SQLJ programs)

 Java Applications
Start your application from the desktop or command line by running the Java interpreter
on the executable program with this command:

 java prog_name

where prog_name is the name of the program.

The DB2 JDBC driver handles the JDBC API calls from your application and uses the
DB2 CAE to communicate the requests to the server and receive the results.

Note:  An SQLJ application must be bound to the database before it is run.

 Java Applets
Because Java applets are delivered over the web, a web server must be installed on
your DB2 machine (server or client).

To run your applet, make sure your .html file is properly configured. Start the JDBC
applet server on the TCP/IP port specified in the .html file. For example, if you
specified:

param name=port value='6789'

then you would enter:

 db2jstrt 6789

You must ensure that your working directory is accessible to your web browser. If it is
not, copy your applet's .class and .html files into a directory that is accessible. For
SQLJ applets, you must also copy the profile .class and .ser files as well.

Copy the sqllib/java/db2java.zip file into the same directory as these other files. For
SQLJ applets, also copy the sqllib/java/runtime.zip file into this directory.

Then on your client machine start your web browser (which supports JDK 1.1) and load
the .html file.
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When your applet calls the JDBC API to connect to DB2, the JDBC driver establishes
separate communications with the DB2 database through the JDBC applet server
residing on the DB2 server.

Note:  An SQLJ applet must be bound to the database before it is run.
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Chapter 23. Entering DB2 Commands and
SQL Statements

You can use the Command Center to enter DB2 commands and SQL statements if you
are working with DB2 on OS/2 or Windows 32-bit operating systems. Otherwise, you
can enter commands in the command line processor or at a system command prompt.

Task: Entering DB2 commands, SQL statements, and operating system commands

Operating System Tools

OS/2  ¹ Command Center

¹ command line processor

 ¹ command prompt

Windows 3.x ¹ command line processor

Windows 32-bit operating
systems

 ¹ Command Center

¹ command line processor

 ¹ command window

Using the Command Center

On OS/2 and Windows 32-bit operating systems, the Command Center provides an
interactive window that allows you to:

¹ Run SQL statements, DB2 commands, and operating system commands.

¹ See the execution result of SQL statements and DB2 commands in a results
window. You can scroll through the results and save the output to a file.

¹ Save a sequence of SQL statements and DB2 commands to a script file. You can
then schedule the script to run as a job. When a saved script is modified, all jobs
dependent on the saved script inherit the new modified behavior.

¹ Recall and run a script file.

¹ See the execution plan and statistics associated with a SQL statement before
execution. You do this by invoking Visual Explain in the interactive window.

¹ Get quick access to database administrative tools such as the Control Center and
the Journal from the main tool bar.

¹ Display all the command scripts known to the system through the Script Center,
with summary information listed for each.
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To invoke the Command Center on OS/2:

1 Double-click on the DB2 for OS/2  folder.

2 Double-click on the Command Center  icon.

To invoke the Command Center on Windows 32-bit operating systems:

1 Click on Start , and select Programs->DB2 for Windows-> Command Center .

The Command Center contains a large input area in which you type your commands.
To run the commands you have entered, select the Start or stop execution  icon from
the menu toolbar, or use CTRL+Enter.

If you want to enter multiple commands, you must end each command with the
termination character, then press Enter to start the next command on a new line. (The
default termination character is a semicolon(;).) To specify a different termination
character, click on the Tools Settings  icon in the menu toolbar.

After you enter a command, the Command Center displays the Results window, which
informs you how the commands are proceeding.

| To recall commands that you have entered, select the Script  Tab, click on the drop
| down box, and select a command. To save commands as scripts, select Script ->Save

as from the menu bar.

It is no longer necessary to enter the commands with a db2 prefix; instead,
enter the command as follows:

list node directory

| To enter operating system commands in interactive mode, precede the
| operating-system command with an exclamation mark (!). For example:

|  !dir

If you want to store commonly used SQL statements or DB2 commands as
scripts, click on the Script Center  icon from the main tool bar.

Using the Command Line Processor

| You can use the command line processor to enter SQL statements, DB2 commands,
| and operating system commands. It operates in the following modes:
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| Interactive Input Mode You can enter operating systems commands, DB2
commands or SQL statements and view their
output.

Command Line Mode The DB2 command line processor behaves like a
command window from your operating system.

| You can enter operating system commands, DB2
commands, or SQL statements and view their
output.

File Input Mode Refer to the Command Reference for information
on the file input mode.

Interactive Input Mode
To invoke the command line processor in interactive input mode, do the following:

 ¹ On OS/2:

1 Double-click on the DB2 for OS/2  folder.

2 Double-click on the Command Line Processor  icon.

¹ On Windows 32-bit operating systems:

1 Click on Start  and select Programs  ->DB2 for Windows ->Command Line
Processor .

¹ On Windows 3.x use one of the following methods:

– From a DOS full screen, enter the win db2clpw  command.

 – From Windows:

1 Double-click on the DB2 folder.

2 Double-click on the Command Line Processor  icon.

You can also invoke the command line processor in interactive input mode by entering
the db2cmd  command followed by the db2  command at a command prompt. In
interactive input mode, the prompt looks like this:

 db2 =>

In interactive mode, you do not have to enter DB2 commands with a db2 prefix;
instead, you just enter the DB2 command. For example:

db2 => list node directory

To enter operating system commands in interactive mode, precede the
operating-system command with an exclamation mark (!). For example:

db2 => !dir
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If you need to enter a long command that does not fit on one line, use the line
continuation character, \. For example:

db2 => select empno, lastname, birthdate, from \

db2 (cont.) => employee where sex='F' order by empno desc

Note:  You do not need to use a line continuation character when entering long
commands in interactive input mode on Windows 3.x workstations.

To end interactive input mode, enter the quit  command.

| For more information on advanced topics using the command line processor, refer the
| Command Reference.

Windows 3.x does not support this method of running operating system
commands.

Command Line Mode
On OS/2, you can enter DB2 commands from a command prompt. You must include
the db2 prefix. For example:

db2 list node directory

To invoke the command line processor in command line mode on Windows 32-bit
operating systems, use one of the following methods:

| ¹ Click on Start  and select Programs -> DB2 for Windows ->Command Window .

¹ Enter the db2cmd  command at a command prompt.

After you invoke the DB2 command environment, you can enter DB2 commands at the
command prompt. You must include the db2 prefix.

Notes:

1. If the DB2 command contains characters that have special meaning on the
operating system you are using, you will need to enter the command in quotation
marks to ensure that it is run properly. For example, the following command will
successfully retrieve all the information from the employee table, even if the *
character has a special meaning on the operating system:

db2 "select * from employee"

2. The command line mode is not available on Windows 3.x systems.

| For more information on using the command line processor, refer to the Command
| Reference.
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Chapter 24. Controlling Your DB2
Environment

Registry values, environment variables, and configuration parameters control your
database environment.

¹ To set registry values through the DB2 profile registry, see “Controlling the DB2 Profile
Registry” on page 166.

¹ To set DB2 environment variables, see:

– “Setting Your Environment on OS/2” on page 167.
– “Setting Your Environment on Windows 32-Bit Operating Systems” on page 168.
– “Setting Your Environment on Windows 3.x” on page 169.

¹ To set database manager configuration parameters on a client instance, see “Configuration
Parameters” on page 177.

Prior to the introduction of the DB2 profile registry in Version 5, changing your DB2
environment on OS/2 or Windows 32-bit operating systems required you to change your
system's environment variables.

With Version 5, almost all of the environment variables have been moved to the DB2
profile registry. Users with system administrative (SYSADM) authority for a given
instance can update registry values for that instance. Use the db2set  command to
update DB2 registry values without rebooting your system. The DB2 registry applies the
updated information to DB2 server instances and DB2 applications started after the
changes are made.

Note:  There is no DB2 profile registry on Windows 3.x. See “Setting Your Environment
on Windows 3.x” on page 169 for more information.

DB2 configures its operating parameters by checking for variable values according to
the following search order:

¹ The environment variable settings.

¹ Profile registry values set with the db2set  command in the instance-level profile.

¹ Profile registry values set with the db2set  command in the global-level profile.

See “DB2 Registry Values and Environment Variables” on page 170 for descriptions of
the subset of registry values and environment variables that you may want to adjust to
get DB2 up and running. For more detailed information about all registry values and
environment variables, refer to the Administration Guide.
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Controlling the DB2 Profile Registry

The DB2 profile registry stores DB2 registry values. The "levels" of registry values are
as follows:

DB2 instance-level profile:
This profile contains instance level variable settings and overrides. Values defined in
this level will override their settings in the global level.

DB2 global-level profile:
This profile contains machine global variable settings. Any variable not defined at the
node or instance levels will be evaluated at this level.

To modify registry variable values, enter the db2set  command.

The syntax of the db2set  command is as follows:

| ¹ To set a parameter, enter:

|  db2set parameter=value

| This command will set the parameter that you specify at the default level for that
| parameter.

¹ To set a parameter's value for a specific instance, enter:

db2set parameter=value -i instance_name

¹ To set a parameter's value for a specific DB2 instance and node, enter:

db2set parameter=value -i instance_name node_number

¹ To set a parameter at the global profile level, enter:

db2set parameter=value -g

Notes:

1. Some parameters will always default to the global level profile. They cannot be
set at the instance or node level profiles; for example, DB2SYSTEM and
DB2INSTDEF.

| ¹ To delete a parameter's value at a specified level, you can use the same command
| syntax to set the parameter, but specify nothing for the parameter value. For
| example, to delete the parameter's setting at the instance level, enter:

| db2set parameter= -g instance

| ¹ To delete a parameter's setting and to restrict its use, if it is defined at a higher
| profile level, enter:

| db2set parameter= -null -i instance

| This command will delete the setting for the parameter you specify and restrict high
| level profiles from setting this parameter (in this case, the DB2 global-level profile).
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| However, the parameter you specify could still be set by a lower level profile (in
| this case, the DB2 node-level profile).

¹ To view the current session's parameter's value, enter:

 db2set parameter

¹ To view the parameter's value at all levels, enter:

db2set parameter -all

¹ To view a list of all values defined in the profile registry, enter:

 db2set -all

| For more information on the db2set  command and the administration of the DB2 profile
| registry, refer to the Command Reference.

Setting Your Environment on OS/2

It is strongly recommended that all DB2 specific registry values be defined in the DB2
profile registry. If DB2 variables are set outside of the registry, remote administration of
those variables will not be possible, and the workstation will have to be rebooted in
order for the variable values to take effect.

On OS/2, there are three system environment variables that are not stored in the DB2
profile registry: DB2INSTANCE, DB2PATH, and DB2INSTPROF. DB2INSTANCE and
DB2PATH are set when DB2 is installed; DB2INSTPROF can be set after installation.
The environment variable DB2PATH must be set; this environment variable is set
during install and you should not modify it. Setting DB2INSTANCE and DB2INSTPROF
is optional. Because the system environment variables are not set in the profile registry,
you will need to reboot if you change their settings.

To determine the setting of an environment variable, enter:

 set variable

To change the setting of an environment variable, enter the following command:

 set variable=value

| To modify system environment variables you must edit the config.sys file, then reboot
| to make the changes take effect.
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Setting Your Environment on Windows
32-Bit Operating Systems

It is strongly recommended that all DB2 specific registry values be defined in the DB2
profile registry. If DB2 variables are set outside of the registry, remote administration of
those variables will not be possible, and the workstation will have to be rebooted in
order for the variable values to take effect.

Windows 32-bit operating systems have one system environment variable,
DB2INSTANCE, that can only be set outside the profile registry; however, you are not

| required to set DB2INSTANCE. The DB2 profile registry variable DB2INSTDEF may be
set in the global level profile to specify the instance name to use if DB2INSTANCE is
not defined.

To determine the setting of an environment variable, enter:

 set variable

To set system environment variables, do the following:

| On Windows 95 and Windows 98:
| Edit the file and reboot to make the change take effect.

On Windows NT:
Set environment variables as follows:

1 Click on Start  and select Settings ->Control Panel .

2 Double-click on the System  icon.

3 In the System Properties window, select the Environment  tab and do the
following:

a If the variable does not exist:

1 Select any environment variable in the System Variables window.

2 Change the name in the Variable  field to the name of the environment
variable you want to set, for example DB2INSTANCE.

| 3 Change the Value  field to the value that you would like this parameter
| to take, for example, db2inst.

b If the variable already exists in the System Variables window, you can set a
new value:

| 1 Select the environment variable you want to change or append, for
| example DB2INSTANCE.
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| 2 Change the Value  field to the value that you would like this parameter
| to take, for example, db2inst.

c Click on the Set push button.

d Click on OK.

4 You may have to reboot your system for these changes to take effect.

Setting Your Environment on Windows 3.x

The DB2 environment on Windows 3.x is not controlled by profile registries. Instead,
Windows 3.x clients define environment keywords in the file db2.ini file (typically found
in C:\windows directory).

| The db2.ini initialization file is an ASCII file that stores values for the Windows 3.x
| client environment keywords. Within this file, there is just one section header titled:

| [DB2 Client Application Enabler]

The parameters are set by specifying a keyword with its associated keyword value in
the form:

 KEYWORD=keywordValue

| The following is a sample db2.ini file:

| [DB2 Client Application Enabler]

| ; This is for my Windows 3.x Client

|  DB2PATH=C:\SQLLIB\WIN

|  DB2INSTANCE=DB2

|  DB2INSTPROF=C:\SQLLIB

|  DB2TRACEON=N

On Windows 3.x, the parameters that control the DB2 environment are
called environment keywords. However, because many Windows 3.x
keywords are also used on operating systems that use the DB2 profile
registries, environment keywords may also be referred to as registry values
in this manual.
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Notes:

1. All the keywords and their associated values must be located below the section
header.

2. The keywords are not case sensitive; however, their values can be if the values
are character based.

3. Comment lines use a semicolon in the first position of a new line.

4. Blank lines are permitted. If duplicate entries for a keyword exist, the first entry is
used (and no warning is given).

This file is located in the Windows product directory.

| On Windows 3.x, the Client Application Enabler for DB2 Version 2.x, Version 4, and
Version 5 must set this information only in the db2.ini file.

DB2 Registry Values and Environment
Variables

The following subset of the DB2 registry values and environment variables are those
that you may need to know about to get up and running. Each has a brief description;
some may not apply to your environment.

| You can view a list of all supported variables for your platform. On all operating
| systems except Windows 3.x, enter the following command:

|  db2set -lr

Note:  Windows 3.x clients define environment variables in the file db2.ini. See
“Setting Your Environment on Windows 3.x” on page 169 for details.

| Parameter| Operating
| System
| Values| Description

| General

| DB2ACCOUNT| All| Default: (not set)| The accounting string that is sent to the
| remote host. Refer to the DB2 Connect
| User's Guide for details.

| DB2BIDI| All| Default: (not set)| Enables bi-directional CCSID processing
| by UDB. Refer to the DB2 Connect User's
| Guide for details.
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| Parameter| Operating
| System
| Values| Description

| DB2CODEPAGE| All| Default: derived from
| the language ID, as
| specified by the
| operating system.

| Specifies the code page of the data
| presented to DB2 for database client
| application. The user should not set
| db2codepage unless explicitly stated in
| DB2 documents, or asked to do so by DB2
| service. Setting DB2CODEPAGE to a
| value not supported by the operating
| system can produce unexpected results.
| Normally, you do not need to set
| DB2CODEPAGE because DB2
| automatically derives the code page
| information from the operating system.

| DB2COUNTRY| All| Default: derived from
| the language ID, as
| specified by the
| operating system.

| Specifies the country code of the client
| applications, which influences date and
| time formats.

| DB2DBDFT| All| Default: (not set)| Specifies the database alias name of the
| database that will be implicitly connected
| to when applications are started and no
| implicit connect has been done. This
| keyword is ignored if it is not set.

| DB2DBMSADDR| Windows
| 32-bit
| operating
| systems

| Default= (not set),
| value for Windows 95
| and Windows 98:
| (90000000), value for
| Windows NT:
| (20000000)

| Specifies the default database manager
| shared memory address in hexadecimal
| format. If a shared memory address
| collision occurs, this value can modified to
| force the database manager instance to
| allocate its shared memory at a different
| address. Use the DB2DMSADDR registry
| profile variable to assign an address value
| in the range of x'20000000' to x'B0000000'
| on Windows NT or x'80000000' to
| x'B0000000' on Windows 95 using
| increments of x'40000000'. Use the
| db2set  command to change the shared
| memory address. For example, to set
| DB2DBMSADDR to x'84000000, use the
| following command:

|  db2set DB2DBMSADDR=84000000

| DB2DISCOVERYTIME| OS/2 and
| Windows
| 32-bit
| operating
| systems

| Default: (default time
| of 40 seconds is used
| when this parameter is
| not set)

| Specifies the amount of time that a
| SEARCH discovery will search for DB2
| systems.
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| Parameter| Operating
| System
| Values| Description

| DB2DMNBCKCTLR| Windows
| NT
| Default: (not set)| If DB2 is installed on a backup domain
| controller, setting
| DB2DMNBCKCTLR=DOMAIN_NAME
| allows DB2 to use the security database
| on the backup domain controller, thereby
| reducing LAN traffic. (DOMAIN_NAME
| must be in upper case.)

| Note:  A backup domain controller
| shadows the security database on
| the primary domain controller.

| DB2INCLUDE| All| Default: (not set)| Specifies a path to be used during the
| processing of the SQL INCLUDE text-file
| statement during DB2 PREP processing. It
| provides a list of directories where the
| INCLUDE file might be found. Refer to the
| Embedded SQL Programming Guide for
| descriptions of how db2include is used in
| the different precompiled languages.

| DB2INSTDEF| OS/2 and
| Windows
| 32-bit
| operating
| systems

| Default=DB2 (on OS/2
| and Windows 32-bit
| operating systems)

| Sets the default instance to be used if
| DB2INSTANCE is not defined.

| DB2OPTIONS| All| Default: (not set)| Sets command line processor options.

| DB2SLOGON| Windows
| 3.x
| Default (not set),
| Values: Y, N
| Enables a secure logon in DB2 for
| Windows 3.x . If db2slogon=YES DB2 does
| not write user IDs and passwords to a file,
| but instead uses a segment of memory to
| maintain them. When db2slogon is
| enabled, the user must logon each time
| Windows 3.x is started.

| DB2TIMEOUT| Windows
| 3.x and
| Macintosh

| Disabled| Used to control the timeout period for
| Windows 3.x and Macintosh clients during
| long SQL queries. After the timeout period
| has expired a dialog box pops up asking if
| the query should be interrupted or allowed
| to continue. The minimum value for this
| variable is 30 seconds. If db2timeout is set
| to a value between 1 and 30, the default
| minimum value will be used. If db2timeout
| is set to a value of 0, or a negative value,
| the timeout feature is disabled. This
| feature is disabled by default.
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| Parameter| Operating
| System
| Values| Description

| DB2TRACENAME| Windows
| 3.x and
| Macintosh

| Default (not set)| On Windows 3.x and Macintosh, specifies
| the name of the file where trace
| information is stored. The default on
| Windows 3.x is
| db2tracename=DB2WIN.TRC, and is saved
| in your current instance directory (for
| example, \sqllib\db2). The default on
| Macintosh is db2tracename=DB2MAC.TRC.
| We strongly recommend that you specify
| the full path name when naming the trace
| file.

| DB2TRACEON| Windows
| 3.x and
| Macintosh

| Default (not set),
| Values: Y, N
| On Windows 3.x and Macintosh, turn trace
| on to provide information to IBM in case of
| a problem. (It is not recommended that
| you turn trace on unless you encounter a
| problem you cannot resolve.) Refer to the
| Troubleshooting Guide for information on
| using the trace facility with DB2 Client
| Application Enabler.

| DB2TRCFLUSH| Windows
| 3.x and
| Macintosh

| Default (not set),
| Values: Y, N
| On Windows 3.x and Macintosh,
| db2trcflush can be used in conjunction
| with db2traceon=Y. db2trcflush=Y will
| cause each trace record to be written
| immediately into the trace file. Setting this
| will slow down your DB2 system
| considerably, so the default setting is
| db2trcflush=N. This setting is useful in
| cases where an application hangs the
| system and therefore needs to be
| rebooted. Setting this keyword guarantees
| that the trace file and trace entries are not
| lost by the reboot.

| DB2TRCSYSERR| Windows
| 3.x and
| Macintosh

| Default: (not set),
| Values: Y, N
| Specifies the number of system errors to
| trace before the client turns off tracing.
| The default value traces one system error,
| after which, trace is turned off.
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| Parameter| Operating
| System
| Values| Description

| DB2YIELD| Windows
| 3.x
| Default (not set),
| Values: Y, N
| Specifies the behavior of the Windows 3.x
| client while communicating with a remote
| server. When N is set, the client will not
| yield the CPU to other Windows 3.x
| applications, and the Windows
| environment is halted while the client
| application is communicating with the
| remote server. You must wait for the
| communications operation to complete
| before you can resume any other tasks.
| When set to Y, your system functions as
| normal. It is recommended that you try to
| run your application with db2yield=YES. If
| your system crashes, you will need to set
| db2yield=NO. For application development,
| ensure your application is written to accept
| and handle Windows messages while
| waiting for a communications operation to
| complete.

| System Environment

| DB2INSTANCE| All| Default=DB2INSTDEF
| on OS/2 and Windows
| 32-bit operating
| systems

| The environment variable used to specify
| the instance that is active by default. On
| UNIX, users must set the environment
| variable DB2INSTANCE.

| DB2INSTPROF| OS/2,
| Windows
| 3.x, and
| Windows
| 32-bit
| operating
| systems

| Default (not set)| The environment variable used to specify
| the location of the instance directory on
| OS/2 and Windows 32-bit operating
| systems if different than DB2PATH.

| DB2PATH| OS/2,
| Windows
| 3.x, and
| Windows
| 32-bit
| operating
| systems

| The environment variable used to specify
| the directory where the product is installed
| on OS/2 and Windows 32-bit operating
| systems. By default it is set to
| x:\sqllib\win on Windows 32-bit
| operating systems; where x: is the install
| drive.

| Communications

| DB2COMM| All, server
| only
| Default (not set),
| values: any
| combination of APPC,
| IPXSPX, NETBIOS,
| NPIPE,TCPIP

| Specifies the communication managers
| that are started when the database
| manager is started. If this is not set, no
| DB2 communications managers are
| started at the server.
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| Parameter| Operating
| System
| Values| Description

| DB2NBADAPTERS| OS/2 and
| Windows
| 32-bit
| operating
| systems

| Default=0, Range:
| 0-15, Multiple values
| should be separated
| by commas

| Used on the server to specify which local
| adapters to use for DB2 NetBIOS LAN
| communications. Each local adapter is
| specified using its logical adapter number.

| You can set DB2NBADAPTERS on the
| client if you want to perform a NetBIOS
| discoery on an adapter other than the
| default adapter 0.

| Note:  On Windows 95 and Windows 98
| DB2NBADAPTERS is only used for
| discovery.

| DB2NETREQ| Windows
| 3.x
| Default=3, Range: 0-25| Specifies the number of NetBIOS requests
| that can be run concurrently on Windows
| 3.x clients. The default value is 3. The
| number can range from 0 to 25. The
| higher you set this value, the more
| memory below the 1MB level will be used.
| When the concurrent number of requests
| to use NetBIOS services reaches the
| number you have set, subsequent
| incoming requests for NetBIOS services
| are held in a queue and become active as
| the current requests complete. If you enter
| 0 (zero) for db2netreq, the Windows
| database client issues NetBIOS calls in
| synchronous mode using the NetBIOS wait
| option. In this mode, the database client
| allows only the current NetBIOS request to
| be active and does not process another
| one until the current request has
| completed. This can affect other
| application programs. The 0 value is
| provided for backwards compatibility only.
| It is strongly recommended that 0 not be
| used.
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| Parameter| Operating
| System
| Values| Description

| DCE Directories

| DB2DIRPATHNAME| OS/2 and
| UNIX
| Default: (not set)| Specifies a temporary override of the
| DIR_PATH_NAME parameter value in the
| database manager configuration file. If a
| directory server is used and the target of a
| CONNECT statement or ATTACH
| command is not explicitly cataloged, then
| the target is concatenated with
| db2dirpathname (if specified) to form the
| fully qualified DCE name.

| Note:  The db2dirpathname value has no
| effect on the instance's global
| name, which is always identified by
| the database manager
| configuration parameters
| DIR_PATH_NAME and
| DIR_OBJ_NAME.

| DB2CLIENTCOMM| OS/2 and
| UNIX
| Default: (not set)| Specifies a temporary override of the
| DFT_CLIENT_COMM parameter value in
| the database manager configuration file. If
| both DFT_CLIENT_COMM and
| db2clientcomm are not specified, then the
| first protocol found in the object is used. If
| either one or both of them are specified,
| then only the first matching protocol will be
| used. In either case, no retry is attempted
| if the first connect fails.

| DB2CLIENTADPT| OS/2| Default: (not set),
| range: 0-15
| Specifies the client adapter number for
| NETBIOS protocol on OS/2 operating
| systems. The db2clientadpt value
| overrides the DFT_CLIENT_ADPT
| parameter value in the database manager
| configuration file.

| DB2ROUTE| OS/2 and
| UNIX
| Default: (not set)| Specifies the name of the Routing
| Information Object the client uses when it
| connects to a database with a different
| database protocol. The db2route value
| overrides the ROUTE_OBJ_NAME
| parameter value in the database manager
| configuration file.
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 Configuration Parameters

Configuration parameters are values that affect the operating characteristics of a
database or database management system.

Database manager configuration parameters exist on servers and clients; however, only
certain database manager configuration parameters can be set on the client. These
parameters are a subset of the database management configuration parameters that
can be set on the server.

Database configuration parameters can be set only on the server, or remotely from the
Control Center.

For information on setting database or database manager configuration parameters,
refer to the Administration Guide.

Setting Database Manager Configuration
Parameters on a Client Instance

To control database management configuration parameters on a client instance on
OS/2 or Windows 32-bit operating systems, use the Client Configuration Assistant
(CCA).

 ¹ On OS/2:

1 Double-click on the Client Configuration Assistant  icon in the DB2 for
OS/2 folder.

2 Click on the Client Settings  push button.

¹ On Windows 32-bit operating systems:

1 Click on Start  and select Programs ->DB2 for Windows ->Client
Configuration Assistant . The Client Configuration window opens.

2 Click on the Client Settings  push button.

To modify a configuration parameter:

| 1 Select the tab that corresponds to the type of configuration parameter that you
| want to modify.

| 2 Select the configuration parameter that you want to modify from the Parameter
| window.

| 3 Select the value for this parameter from the Value  window.
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| 4 Click on OK.

For more information, refer to the online help.

¹ For information on using Client Configuration Assistant, see Chapter 28, “Using the Client
Configuration Assistant” on page 217.
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Chapter 25. Administering and Using OS/2
User Profile Management on OS/2 Systems

User Profile Management (UPM) provides access control to workstation resources
through a set of user ID validation and user and group ID management functions. UPM
is installed with the DB2 products.

Three icons appear in the UPM Services  folder:

 ¹ Logoff
 ¹ Logon
¹ User Account Management

Special Note for Users of Warp Connect and
Warp Server

DB2 for OS/2 Version 5 includes UPM Version 4.0. Peer Services ships as a part of
OS/2 Warp Connect and Warp Server includes a later version of UPM.

If DB2 for OS/2 detects that UPM is already installed it does not attempt to re-install it.
Note that Version 4.06 of UPM does not include default user ID USERID with password
PASSWORD defined. For DB2 for OS/2 Version 5 local logon, either:

¹ Use your Peer Services user ID, or

¹ Create a new user ID called USERID with password PASSWORD in UPM when
logged on with your Peer Services user ID, which is an Administrator by default.

Using UPM for the First Time

The first time you use UPM, you have to use a default user ID. Your first task is to
establish a permanent user ID and delete the default ID:

1 Make a backup copy of the net.acc file. This is stored on your workstation as
c:\muglib\accounts\net.acc and contains the UPM defaults.
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Note:  If IBMLAN is also installed, you will find net.acc under
x:\ibmlan\accounts

You may use the backacc.exe  and restacc.exe  commands to backup and
restore the net.acc file. Refer to your operating system or LAN documentation for
further information.

2 Log on to UPM, following the procedure in “Logging on to UPM” on page 181.
Use the default user ID, USERID, and the default password, PASSWORD.

3 Establish a permanent user ID, following the procedures in “Adding a New User
ID and Password” on page 182. Select the:

¹ Administrator  radio button in the User type  box

¹ Allowed  radio button in the Logon  box

¹ Password Required  radio button in the Options  box.

Note:  Use a password that is not trivial.

4 Log off from UPM, following the procedures in “Logging Off” on page 184.

5 Log on to UPM again. Use the user ID you established in step 3.

6 Delete the default user ID, USERID, following the procedure in “Changing or
Deleting a User ID” on page 183. This is a safeguard against unauthorized use of
your workstation.

7 Do other work in UPM, as required.

8 When you are finished, log off from UPM.

Using UPM Every Day

This section covers everyday usage of UPM.

¹ “Logging on to UPM” on page 181

¹ “Logging On at the Command Prompt” on page 181

¹ “Adding a New User ID and Password” on page 182

¹ “Changing or Deleting a User ID” on page 183

¹ “Logging Off” on page 184

¹ “Managing UPM Groups” on page 184
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Logging on to UPM
To log on to UPM, follow these steps:

1 Double-click on the UPM Services  folder on the desktop.

2 Double-click on the Logon  icon.

3 In the Logon window, type your user ID and password. (The password does not
display.)

4 Click on OK.

Logging on to UPM with Multiple IDs
You can log on to UPM with multiple user IDs. You can use this feature to start several
application programs under different user IDs. There are two ways to enable multiple
logons at your workstation (and control selective logoffs). Use either of these methods:

¹ Type LOGON /O=MULTI at the OS/2 prompt and press Enter. As each application
starts, the UPM logon window appears.

¹ Embed UPM logon and logoff commands in each application program you want to
start with its own user ID. UPM provides two application programming interfaces
(APIs), one for logon and one for logoff.

Logging On at the Command Prompt
You may also log on at the command prompt using the following syntax:

 

55─ ─logon──userid─ ─/P:──password─ ─/N:──node──/D:──domain──/L:─────────5%

userid Identifies the user logging on. If userid is not specified, the Logon
window is displayed so you can enter the user ID.

/P:password Allows you to specify a password. If you enter a password, UPM tries
to log on using the password specified. If no password is specified,
UPM tries to log on without a password. If a password is required, the
Logon window is displayed so you can enter it.

/P is ignored if userid was not specified.

/N:node Specifies the node to be used the next time a node must be
accessed. If you use /N, the user ID and password are not validated
until the program attempts to connect to the node.

If no node is specified, the Logon window for Remote Node Access is
displayed so you can enter the node name.
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If only /N is specified, the Logon window for Remote Node Access is
displayed so you can enter the user ID, password, and node name.

/D:domain Specifies the domain on which a logon is to be attempted. An attempt
to start a LAN requester is issued and, if successful, the domain
logon completes.

If a LAN requester cannot be started, then a local logon is attempted.

If only /D is specified, the Logon window for a domain logon is
displayed. If the workstation is a server, the default domain name is
displayed on the domain logon window and you cannot change this
domain name. If the workstation is a requester, the default domain
name is displayed and you can use the default domain name or type
a new domain name.

If you do not specify any parameters with the LOGON command,
domain logon is the default if you are not already logged on to a
domain. If you are already logged on to a domain, and you want to
log on to another domain, specify the logon command, user ID, and
password with the new domain name. You are logged off the old
domain and logged on to the new domain without windows being
displayed.

/L Forces a local logon. If you issue the LOGON command with no
parameters, a domain logon is automatically attempted. To force a
local logon, you must use the /L parameter.

Adding a New User ID and Password
To add a new UPM user ID and password, follow these steps:

1 Double-click on the User Account Management  icon in the UPM Services
folder. You must logon to UPM with a user ID that has Administrator authority.

If you are currently logged on to a domain and want to Manage Users locally, to
use a local logon you must:

¹ Click on Actions  in the User Profile  window.

¹ Select Use domain  from the pulldown menu.

¹ Select the Local  radio button.

¹ Click on OK.

2 Select Manage ->Manage Users  from the menu bar.

3 Select —NEW— from the list.

4 Select Actions ->Add a new user ID  from the menu bar.

5 Type a new user ID and an optional comment. The user ID can be 1-8 characters
and must comply with the guidelines in “Naming Rules” on page 185.
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6 Select the values you want for User type  and Logon . For most users, use the
defaults, User  and Allowed .

7 In the Confirmation  box, type a password in the first Type password twice  field,
and type the password again in the second field for verification. The password
must comply with the guidelines in “Naming Rules” on page 185.

8 Select the value you want for Options . For most users, use the default,
Required .

9 Click OK. You are returned to the User Profile Management—User Management
window.

Changing or Deleting a User ID
To change or delete a UPM user ID, follow these steps:

1 Log on to UPM.

2 Double-click on the User Account Management  icon in the UPM Services
folder.

3 Select Manage ->Manage Users  from the menu bar.

4 Select the user ID you want from the list.

5 Select Actions  from the menu bar; then select one of the following:

Update user information
To change a user's attributes, such as authorization level and
password

View user profile...
To see a user's profile information

Select groups for user ID...
To add a user to, or remove the user ID from, groups

Erase user ID...
To delete a user ID

Add/Change user logon profile...
To add a new logon profile for a user, change an existing logon
profile, or delete a logon profile

Erase user logon profile...
To delete a user's logon profile

6 When you return to the User Profile Management - User Management window,
select Exit ->Exit user management  from the menu bar.
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 Logging Off
To log off from UPM, follow these steps:

1 Display the User Profile Services window, either by exiting the UPM window in
which you are working or by selecting User Profile Management  from the
desktop.

2 Double-click on the UPM Services  folder.

3 Double-click on the Logoff  icon.

4 Select a user ID from the list; then click on the Logoff  push button. To log off all
the user IDs from UPM, click on the Logoff all  push button.

Managing UPM Groups
With administrator authority, you can put user IDs into groups and perform the following
tasks:

¹ Create a new group
¹ Add or delete users in a group
¹ Delete a group.

All of the procedures below begin at the User Profile Management - Group
Management window. To get there, follow these steps:

¹ Double-click on the User Account Management  icon in the UPM Services  folder.

¹ Select Manage ->Manage Groups  from the menu bar.

Creating a New Group
To create a new group, follow these steps:

1 Select —NEW— from the list in the window.

2 Select Actions ->Add a new group  from the menu bar.

3 In the Group ID  field, type the name of the new group. Group IDs follow the
same naming conventions as user IDs (see “Naming Rules” on page 185).

4 Type an optional comment in the Group comment  field.

5 In the User ID  list, select the user IDs for membership in the group.

6 Click on OK.
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Adding and Deleting Users in a Group
To add or delete users in a group, follow these steps:

1 Select the group ID you want from the list in the window.

2 Select Actions ->Update group  from the menu bar.

3 Update the Group comment  field by entering new text.

4 Select the user IDs you want to add to the group.

5 Deselect the user IDs you want to delete from the group.

6 Click on OK.

Deleting a Group
To delete a group, follow these steps:

1 Select the group ID you want from the list in the window.

2 Select Actions ->Erase group  from the menu bar.

3 Click on Erase ID push button to confirm the request.

 Naming Rules
The user ID must conform to the following rules:

¹ Cannot start with a digit (0 to 9) or end with a dollar sign ($).

¹ Can be 1 to 8 characters long and may contain the following characters:

– Upper or lower case letters A to Z
– Special characters #, @, or $
– Digits 0 to 9.

¹ Cannot be PUBLIC, USERS, ADMINS, LOCAL, or GUESTS, or a name that starts
with IBM, SYS, or SQL.

User Profile Management Passwords
UPM provides default values for user ID and password; some countries have translated
these values as shown in Table 12 on page 186.
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Table 12. Default UPM User IDs and Passwords

Country USERID Password

<default> USERID PASSWORD

Denmark BRUGERID KODEORD

Finland OMATUNN TUNNSANA

France IDUTIL MOTDEPAS

Germany BENUTZER KENNWORT

Italy ID CHIAVE

Norway BRUKER PASSORD

Portugal IDUTIL PASSE

Spain IDUSUAR CONTRASE
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Part 7. Advanced Installation and
Configuration
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Chapter 26. Unattended DB2 Installation on
OS/2 or Windows 3.x Operating Systems

During a regular installation, you interact with the install program, filling in a series of
panels to set up and configure the DB2 product.

In an unattended installation, these tasks run automatically without any intervention.
The setup and configuration data is supplied by response files you set in place
beforehand.

You can use this feature to install DB2 products on OS/2 or Windows 3.x operating
systems:

¹ Locally, from a CD-ROM (refer to “Installing DB2 Products from a Hard Disk or
CD-ROM”).

¹ Remotely, across a network connection from a hard disk/CD-ROM (refer to
“Installing DB2 Products from a Hard Disk or CD-ROM”).

¹ Remotely, using the Netfinity server, if it is installed on your system (refer to
“Installing DB2 Products Remotely Using TME Netfinity Server” on page 195).

If you need to install the same DB2 product on several machines, you can
use unattended installation's "response file" feature to create a customized
configuration, save the customized response file, then reuse it as a template
for each installation.

Installing DB2 Products from a Hard Disk or
CD-ROM

To install DB2 products on local or remote workstations, from a hard disk or CD-ROM,
perform the steps in the following sections:

¹ “Step 1. Make DB2 Files Available for Installation” on page 190

¹ “Step 2. Create a Response File for Unattended Installation” on page 191

¹ “Step 3. Run the CMD/BAT File from the Remote Workstation” on page 193

You can also use the following procedure to remove all DB2 products from
a target workstation. Simply follow the instructions below, but when editing
the command file, specify D (Delete) instead of I (Install).
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Step 1. Make DB2 Files Available for Installation
In this section, you make the DB2 install files accessible to the client machine where
DB2 will be installed.

¹ If performing remote installs directly from the CD-ROM:

1 Insert the appropriate Client Pack CD-ROM into the drive.

2 Ensure that the CD-ROM will remain in the drive for as long as it is needed
for the install. If the drive is often used for other tasks as well, consider
installing from the hard disk instead.

¹ If installing from a hard disk, you must copy the required files from the CD-ROM
directories to the hard disk. At the command prompt, use the xcopy  command with
the /s option.

– For OS/2, the syntax for the two commands required is:

| xcopy x:\db2\os2\language e:\clients\os2\language /s

| xcopy x:\db2\os2\common e:\clients\os2\common /s

where:

- x: represents the CD-ROM drive
- language is the two-character code that represents your language (for

example, EN for English). Table 16 on page 264 lists the code for each
available language.

- e: represents the destination drive

– For Windows 3.x, the command syntax is:

|  xcopy x:\db2\windows\language\client\*.* e:\clients\windows /s

where:

- x: represents the CD-ROM drive
- language is the two-character code that represents your language (for

example, EN for English). Table 16 on page 264 lists the code for each
available language.

- e: represents the destination drive

If performing a remote installation, you must enable your network clients to access the
DB2 install files.

Grant shared access authority to the directory that you just created, or to the CD-ROM
drive if installing directly from CD-ROM.
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Step 2. Create a Response File for Unattended
Installation

During an interactive installation, you provide the information needed to install DB2 and
configure its environment. During an unattended installation, this information is provided
as keywords and values in a response file. DB2's install package includes a
ready-to-use sample response file, with default entries already in place.

If you intend to use the sample response file provided, without making any changes to its values,
you can skip this step and go to “Step 3. Run the CMD/BAT File from the Remote Workstation” on
page 193.

To edit the sample response file:

1 Find the correct sample response files for the platform you are installing to, and
for the product you want to install. Copy the files to a local directory.

If installing directly from the CD-ROM, substitute x:\os2 or x:\windows (depending
on the target workstation's operating system), where x: represents the CD-ROM
drive for e:\clients in the directory names below.

¹ For OS/2, edit

| – e:\clients\os2\language\db2conpr.rsp for DB2 Connect Personal
| Edition

where language is the two-character country code that represents your
language (for example, EN for English). Table 16 on page 264 lists the codes
for each available language.

¹ For Windows 3.x, use :

| – e:\clients\windows\db2pconw.rsp for DB2 Connect Personal Edition

2 The response file contains:

¹ Keywords unique to installation

¹ Registry value/environment variable settings

¹ Database manager configuration parameter settings.

3 To activate an item in the response file, remove the asterisk (*) to the left of the
keyword/environment variable, erase the current setting to the right of the value

For more information on:

¹ DB2 environment variables and registry values, see “DB2 Registry
Values and Environment Variables” on page 170, or refer to the
Administration Guide.

¹ Database manager configuration parameters, refer to the Administration
Guide.
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and type in a new setting. The possible settings are listed to the right of the
current setting.

An example section of a response file appears below:

...

FILE = c:\sqllib

COMP = Client Application Enabler

...

*DB2ACCOUNT = BLANK or char(199)

*DB2BQTIME = BLANK or 1 - MAX

...

Keywords unique to installation are parameters that are only specified in a
response file during an unattended installation. The following is a list of keywords
unique to OS/2 and Windows 3.x unattended installation:

 ¹ FILE

Specifies the destination directory for DB2. If you do not change this value, it
defaults to x:\sqllib where x: is the drive on which your operating system is
installed.

 ¹ COMP

Specifies the components you want installed. By default, all components of
the DB2 product are installed. If you do not want to install a component, add
an asterisk (*) to the left of the COMP line for that component in the
response file.

 ¹ OVERWRITE

Specifies whether to automatically overwrite files during installation. Valid
values for this keyword are YES and NO.

 ¹ CFGUPDATE

Specifies whether the config.sys file is automatically updated. Valid values
for this keyword are:

 – AUTO

Automatically updates CONFIG.SYS.

 – MANUAL

Does not update CONFIG.SYS.

 ¹ SAVEBACKUP

Specifies whether to save a backup version of the product when it is updated.
Valid values for this keyword are YES and NO.

 ¹ DB2SYSTEM

¹ Install DB2 products only on a drive which is local to the target
workstation. Installing on a non-local drive can cause performance and
availability problems.
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On OS/2, specifies a name for the system which is unique within a network.

Note:  This parameter must be specified.

 ¹ AUTOSTART_CONTROL_CENTER

On OS/2, specifies whether or not to automatically start the Control Center
each time the system is rebooted.

Note:  By default the Control Center will be automatically started unless this
parameter is set to NO.

 ¹ DB2.AUTOSTART

On OS/2, specifies whether or not to automatically start the DB2 instance
each time the system is rebooted.

Note:  By default the DB2 instance will be automatically started unless this
parameter is set to NO.

¹ ADMIN.USERID and ADMIN.PASSWORD

On OS/2, specifies the user ID and password that will be used to log on and
start the Administration Server each time your system is started. If UPM
already exists on your system, the user ID and password you provide must
exist and have one of the following:

– UPM administrator authority on your system.

– UPM local administrator authority on your system.

If UPM is not on your system, it will be installed as part of the DB2
installation and the user ID and password you provide will be set up with the
appropriate authority.

4 Exit the file. If you have made any changes, save the file under a new file name
to preserve the original sample response file.

If you are installing directly from the CD-ROM, you must store the renamed
response file on a local drive.

Step 3. Run the CMD/BAT File from the Remote
Workstation

A command (CMD) or batch (BAT) file contains the commands which will start the
installation program. You must edit this file before running the installation.

1 Find and open the correct CMD or BAT file.

If installing directly from the CD-ROM, substitute x:\os2 or x:\windows (depending
on the target workstation's operating system) for e:\clients\os2\ in the directory
names below.

¹ For OS/2, the CMD files are available in the e:\clients\os2\language

directory where language is the two-character country code that represents
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your language (for example, EN for English). Table 16 on page 264 lists the
codes for each available language. For example:

– db2conpr.cmd for DB2 Connect Personal Edition

¹ For Windows 3.x, the BAT file is:

– e:\clients\windows\db2pconw.bat for DB2 Connect Personal Edition

2 Edit the command in the file, to fill in the information needed for the installation.

 ¹ For OS/2:

a You must specify the complete install command. A complete command
requires the following syntax:

install

/R:response

/A:action /P:"product"
/X

/L1:error

d:\path

/L2:history

The following is an example of a complete command in the sample command
files:

e:\clients\os2\language\install\install /A:I /X

/P:"IBM DB2 Client Application Enabler"

 /R:e:\clients\os2\language\db2cae.rsp /L1:d:\error.log

 /L2:d:\history.log

where:

/d:\path Specifies the location of the install files. If installing from the hard
drive, specify the directory created in Step 1.

/A Specifies the action to be performed.

I Specifies install.

Note:  If you want to remove all DB2 products from a
target workstation, specify D (Delete) instead of I
(Install).

/X Specifies that the installation will run in unattended mode.

/P Specifies the name of the product you want to install.

/R Specifies the fully qualified response file name. If you changed
and renamed the sample response file provided, make sure this
parameter matches the new name.

/L1 Specifies the fully qualified log file name, where setup
information and any errors occurring during setup are logged.

/L2 Specifies the fully qualified history log name, where all the files
processed by the installation program are listed.
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3 Save and exit the CMD or BAT file.

If you are installing directly from the CD-ROM, you must rename the CMD or BAT
file, store it on a local drive, and use that file name in the next step.

4 Start the installation by entering the CMD or BAT file's name on the command
line. The DB2 Client Application Enabler is now ready to install on the target
workstation.

5 When installation is complete, check the error and history logs for any errors or
problems.

To configure your client to access remote servers, go to Chapter 19, “Configuring Access to a
Remote DB2 Server Using the Client Configuration Assistant” on page 133.

| Installing DB2 Products Remotely Using
| TME Netfinity Server

To install a DB2 product in a Netfinity Server environment, perform the steps in the
following sections:

¹ “Step 1. Copy the DB2 Install Files to the Code Server” on page 196

¹ “Step 2. Add the DB2 Product to the Software Library” on page 196

¹ “Step 3. Configure the DB2 Product” on page 197

¹ “Step 4. Install DB2 Products on the Remote Workstation” on page 197

| Note:  The following are the required levels of Netfinity:

| Netfinity Server Product:  IBM TME 10 Netfinity Server - Manager Version 4
| Product Number: 5697-288, Feature 0000
| Must have component: Software Distribution Server at service level 00000003
| Netfinity Server cannot be used for Windows 3.x workstations.

| Netfinity Client Product:  IBM TME 10 Netfinity Server - Client Version 4
| Product Number: 5697-288, Feature 0000
| Must have component: Software Distribution Client at service level 00000003
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Step 1. Copy the DB2 Install Files to the Code
Server

1 Insert the appropriate CD-ROM into the drive.

2 Copy the required files from the CD-ROM directories to the code server's hard
drive. At the command prompt, use the xcopy  command with the /s option.

The syntax for the two commands required is:

xcopy x:\db2\os2\language e:\cid\img\language /s

xcopy x:\db2\os2\common e:\cid\img\common /s

where

¹ x: represents the CD-ROM drive
¹ language is the two-character code that represents your language (for

example, EN for English. Table 16 on page 264 lists the code for each
available language.

¹ e is the letter that designates the code server's hard disk

3 Leave the CD-ROM in the drive; it is required for the next step.

Step 2. Add the DB2 Product to the Software
Library

To add a DB2 product to the software library:

1 Start Netfinity Server.

2 Double-click on the Netfinity Server Service Manager  icon.

3 Double-click on the CID Software Preparation  icon.

4 Double-click on the Software Library  icon.

5 Select Software ->New from the menu bar on the Software Library window.

6 Enter the name of the product you are adding.

7 Select the Find  push button.

8 In the Find definition file window, select:

¹ The CD-ROM drive letter in the Drive  list
¹ en\install\*.adf in the Directory  list

Once you have added a particular DB2 product to the software library, you
can omit this step for later installations of that product.

196 DB2 Connect Personal Edition Quick Beginnings  



¹ The appropriate .adf file name in the File  list:

– db2conpr.adf for DB2 Connect Personal Edition

9 Click on OK.

10 Select the Add  push button to associate the application definition file with DB2.

This copies the remote installation files (.adf, .var, .cmd and .mrf) from the
CD-ROM to the subdirectory where Netfinity Server resides.

An icon is created in the Software Library  folder, representing the DB2 product you
have just added.

Step 3. Configure the DB2 Product
In this step, you configure the DB2 product for the target workstation, just as you would
during a standard interactive installation. To perform this task:

1 Double-click on the DB2 product icon in the Software Library window.

 2 Select Configuration ->New.

The Settings notebook opens.

3 Enter a unique identifier to define this configuration.

4 On each page of the notebook, select each of the items in the Variables  list and
choose the setting. A description of each variable is displayed in the Explanation
field of the notebook page.

5 When you have completed all of the pages of the notebook, click on OK.

6 When the message Do you want to catalog the database? appears, click on the
Yes push button.

The values entered in the notebook are used to create a response file which will
supply the information needed to run the installation.

Step 4. Install DB2 Products on the Remote
Workstation

To install DB2 products on the remote workstation, you can use either the Event
Scheduler or the Remote System Manager. For information on how to use these tools,
refer to the Netfinity Server documentation.

After installation, you must reboot the workstation before using DB2.
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To configure your client to access remote servers, go to Chapter 28, “Using the Client
Configuration Assistant” on page 217.
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Chapter 27. Unattended DB2 Installation on
Windows 32-bit Operating Systems

During a regular installation, you interact with the install program, filling in a series of
panels to set up and configure DB2.

In an unattended installation, you supply the setup and configuration data in a response
file you create before running the installation.

| You can use this feature to install DB2 products on Windows 32-bit operating systems
| operating systems:

| ¹ Locally, from a CD-ROM (see “Installing DB2 Products from a Hard Disk or
| CD-ROM”)

| ¹ Remotely, across a network connection from a hard disk or CD-ROM (see
| “Installing DB2 Products from a Hard Disk or CD-ROM”)

| ¹ Remotely, across a network connection to target workstations, using Microsoft
| Systems Management Server (SMS) if it is installed on your Windows NT system
| (see “Installing DB2 Remotely Using SMS” on page 207).

| If you need to install the same DB2 product on several machines, you can
| use unattended installation's "response file" feature to create a customized
| configuration, save the customized response file, then reuse it as a template
| for each installation.

Installing DB2 Products from a Hard Disk or
CD-ROM

| To install DB2 products for Windows 32-bit operating systems, from a hard disk or
| CD-ROM to local or remote workstations, perform the steps in the following sections:

| ¹ “Step 1. Make DB2 Files Available for Installation” on page 200

| ¹ “Step 2. Create a Response File for Unattended Installation” on page 202

| ¹ “Step 3. Run Setup from the Workstation” on page 206

You can also use this procedure to perform an interactive remote install instead of an
unattended remote one. Follow the instructions below.
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Before You Begin
Read and perform the steps in this section before you begin the installation to ensure
that you have the required items and information you will need.

Creating Usernames for DB2 Installation and
Operation
This section describes usernames required to install the DB2 product and its
components.

Creating a Username for Installing DB2 Products:

| Windows 95 and Windows 98
The username must be a valid DB2 username.

A valid DB2 username is eight characters or less, and complies with DB2's
naming rules. For more information on DB2's naming rules, see
Appendix C, “Naming Rules” on page 269.

Windows NT
You need to have a username that will be used to install DB2. The
username may belong to the Domain or local Administrators group.

On clients, this username will be removed from the system when the
installation is complete.

Step 1. Make DB2 Files Available for Installation
To make the DB2 install files accessible to the machine where DB2 will be installed:

¹ If performing remote installs directly from the CD-ROM:

1 Insert the appropriate Client Pack CD-ROM into the drive.

2 Ensure that the CD-ROM remains in the drive for as long as the installation
requires it. If the drive is often used for other tasks as well, consider installing
from the hard disk instead.

¹ If installing from a code server, you must copy the required files from the CD-ROM
directories to the hard disk:

1 Insert the appropriate CD-ROM into the drive.

2 Create a directory on the code server, for example, q:\db2prods.
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3 At the command prompt, use the cpysetup.bat  command to copy the files
necessary for a particular language install to a code server.

The command syntax is:

x:\db2\winnt95\common\cpysetup.bat q:\db2prods language

where:

– x: represents your CD-ROM drive
– q: represents the code server's disk.
– language is the two-character country code that represents your

language (for example, EN for English). See Table 16 on page 264 

If performing a remote installation, you must enable your network clients to access the
DB2 install files.

Grant shared access to the directory that you just created, or to the CD-ROM drive.

To set up a share:

1 Click on Start  and select Programs ->Windows Explorer .

2 Select the directory that you want to share, for example q:\db2prods.

3 Select Files ->Properties  from the menu bar. The properties window for the
directory will open. Click on the Sharing  tab.

4 Select the Shared As  radio button.

5 In the Share Name  field type a share name. For example, type db2nt.

6 To specify read access for everyone on Windows NT:

a Select the Permissions  push button. The Access Through Share
Permissions window opens.

b In the Name box, make sure that Everyone  is selected.

c In the Type of Access  box, select Read.

d Click on OK.

On Windows 95 and Windows 98, you do not need to specify type of access
when you set up a share. By default, everyone is allowed read access.

In our example scenario, q:\db2prods uses a share name of db2nt. We will use this
value in the examples that follow.
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Step 2. Create a Response File for Unattended
Installation

During an interactive installation, you interact with the install program, filling in a series
of panels to set up and configure the DB2 product. During an unattended installation,
you supply the setup and configuration data in a response file you create before
running the installation. DB2's install package includes a number of ready-to-use
sample response files, with default entries already in place.

The sample response files are located in the x:\db2\winnt95\common directory,

where x is the letter that designates the CD-ROM drive. There is a different response
file for each product on the CD, so that the user has a valid list of parameters for each
product.

If you intend to use the sample response file provided, without making any changes to its values,
you can skip this step and go to “Step 3. Run Setup from the Workstation” on page 206.

Edit the sample response file. For example, you can use Notepad or WordPad.

1 Open the sample response file for the package you want to install.

¹ db2conpr.rsp for DB2 Connect Personal Edition

2 The response file contains:

¹ Keywords unique to installation

¹ Registry value/environment variable settings

¹ Database manager configuration parameter settings.

3 To activate an item in the response file, remove the asterisk (*) to the left of the
keyword/environment variable, erase the current setting to the right of the value
and type in a new setting. The possible settings are listed to the right of the
current setting.

An example section of a response file appears below:

For more information on:

¹ DB2 environment variables and registry values, see “DB2 Registry
Values and Environment Variables” on page 170, or refer to the
Administration Guide.

¹ Database manager configuration parameters, refer to the Administration
Guide.
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...

FILE = c:\sqllib

REBOOT = No

*COMP = Control Center

...

Keywords unique to installation are parameters that are only specified in a
response file during an unattended installation. The following is a list of keywords
unique to installation for Windows 32-bit operating systems unattended
installation:

 ¹ FILE

Specifies the destination directory for DB2.

Note:  Check the value for the FILE keyword. FILE specifies where to install
the product. If you do not change this value, it defaults to x:\sqllib

where x: is the drive on which your operating system is installed.

 ¹ REBOOT

Specifies whether to restart the system following installation.

 ¹ TYPE

Specifies the type of install. The options are:

 0=Compact

 1=Typical (default)

 2=Custom

For 0 and 1 (compact and typical), any Custom Keywords (COMP) value will
be ignored.

For all types, default communication values will be used where applicable, as
follows:

a DB2.DB2COMM and ADMIN.DB2COMM will be set for the protocols detected
on your system.

b If a protocol is detected on the system, or if you have specified values
for DB2.DB2COMM or ADMIN.DB2COMM, values for its parameters will be
generated so that the protocol will be enabled for DB2's use at the end
of the install. Checks are made to ensure that the generated values are
not duplicates, and that they conform to the protocols set up on your
system. Default values will be generated for the following:

 – For NetBIOS:

 DB2.DB2NBADAPTERS ADMIN.DB2NBADAPTERS

 DB2.NNAME ADMIN.NNAME

 – For TCP/IP:

 DB2.PORT_NUMBER ADMIN.PORTNUMBER

 DB2.SVCENAME ADMIN.SVCENAME
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 – For IPX/SPX:

 DB2.FILESERVER ADMIN.FILESERVER

 DB2.OBJECTNAME ADMIN.OBJECTNAME

 DB2.IPX_SOCKET ADMIN.IPX_SOCKET

 – For APPC:

 DB2.TPNAME ADMIN.TPNAME

Note:  You may override these values; however, if the associated
protocol has not been detected or specified, the values will not
be used.

 ¹ PROD

Specifies the product you want installed. The options are:

– CONNECT_PERSONAL for DB2 Connect Personal Edition

Note:  You can use this parameter more than once.

 ¹ COMP

Specifies the components you want installed. The installation program
automatically installs components that are required for a product, and ignores
requested components that are not available.

Note:  Component selections have no effect unless you specify a custom
installation.

The following table lists COMP keywords and the components they represent.

Table 13 (Page 1 of 2). Component Keywords for Windows 32-bit Operating Systems
Unattended Install

Keyword Component

Product Components

GRAPHICAL_TOOLS Graphical Tools

CLIENT_CONFIGURATION_ASSISTANT Client Configuration Assistant

CONTROL_CENTER Control Center

WEB_CONTROL_CENTER Web Control Center

PERFORMANCE_MONITOR Performance Monitor

VISUAL_EXPLAIN Visual Explain

ODBC_DRIVER DB2 ODBC Driver

SAMPLE_APPLICATIONS 1 Sample Applications

THIN_CLIENT_CODE_SERVER Thin Client Code Server

DB2 Books

API_REFERENCE 1 API Reference

ADMINISTRATION_GUIDE Administration Guide
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 ¹ AUTO_CTRL_CENTER

Specifies whether or not to automatically start the Control Center each time
the system is rebooted.

Note:  By default the Control Center starts automatically unless this
parameter is set to NO.

 ¹ AUTOSTART_CCA

Specifies whether or not to automatically start the Client Configuration
Assistant each time the system is rebooted.

Note:  By default, the Client Configuration Assistant starts automatically
unless this parameter is set to NO.

4 Exit the file. If you have made any changes, save the file under a new file name
to preserve the original sample response file.

Table 13 (Page 2 of 2). Component Keywords for Windows 32-bit Operating Systems
Unattended Install

Keyword Component

ADMINISTRATION_GETTING_STARTED Administration Getting Started

DB2_PROGRAMMING_GETTING_STARTED 1 Road Map to DB2 Programming

BUILDING_OS2_WIN_APPLICATIONS 1 Building Applications for Windows and
OS/2 Environments

CLI_GUIDE_REFERENCE 1 CLI Guide and Reference

COMMAND_REFERENCE Command Reference

SQL_PROGRAMMING_GUIDE 1 Embedded SQL Programming Guide

GLOSSARY Glossary

MASTER_INDEX Master Index

MESSAGES_REFERENCE Messages Reference

SQL_GETTING_STARTED SQL Getting Started

SQL_REFERENCE SQL Reference

SYSTEM_MONITOR_GUIDE System Monitor Guide and Reference

TROUBLESHOOTING_GUIDE Troubleshooting Guide

Note: 

1. Software Developer's Kit only

¹ Install DB2 products only on a drive which is local to the target
workstation. Installing on a non-local drive can cause performance and
availability problems.

¹ By default, the name of the response file will be used to determine the
products to be installed. You can override this setting by providing one
or more PROD parameter values in the response file.
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If you are installing directly from the CD-ROM, you must store the renamed
response file on another drive.

Step 3. Run Setup from the Workstation
To perform the installation:

1 At the workstation where DB2 will be installed, logon as a username that meets
the requirements for installing DB2. See “Creating Usernames for DB2 Installation
and Operation” on page 200 for more information.

2 If performing a remote install, connect to the shared directory of the hard disk, or
to the CD-ROM drive, using a command similar to the following:

net use e: \\machine\directory

where:

¹ e is the drive letter used to connect to the shared directory on the hard disk
or CD-ROM drive.

¹ machine is the machine name of the code server.
¹ directory is the share name of the code server or CD-ROM drive.

For example, type:

net use e: \\codeserv\db2nt

Based on the example set up in previous steps, this points to q:\db2prods on the
code server.

3 Run the setup program:

a Click on Start  and select Run .

b In the Open Window, type the path to the setup program. The path accepts
the following command line arguments:

setup /U drive:path\responsefile

/L drive:path\logfile

drive:\path

/I language

Specify the fully qualified path to start the program. For example:

e:\setup /U d:\db2\common\db2setup.rsp /L db2log.log /I language

where:

/U Specifies the fully qualified response file name. If you changed and
renamed the sample response file provided, make sure that this
parameter matches the new name.
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/L Specifies the fully qualified log file name, where setup information and
any errors occurring during setup are logged.

If you do not specify the log file's name, DB2 names it db2.log, and
stores it in a directory called db2log, on the drive on which your
operating system is installed.

/I Specifies the two-character country code that represents your
language (for example, EN for English). Table 16 on page 264 lists
the code for each available language.

If you do not specify the language, setup will determine the system
language, and launch the appropriate DB2 install for that language.

c Click on OK to start the setup program.

d The installation proceeds without further action on your part.

4 Check the messages in the log file when the installation finishes.

5 Following installation, you must reboot the workstation before using DB2.

Note:  If you specified REBOOT=yes in your response file, the workstation will
reboot automatically.

For information on errors encountered during installation, see the db2.log

file. The db2.log file stores general information and error messages
resulting from installation and uninstall activities. By default, the db2.log file
is located in the x:\db2log directory; where x: is the drive on which your
operating system is installed.

 To configure your DB2 software to access remote DB2 servers, go to Chapter 28, “Using the
Client Configuration Assistant” on page 217 .

Installing DB2 Remotely Using SMS

With Microsoft Systems Management Server (SMS), you can install DB2 across a
network onto remote Windows NT systems, setting up the installation from a central
location.

You can also use SMS to remove all DB2 products from a target
workstation. Simply follow the instructions below, but when creating the
SMS package, select Uninstall DB2 Products  instead of selecting the
packages to be installed.
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To install DB2 using SMS, perform the steps in the following sections:

¹ “Step 1. Make DB2 Files Available for Installation” on page 209

¹ “Step 2. Create a Response File for Unattended Installation” on page 210

¹ “Step 3. Import the DB2 Install Files into SMS” on page 213

¹ “Step 4. Distribute the DB2 Installation Package Using SMS” on page 214

¹ “Step 5. Run the Installation on the SMS Client” on page 215

Before You Begin
Read and perform the steps in this section before you begin the installation to ensure
that you have the required items and information you will need.

Creating Usernames for DB2 Installation and
Operation
This section describes usernames required to install DB2 and its components.

Creating a Username for Installing DB2

| Windows 95 and Windows 98
The username must be a valid DB2 username.

A valid DB2 username is eight characters or less, and complies with DB2's
naming rules. For more information on DB2's naming rules, see
Appendix C, “Naming Rules” on page 269.

Windows NT
You need to have a username that will be used to install DB2. The
username may belong to the Domain or local Administrators group.

On clients, this username will be removed from the system when the
installation is complete.

 SMS Requirements
You must already have SMS installed and configured on your network. Refer to
Microsoft's Systems Management Server for Windows NT Administrator's Guide for
information on how to:

¹ Set up SMS (including setting up primary and secondary sites).
¹ Add clients to the SMS system.
¹ Set up inventory collection for clients.
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To create an SMS package that copies the required files directly from the CD-ROM, insert the
appropriate CD-ROM into the drive and go to “Step 2. Create a Response File for Unattended
Installation” on page 210.

Step 1. Make DB2 Files Available for Installation
To make the DB2 install files accessible to the machine where DB2 will be installed:

¹ If performing remote installs directly from the CD-ROM:

1 Insert the appropriate CD-ROM into the drive.

2 Ensure that the CD-ROM remains in the drive for as long as the installation
requires it. If the drive is often used for other tasks as well, consider installing
from the hard disk instead.

¹ If installing from a code server, you must copy the required files from the CD-ROM
directories to the hard disk:

1 Insert the appropriate CD-ROM into the drive.

2 Create a directory on the code server, for example, q:\db2prods.

3 At the command prompt, use the cpysetup.bat  command to copy the files
necessary for a particular language install to a code server.

The command syntax is:

x:\db2\winnt95\common\cpysetup.bat q:\db2prods language

where:

– x: represents your CD-ROM drive
– q: represents the code server's disk.
– language is the two-character country code that represents your

language (for example, EN for English). Table 16 on page 264 

If performing a remote installation, you must enable your network clients to access the
DB2 install files.

Grant shared access to the directory that you just created, or to the CD-ROM drive.

To set up a share:

1 Click on Start  and select Programs ->Windows Explorer .

2 Select the directory that you want to share, for example q:\db2prods.

3 Select Files ->Properties  from the menu bar. The properties window for the
directory will open. Click on the Sharing  tab.

4 Select the Shared As  radio button.
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5 In the Share Name  field type a share name. For example, type db2nt.

6 To specify read access for everyone on Windows NT:

a Select the Permissions  push button. The Access Through Share
Permissions window opens.

b In the Name box, make sure that Everyone  is selected.

c In the Type of Access  box, select Read.

d Click on OK.

On Windows 95 and Windows 98, you do not need to specify type of access
when you set up a share. By default, everyone is allowed read access.

In our example scenario, q:\db2prods uses a share name of db2nt. We will use this
value in the examples that follow.

Step 2. Create a Response File for Unattended
Installation

During an interactive installation, you interact with the install program, filling in a series
of panels to set up and configure DB2. During an unattended installation, you supply
the setup and configuration data in a response file you create before running the
installation. DB2's install package includes a number of ready-to-use sample response
files, with default entries already in place.

The sample response files are located in the x:\db2\winnt95\common directory,

where x is the letter that designates the CD-ROM drive. There is a different response
file for each product on the CD, so that the user has a valid list of parameters for each
product.

If you intend to use the sample response file provided, without making any changes to its values,
you can skip this step and go to “Step 4. Distribute the DB2 Installation Package Using SMS” on
page 214.

Edit the sample response file. For example, you can use Notepad or WordPad.

1 Open the sample response file for the package you want to install.

¹ db2conpr.rsp for DB2 Connect Personal Edition

2 The response file contains:

¹ Keywords unique to installation

¹ Registry value/environment variable settings

¹ Database manager configuration parameter settings.
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3 To activate an item in the response file, remove the asterisk (*) to the left of the
keyword/environment variable, erase the current setting to the right of the value
and type in a new setting. The possible settings are listed to the right of the
current setting.

An example section of a response file appears below:

...

FILE = c:\sqllib

REBOOT = No

*COMP = Control Center

...

Keywords unique to installation are parameters that are only specified in a
response file during an unattended installation. The following is a list of keywords
unique to installation for Windows 32-bit operating systems unattended
installation:

 ¹ FILE

Specifies the destination directory for DB2.

Note:  Check the value for the FILE keyword. FILE specifies where to install
the product. If you do not change this value, it defaults to x:\sqllib

where x: is the drive on which your operating system is installed.

 ¹ REBOOT

Specifies whether to reboot the system following installation.

 ¹ TYPE

Specifies the type of install. The options are:

 0=Compact

 1=Typical (default)

 2=Custom

For 0 and 1 (compact and typical), any Custom Keywords (COMP) value will
be ignored.

For all types, default communication values will be used where applicable, as
follows:

a DB2.DB2COMM and ADMIN.DB2COMM will be set for the protocols detected
on your system.

For more information on:

¹ DB2 environment variables and registry values, see “DB2 Registry
Values and Environment Variables” on page 170, or refer to the
Administration Guide.

¹ Database manager configuration parameters, refer to the Administration
Guide.
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b If a protocol is detected on the system, or if you have specified values
for DB2.DB2COMM or ADMIN.DB2COMM, values for its parameters will be
generated so that the protocol will be enabled for DB2's use at the end
of the install. Checks are made to ensure that the generated values are
not duplicates, and that they conform to the protocols set up on your
system. Default values will be generated for the following:

 – For NetBIOS:

 DB2.DB2NBADAPTERS ADMIN.DB2NBADAPTERS

 DB2.NNAME ADMIN.NNAME

 – For TCP/IP:

 DB2.PORT_NUMBER ADMIN.PORTNUMBER

 DB2.SVCENAME ADMIN.SVCENAME

 – For IPX/SPX:

 DB2.FILESERVER ADMIN.FILESERVER

 DB2.OBJECTNAME ADMIN.OBJECTNAME

 DB2.IPX_SOCKET ADMIN.IPX_SOCKET

 – For APPC:

 DB2.TPNAME ADMIN.TPNAME

Note:  You may override these values; however, if the associated
protocol has not been detected or specified, the values will not
be used.

 ¹ PROD

Specifies the product you want installed. The options are:

– CONNECT_PERSONAL for DB2 Connect Personal Edition

Note:  You can use this parameter more than once.

 ¹ COMP

Specifies the components you want installed. The installation program
automatically installs components that are required for a product, and ignores
requested components that are not available.

Note:  Component selections have no effect unless you specify a custom
installation.

Table 13 on page 204 lists COMP keywords and the components they
represent.

 ¹ AUTO_CTRL_CENTER

Specifies whether or not to automatically start the Control Center each time
the system is rebooted.

212 DB2 Connect Personal Edition Quick Beginnings  



Note:  By default, the Control Center starts automatically unless this
parameter is set to NO.

 ¹ AUTOSTART_CCA

Specifies whether or not to automatically start the Client Configuration
Assistant each time the system is rebooted.

Note:  By default, the Client Configuration Assistant starts automatically
unless this parameter is set to NO.

4 Exit the file. If you have made any changes, save the file under a new file name
to preserve the original sample response file.

If you are installing directly from the CD-ROM, you must store the renamed
response file on another drive.

¹ Install DB2 only on a drive that is local to the target workstation.
Installing on a non-local drive can cause performance and availability
problems.

¹ By default, the name of the response file will be used to determine the
products to be installed. You can override this setting by providing one
or more PROD parameter values in the response file.

| Step 3. Import the DB2 Install Files into SMS
| To import the DB2 install files into SMS:

| 1 Insert the appropriate CD-ROM into the drive.

| 2 From the Start  button select Programs , then Systems Management Server , and
| then SMS Administrator . The SMS Administrator window opens.

| 3 Open the Package Properties window. The first time you start the SMS
| Administrator program you will see a dialog box prompting you to open an SMS
| Window. You can select the Packages option from there. Otherwise, select
| File ->New from the menu bar.

| 4 Click on the Import  push button. The File Browser  opens.

| 5 In the File Name  field, select the db2.pdf file.

| The server db2.pdf file for DB2 Universal Database is located in the

| x:\db2\common directory (for DB2 Server)

| x:\db2\winnt95\common directory (for DB2 CAE or DB2 SDK)

| where x: designates your CD-ROM drive
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Step 4. Distribute the DB2 Installation Package
Using SMS

In this step, you create an SMS package and send it to the SMS client where you want
to install DB2.

To create the SMS package:

1 From the Package Properties window, click on the Workstations  push button.
The Setup Package For Workstations window opens, showing a list of predefined
DB2 installation packages that you can use.

2 In the Source Directory  field, type the name of the parent directory where you
put the copied DB2 files (for example, q:\db2prods).

3 Select the name of the product to install from the Workstation Command Lines
list.

4 If you changed and renamed the sample response file, click on the Properties
push button and change the value of the parameter to match the new response
file name.

If you do not specify the language, setup will determine the system language, and
launch the appropriate DB2 install for that language. If you want to install a
different language, use the /I parameter to specifies the two-character code that
represents your language (for example, EN for English). Table 16 on page 264
lists the code for each available language.

5 Click on the Close  push button.

6 Click on OK to close the opened windows.

The Packages window shows the name of the new SMS package.

7 Specify where to run the package:

a Open the Sites and Packages windows.

b In the Packages window, select the appropriate package and drag it onto
the target client in the Sites window. The Job Details window opens.

c Select the Run Workstation Command  check box and select the
installation package that you want to use for the Run Command on
Workstation job. For more information about completing the Job Details
window, refer to Microsoft's Systems Management Server for Windows NT
Administrator's Guide.

d When the job specifications are complete, click on OK to close the opened
windows.

The job is created and sent to the SMS client.
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Step 5. Run the Installation on the SMS Client
Now that the remote installation package has been prepared and sent, the SMS client
on the target machine can run the installation.

1 On the SMS client where DB2 will be installed, logon as a username that meets
the requirements for installing DB2. See “Creating Usernames for DB2 Installation
and Operation” on page 208 for more information.

| 2 Select Start->Programs -> Systems Management Client  and then click on
| Package Command Manager . The Package Command Manager window opens.

3 When packages are sent from the SMS server, they are listed in the window.
Select the DB2 package, then click on the Execute  push button. The installation
runs automatically.

4 Following installation, you must reboot the SMS client before using DB2.

Note:  If you specified REBOOT=yes in your response file the SMS client will
reboot automatically.

 To configure your DB2 software to access remote DB2 servers, go to Chapter 28, “Using the
Client Configuration Assistant” on page 217 .
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| Chapter 28. Using the Client Configuration
| Assistant

Use the information in this section to use the Client Configuration Assistant (CCA) to
perform administration tasks on OS/2 and Windows 32-bit operating systems.

Read this section if:

¹ You have an OS/2 or Windows 32-bit operating systems.
¹ You have installed the Client Configuration Assistant option and want to administer

your clients.
¹ You want to configure DB2 Connect Personal Edition to act as a DB2 client and

access information from a DB2 Universal Database server.

This section describes how you configure DB2 Connect Personal Edition to act as a
DB2 client and access information from remote DB2 servers. If you do not intend to use
this feature, you can ignore this section.

With the CCA, you can:

¹ Configure database connections that applications can use.
¹ Update or delete existing configured database connections.
¹ Display the information for existing configured connections.
¹ Test a connection to a database.

| ¹ Enable or disable databases to be configured as CLI or ODBC data sources.
¹ Import or export client profiles which contain information for the setup of a client.
¹ Update client configuration settings.
¹ Discover remote databases (if enabled).
¹ Bind user applications and utilities to databases.

| ¹ Change your password.

The CCA can be installed on OS/2 and Windows 32-bit operating systems.
If it is not installed on your system, you can rerun the setup program and
select to install the CCA.
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Configuring Database Connections

To complete the steps in this section, you must be logged on to the local
system as a user with System Administrative (SYSADM) authority on the
instance.

You can configure database connections through the Add Database SmartGuide, by:

¹ Using a profile as a source of information to add database connections, see “Using an Access
Profile.”

¹ Searching the network for databases, see “Searching the Network for Databases” on
page 221.

¹ Adding database connections manually, see “Manually Configure a Connection to a DB2
Database” on page 226.

Using an Access Profile
You can use either a Server profile or a Client profile to configure database connections
on a client.

 Server Profiles
Server profiles can be generated for a DB2 server. They contain information about
instances on the server system, and databases within each instance. The information
for each instance includes the protocol information required to set up a client to connect
to databases in that instance.

To generate server profiles, use the Generate Access Profile function provided in the
Control Center. When a profile is generated for a DB2 server system, it includes server
instances that have the discover_inst configuration parameter and databases with the

| discover_db configuration parameter set to ENABLE. The discover parameter in the
| Administration Server's configuration file must be set to either SEARCH or KNOWN to

generate a profile for a server system.

For information on setting the discover_inst, discover_db and discover configuration
parameters, see “Setting Discovery Parameters” on page 225.

Generating a Server Profile:  To generate an access profile, perform the following
steps:

| 1 Click on Start  and select Programs ->DB2 for Windows NT ->Administration
Tools ->Control Center .
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2 Click on the [+]  sign beside the Systems  icon to get a list of systems.

3 Select the system to be profiled and click on the right mouse button.

4 Select the Generate access profile  option.

5 Select the path and type in a file name for this profile, then click on the Generate
push button.

To process a server profile and add its databases to the client's connection
configuration list, use the Client Configuration Assistant's Import or Add functions. Using
the Add function is the preferred method.

Using a Server Profile on the Client:  To add a database using the Add function:

| 1 Click on Start  and select Programs ->DB2 for Windows NT ->Client
Configuration Assistant .

2 Click on the Add  push button.

3 Select the Use an access profile  radio button, and click on the Next  push
button.

| 4 Click on the Browse  push button and select the profile for the server that you
| want to access.

5 Select a database to be added and click on the Next  push button.

6 If desired, you can select the Alias  and ODBC tabs at the top of the panel to
specify a database alias name for the database, or to select CLI/ODBC options
for the database. This step is optional.

7 Click on the Done  push button.

8 You can test the connection that has been added by clicking on the Test
Connection  push button.

 Client Profiles
Information in client profiles can be added to another client using the:

¹ Add function, which allows you to selectively process the database connection data
in the client profile and add it to a new client. (This function invokes the Add
Database SmartGuide.)

| ¹ Import function, which allows you to selectively process database connection data,
| client configuration settings, and CLI or ODBC common parameters.

Note:  This scenario assumes that the database connections configured on one client
will be exported and used to set up one or more additional clients.
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Exporting a Client Profile:  Client profiles are generated from clients using the Export
function of the CCA. Use the Export function to copy the database information used by
one client to other clients.

The information contained in a client profile is determined during the export process.
Depending on the settings chosen, it can contain the existing client's:

| ¹ Database connection information (including CLI or ODBC settings).
¹ Client settings (including database manager configuration parameters).

| ¹ CLI or ODBC common parameters.
¹ Configuration data for the local APPC communications subsystem.

The Export function can be used to generate a customized profile that can be imported
on another client to set it up, or update it.

To export a profile from the client, configure the client for communications and do the
following:

1 Enter the db2cca admin  command at a command prompt to start the Client
Configuration Assistant in administrator mode. (You must belong to the local
Administrator group to perform this command.)

2 Click on the Export  push button.

3 Select the databases to be exported from the Available DB2 Databases  window,
and add them to the Databases to be exported  window.

4 Select the check boxes that correspond to the options that you want to set up for
the target client.

To customize settings, click on the appropriate Customize  push button. The
settings that you customize will only affect the profile to be exported, no changes
will be made to your workstation. For more information, click on the Help  push
button.

5 Click on OK.

6 Enter a path and file name for the Client profile.

| The Export function of the CCA is only available when the CCA is started in
| administrator mode. The CCA can be started permanently in administrator
| mode by modifying the Client Configuration Assistant  icon to add the
| parameter admin to the startup. To add the parameter admin to the CCA
| startup:

| 1 Select the CCA icon and click on the right mouse button.

| 2 Select the Properties  option.

| 3 Add the admin parameter to the:

| ¹ Parameters  field on OS/2

| ¹ Target  field (located on the Security  tab) on Windows 32-bit
| operating systems.
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Importing a Client Profile::  Perform these steps at the client that you want to set up.

| 1 Click on Start  and select Programs ->DB2 for Windows NT ->Client
Configuration Assistant .

2 Click on the Import  push button.

3 Select the path and filename of the client profile you want to import and click on
OK.

4 The Import Client Profile window opens. Select the items you want to import. For
more information, click on the Help  push button.

5 Click on OK.

If databases are contained in the client profile that you are importing, and
you select to import them, the Add Database SmartGuide starts to allow you
to selectively import the databases you want to connect to.

Searching the Network for Databases
Instead of entering protocol information to make a connection to remote database
servers, you can use the CCA to find all the databases on your local network by
following these steps:

1 Start the Client Configuration Assistant (CCA).

2 Click on the Add  push button on the CCA's main panel to start the Add Database
SmartGuide.

3 Select the Search the network  radio button, and click on the Next  push button.

4 Click on the [+]  sign beside the Known Systems  icon to list all the systems
known to your workstation.

a Click on the [+]  sign beside a system to get a list of the instances and
databases on it. Select the database that you want to add and proceed to
Step 5.

b If the system that contains the database that you want is not listed, click on
the [+]  sign beside the Other Systems (Search the network)  icon to

| The following scenario assumes that messages used by the Search method
| of discovery are not filtered by your network, and that the installation
| defaults on the client and the server have not been changed. To run the
| following scenario, you must ensure that the discover parameter in the
| database manager configuration file on the client, and the discover
| parameter in the Administration Server configuration file on the server are
| set to SEARCH. Also, the discover_comm parameter must be set to the
| search protocols used on the client and Administration Server.
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search the network for additional systems. Click on the [+]  sign beside a
system to get a list of the instances and databases on it. Select the
database that you want to add and proceed to Step 5.

c If the system you want is still not listed, it can be added to the list of
systems by clicking on the Add Systems  push button.

5 If desired, you can select the Alias  and ODBC tabs at the top of the panel to
specify a database alias name for the database, or to select CLI/ODBC options
for the database. This step is optional.

6 Click on the Done  push button.

7 You can test the connection that has been added by clicking on the Test
Connection  push button.

Searching the network can be customized to meet the needs of individual
organizations. The material that follows provides details on this customization. Refer to
the Administration Guide for more information on individual configuration parameters
and profile registry values.

Choosing a Discovery Method
Network searching uses a DB2 facility called Discovery to obtain information from DB2
servers. This information is used to configure clients for database connections.

Note:  Discovery cannot retrieve information about pre-Version 5 DB2 systems.

Two discovery methods are available for searching the network:

 ¹ Known

Known discovery allows you to discover instances and databases on systems that
are known to your client, and add new systems so that their instances and
databases can be discovered.

Initially, the list of systems will be blank; however, if you are running the CCA on
the server, an entry for the local server will be shown. Add systems to the list by
clicking on the Add System  push button. To use this option you must know a few
details about the Administration Server on the DB2 system to be searched:

– A protocol configured and running on the Administration Server.
– The protocol's configuration information.

The Administration Server will listen for Known discovery requests, from clients, on
the protocols specified by the db2comm registry value in the Administration Server.

 ¹ Search

This mode provides all of the facilities of Known discovery, and adds the option to
allow your local network to be searched for DB2 servers.
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Search may appear to be a simpler discovery method. However, in larger networks,
network routers and bridges can filter the messages that Search uses to find DB2
servers on the network, resulting in an incomplete or even empty list. In this case, use
the Add System method; its messages are not filtered by routers and bridges. If in
doubt, contact your network administrator for assistance.

| To have the server support Known discovery, set the discover parameter in the
| Administration Server configuration file to KNOWN. To have it support Search
| discovery, set this parameter to SEARCH (which also supports all the facilities of
| Known discovery). To prevent discovery of a server, and all of its instances and
| databases, set discover to DISABLE.

On the client, enabling discovery is also done using the discover parameter; however,
in this case, the discover parameter is set in the client instance (or a server acting as a
client) as follows:

Known Allows the CCA to refresh systems in the known list, and to add new
systems to the list by using the Add Systems  push button. When the
discover parameter is set to KNOWN, the CCA will not be able to search
the network.

Search Enables all the facilities of Known discovery, and enables network
searching.

Disable Disables discovery. In this case, the Search the network  option is not
available in the Add Database SmartGuide.

| The TCP/IP host name returned to a client by Search discovery is the same
| host name that is returned by your DB2 server system when you enter the
| hostname  command. On the client, the IP address that this host name
| maps to is determined by either the TCP/IP domain name server (DNS)
| configured on your client machine or, if a DNS is not configured, a mapping
| entry in the client's hosts file. If you have multiple adapter cards configured
| on your DB2 server system, you must ensure that TCP/IP is configured on
| the server to return the correct hostname, and that the DNS or local client's
| hosts file, maps the hostname to the IP address desired.

| The discover parameter defaults to SEARCH on all client and server
| instances. The discover parameter defaults to SEARCH on all
| Administration Servers except Administration Servers installed in a UNIX
| Extended Enterprise Edition environment, where discover defaults to
| KNOWN.

Additional Settings for Search Discovery
Search discovery requires that the discover_comm parameter be set on both the server
(in the Administration Server's configuration file) and the client (in the database
manager configuration file).
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The discover_comm parameter is used to control the communication protocols that the
server will listen to for search requests from clients, and that clients will use to send out
search requests. The discover_comm parameter can be any combination of TCP/IP and
NetBIOS; the protocols supported by Search discovery.

On the Administration Server, the values specified for discover_comm must be equal to,
or a subset of, the values set for db2comm.

On the server, the discover_comm parameter is set in the Administration Server's
configuration file. On the client (or a server acting as a client), discover_comm is set in
the database manager configuration file.

Note:  When using Search discovery, at least one protocol specified by the
discover_comm parameter on the client must match those specified by the
discover_comm parameter on the Administration Server. If there is no match,
the server will not respond to the client's requests.

In addition, there are two DB2 profile registry values that can be used to tune Search
discovery via NetBIOS on the client: db2discoverytime and db2nbdiscoverrcvbufs. The
default values should be suitable in most cases. For more information, refer to the
Administration Guide.

To avoid problems with the Control Center and the Client Configuration
Assistant, ensure that the DB2COMM parameter is set in the DB2 registry
using the db2set command. It is not recommended that you use any other
mechanism to set the DB2COMM value.

Check the settings for the db2comm registry value by entering the db2set
DB2COMM command. For more information, see Chapter 24, “Controlling
Your DB2 Environment” on page 165.

Hiding Server Instances and Databases from
Discovery
You may have multiple instances, and multiple databases within these instances, on a
server. You may want to hide some of these from the discovery process.

To allow clients to discover server instances on a system, set the discover_inst
database manager configuration parameter in each server instance on the system to
ENABLE (this is the default value). Set this parameter to DISABLE to hide this instance
and its databases from discovery.

To allow a database to be discovered from a client, set the discover_db database
configuration parameter to ENABLE (this is the default value). Set this parameter to
DISABLE to hide the database from discovery.
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Setting Discovery Parameters
discover and discover_comm
The discover and discover_comm parameters are set in the Administration Server
configuration file on the server system, and in the database manager configuration file
on the client. Set these parameters as follows:

¹ On the Administration Server:

Update the Administration Server's configuration file, in the command processor, as
follows:

update admin cfg using discover [ DISABLE | KNOWN | SEARCH ]

update admin cfg using discover_comm [ NETBIOS,TCPIP ]

Stop and restart the Administration Server by entering the following commands:

 db2admin stop

 db2admin start

Note:  Search Discovery will only operate on TCP/IP and NetBIOS.

¹ On the client:

1 Start the Client Configuration Assistant (CCA).

2 Click on the Client Settings  push button.

3 Select the Communications  tab.

4 Select the parameters that you want to modify from the Parameters  window.

5 Select a value for the parameter that you want to modify from the Value  box.

| 6 Click on the OK push button to close the Client Settings  window. A DB2
| message window opens.

| 7 Click on the OK push button and restart your applications so that your
| changes can take affect.

discover_inst and discover_db
Use the Control Center to set the discover_inst and discover_db parameters. To set
these parameters, follow these steps:

1 Start the Control Center.

| 2 Click on the [+]  sign beside the Systems  icon to get a list of systems.

If the discover_comm includes NETBIOS, you must ensure that the
Workstation name (nname) configuration parameter is set for the both the
client and the Administration Server. Also, you must ensure that the
db2nbadapters registry value is set to the Adapter number that you want to
use. For more information, refer to the Administration Guide.
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| 3 Click on the [+]  sign beside a system icon to get a list of instances on it.

4 Select the instance that you want to configure and click on the right mouse
button.

5 Select the Configure  option from the pop-up menu. The Configuration Instance
window opens.

6 Select the Environment  tab and select the discover_inst parameter from the
Parameters  box.

7 Select the desired value from the Value  box and click on OK.

8 Click on the [+]  beside an instance icon to get a list of databases in it.

9 Select the database that you want to configure and click on the right mouse
button.

10 Select the Configure  option from the pop-up menu. The Configuration Database
window opens.

11 Select the Environment  tab and select the discover_db parameter.

12 Select the desired value from the Value  box and click on OK.

db2discoverytime and db2nbdiscoverrcvbufs
The db2discoverytime and db2nbdiscoverrcvbufs profile registry values are set in the
client instance (or a server acting as a client). Set these parameters as follows:

¹ To set the db2discoverytime registry value to 60 seconds, enter the following
command:

 db2set db2discoverytime=60

This specifies that Search discovery should wait 60 seconds for a response from
servers.

¹ To set the db2nbdiscoverrcvbufs registry value to 20, enter the following command:

 db2set db2nbdiscoverrcvbufs=20

This specifies the number of NetBIOS buffers that will be allocated for concurrent
response messages from discovered servers.

Manually Configure a Connection to a DB2
Database

Manually configuring a database connection requires you to know:

¹ One of the protocols supported by the server instance containing the database.
¹ The protocol connection information required to configure the connection to the

server instance.
¹ The name of the database on the server system.
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With this information, the SmartGuide will guide you through the steps necessary to add
the database connection.

1 Start the Client Configuration Assistant (CCA).

2 Click on the Add  push button on the CCA's main panel to start the Add Database
SmartGuide.

3 Select the Manually configure a connection to a DB2 database  radio button,
and click on the Next  push button.

4 Select the protocol that you will use to connect to the database and click on the
Next  push button.

5 Enter the required protocol parameters and click on the Next  push button.

| 6 In the Target database  panel, enter the name of the remote database alias in the
| Target Database  field.

| 7 If desired, you can select the Alias  and ODBC tabs at the top of the panel to
| specify a local database alias name or select CLI/ODBC  options for the remote
| database. This step is optional.

8 Click on the Done  push button.

9 You can test the connection that has been added by clicking on the Test
Connection  push button.

| When a database is created on the remote server, if a database alias is not
| specified during database creation, the database is created with a database
| alias=database_name; otherwise, the database alias is the name specified.

| When you add a database using this configuration method, the Client Configuration Assistant will
| generate a default node name for the database.

For example, if you used TCP/IP to add the database to your system, the instance name could be
TCP0000.
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Part 8. Configuring DRDA Hosts
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Chapter 29. Configuring DRDA Hosts for
DB2 Connect

This chapter details steps to be taken by your network or system administrator and your
DB2 administrator in order for you to be able to successfully connect DB2 Connect to a
DRDA application server (AS) on an MVS or OS/390 DRDA host.

Note that the steps listed in this chapter must be performed by users who have the
necessary privileged system access and special expertise. You should make this
information available to your support staff if required.

This section also provides some information for DB2 for AS/400 users, and pointers to
additional information sources for MVS, OS/390, OS/400, VM, and VSE users, as
follows:

¹ DB2 for OS/390 Version 5 Installation Guide, GC26-8970 contains the most
complete and up to date information for DB2 for OS/390.

¹ Information about how to set up DB2 Universal Database as a DRDA AS is
provided in the Quick Beginnings manuals for DB2 Universal Database products.

¹ Selected information about how to set up an MVS, OS/390, OS/400, VM, or VSE
system as a DRDA AS for use over SNA connections with the DB2 Connect DRDA
application requester (AR) is provided with DB2 Connect in the DB2 Connectivity
Supplement.

¹ More information about how to set up an MVS, OS/390, OS/400, VM, or VSE
system as a DRDA AR for use with DB2 Universal Database DRDA AS is also
provided in the DB2 Connectivity Supplement.

¹ Distributed Relational Database Cross Platform Connectivity and Applications,
SG24-4311 contains useful post-configuration information.

The examples in this chapter match those provided elsewhere in this book. When you
use these examples you must substitute your own values for elements such as network
name, LU name, and mode name.
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Preparing MVS/ESA or OS/390 for DB2
Connect

Your VTAM administrator and your host system administrator must configure VTAM and
OS/390 (or MVS/ESA) to prepare DB2 for OS/390 (or DB2 for MVS/ESA) to receive
inbound connection requests from your DB2 Connect workstation.

This section provides:

¹ Examples of VTAM definitions required at your DB2 for OS/390 host for use with
DB2 Connect SNA connections. These should be compared with current
definitions. See “Configuring VTAM” on page 233.

¹ Instructions for establishing TCP/IP network connections between DB2 Connect
and DB2 for OS/390. See “Configuring TCP/IP for DB2 for OS/390” on page 240.

¹ DB2 host configuration steps (see “Configuring DB2 for OS/390” on page 237, or
“Configuring DB2 for MVS/ESA” on page 238). Many details of these steps have
changed with the introduction of DB2 for OS/390 Version 5.1. Most of these steps
apply to SNA users, but some also apply to users who will connect to DB2 for
OS/390 via TCP/IP.

For a summary of the example VTAM names used throughout this book, see “Sample
Network Element Names (VTAM)” on page 233. For TCP/IP names, see “Configuring
TCP/IP for DB2 for OS/390” on page 240.

Summary of Steps
In order to prepare DB2 for OS/390 or DB2 for MVS/ESA to receive connection
requests from DB2 Connect, you must complete the following steps at your DB2 for
OS/390 host:

1 Configure VTAM - see “Configuring VTAM” on page 233, or:

2 Configure TCP/IP - see “Configuring TCP/IP for DB2 for OS/390” on page 240,
or:

3 Configure DB2 for OS/390 or DB2 for MVS/ESA - see “Configuring DB2 for
OS/390” on page 237, or “Configuring DB2 for MVS/ESA” on page 238.
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 Configuring VTAM
VTAM needs to be configured only if DB2 Connect will use SNA connections; it is not
required if DB2 Connect will only use TCP/IP database connections (see “Configuring
TCP/IP for DB2 for OS/390” on page 240).

To configure VTAM, your VTAM Administrator needs to determine the names and
options to be used on your system. The following definitions must be provided to
enable the DB2 Connect workstation to connect to the host:

1 The VTAM APPL Definition for DB2 for OS/390 or DB2 for MVS/ESA. (The APPL
name (LU name) for the DB2 subsystem is NYM2DB2 in these examples.)

2 The VTAM PU and LU Definitions for DB2 Connect. (The PU and LU definitions
for the DB2 Connect workstation are NYX1 and NYX1GW01 respectively in these
examples.)

3 The VTAM Log Mode Definition for DB2. (The log mode entry to be used for the
connection is IBMRDB in these examples.)

The VTAM sample definitions are provided in the sections that follow. These samples
use parameters that match the parameters used elsewhere in this book.

Sample Network Element Names (VTAM)
All the examples in this section use the same names as elsewhere in this book, as
shown in Figure 12 on page 234:
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DB2 Connect GATEWAY:

- Network ID : SPIFNET

- Local Node Name : NYX1 (PU name)

- Local Node ID : 05D27509

- LU Name : SPIFNET.NYX1GW01 (the same LU is used

for DB2 Connect,

for DB2 Universal Database DRDA-AS,

and for the SPM)

- LU Alias : NYX1GW01

HOST:

- Network ID : SPIFNET

- Node Name : NYX

- LU Name : SPIFNET.NYM2DB2

- LU Alias : NYM2DB2

- LAN Destination Address : 400009451902 (NCP TIC address)

MODE DEFINITION:

- Mode Name : IBMRDB

DB2 for MVS/ESA:

 - Location : NEW_YORK3

SECURITY:

- Security Type : Program

- Authentication Type : DCS

Figure 12. Network Element Names Used in the VTAM Examples

Sample VTAM APPL Definition for OS/390
Figure 13 on page 235 lists the sample VTAM application major node definition used
for DB2 for OS/390 in this book. In most cases, such a definition will already exist with
a different LU name.

Otherwise, this application major node must be defined, and DB2 for OS/390 must be
customized in order to use the LU name defined. This name is the Partner LU name
required by DB2 Connect.
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----+----1----+----2----+----3----+----4----+----5----+----6----+----7--

DB2APPLS VBUILD TYPE=APPL

NYM2DB2 APPL APPC=YES, X

 AUTH=(ACQ), X

 AUTOSES=1, X

 DLOGMOD=IBMRDB, X

 DMINWNL=512, X

 DMINWNR=512, X

 DSESSLIM=2048, X

 EAS=6000, X

 MODETAB=RDBMODES, X

 PARSESS=YES, X

 PRTCT=SFLU, X

 MODETAB=RDBMODES, X

 SECACPT=ALREADYV, X

 SRBEXIT=YES, X

 VERIFY=NONE, X

 VPACING=8

Figure 13. Sample VTAM APPL Definition for DB2 for OS/390 or DB2 for MVS/ESA

Note:  Continuations must begin in column 16, with continuation marks in column 72.

Sample VTAM PU and LU Definitions for DB2
Connect
Figure 14 on page 236 lists the sample VTAM switched major node definition used for
the example DB2 Connect workstation in this book.

If you already use SNA applications on the DB2 Connect workstation, then a PU
definition already exists. However, an independent LU definition might not. The
independent LU definition required for DB2 Connect must have LOCADDR=0 specified.
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----+----1----+----2----+----3----+----4----+----5----+----6----+----7--

SWITCHED MAJOR NODE DEFINITION FOR PU NYX1 and

INDEPENDENT LU NYX1GW01

LOC300 VBUILD TYPE=LOCAL

NYX1 ADDR=01,IDBLK=071,IDNUM=27509,ANS=CONT,DISCNT=NO, X

 IRETRY=YES,ISTATUS=ACTIVE,MAXDATA=4302,MAXOUT=7, X

 MAXPATH=1,PUTYPE=2,SECNET=NO,MODETAB=RDBMODES X

 SSCPFM=USSSCS,PACING=0,VPACING=2

NYX1GW01 LOCADDR=000,MODETAB=RDBMODES,DLOGMODE=IBMRDB

OTHERLU LOCADDR=002

Figure 14. Sample VTAM Switched Major Node Definition for DB2 Connect

Alternatively, you can enable DYNPU and DYNLU in VTAM to allow any PU and LU
access through VTAM.

Sample VTAM Log Mode Definition for DB2
Figure 15 on page 237 lists the sample VTAM logon mode table definition IBMRDB
used in this book. Note that this example specifies a 4K RUSIZE, which may not be
suitable for your environment (for example, if you are using Ethernet, which has a
maximum Frame Size of 1536 bytes). Your VTAM Administrator should check these
values and advise you which mode table entry name and RUSIZE to specify for DB2
Connect.
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----+----1----+----2----+----3----+----4----+----5----+----6----+----7---

RDBMODES MODTAB

IBMRDB MODEENT LOGMODE=IBMRDB, DRDA DEFAULT MODE *

 TYPE=0, NEGOTIABLE BIND *

PSNDPAC=X'01', PRIMARY SEND PACING COUNT *

SSNDPAC=X'01', SECONDARY SEND PACING COUNT *

SRCVPAC=X'00', SECONDARY RECEIVE PACING COUNT *

 RUSIZES=X'8989', RUSIZES IN-4K OUT-4K *

FMPROF=X'13', LU6.2 FM PROFILE *

TSPROF=X'07', LU6.2 TS PROFILE *

PRIPROT=X'B0', LU6.2 PRIMARY PROTOCOLS *

SECPROT=X'B0', LU6.2 SECONDARY PROTOCOLS *

COMPROT=X'D0B1', LU6.2 COMMON PROTOCOLS *

PSERVIC=X'060200000000000000122F00' LU6.2 LU TYPE

SNASVCMG MODEENT LOGMODE=SNASVCMG, DRDA DEFAULT MODE *

PSNDPAC=X'00', PRIMARY SEND PACING COUNT *

SSNDPAC=X'02', SECONDARY SEND PACING COUNT *

SRCVPAC=X'00', SECONDARY RECEIVE PACING COUNT *

 RUSIZES=X'8585', RUSIZES IN-1K OUT-1K *

FMPROF=X'13', LU6.2 FM PROFILE *

TSPROF=X'07', LU6.2 TS PROFILE *

PRIPROT=X'B0', LU6.2 PRIMARY PROTOCOLS *

SECPROT=X'B0', LU6.2 SECONDARY PROTOCOLS *

COMPROT=X'D0B1', LU6.2 COMMON PROTOCOLS *

PSERVIC=X'060200000000000000000300' LU6.2 LU TYPE

Figure 15. Sample VTAM Log Mode Definition for DB2 Connect

Note that you must define SNASVCMG when using APPC.

Configuring DB2 for OS/390
Before you can use DB2 Connect, your DB2 for OS/390 Administrator must configure
DB2 for OS/390 to permit connections from the DB2 Connect workstation. This section
indicates the minimum updates required in order to permit the DB2 Connect Application
Requester to make a connection to DB2 for OS/390. More detailed examples can be
found in DB2 Connectivity Supplement, and DB2 for OS/390 Installation Reference.

The following tables need to be updated, depending on the type of connections you are
using (SNA or TCP/IP):

¹ SYSIBM.LUNAMES for SNA connections

¹ SYSIBM.IPNAMES for TCP/IP connections

The sections that follow contain examples of commands to update these tables for DB2
for OS/390. Work with your DB2 Administrator to determine the updates required for
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your DB2 for OS/390 system. The DB2 for OS/390 Communications Database tables
are described in DB2 for OS/390 SQL Reference.

 Updating SYSIBM.LUNAMES
To permit database connection requests to be accepted from any incoming DB2
Connect LU, just insert a blank row. Use an SQL command such as the following:

INSERT INTO SYSIBM.LUNAMES (LUNAME) VALUES (' ')

Alternatively, if you want to restrict access by LU name, you can use an SQL command
such as the following to update this table:

INSERT INTO SYSIBM.LUNAMES (LUNAME,

 SECURITY_OUT,

 ENCRYPTPSWDS,

 USERNAMES)

 VALUES('NYX1GW01','P','N','O');

Result:

 COLUMN EXAMPLE REMARK

 ====== ======= ======

LUNAME NYX1GW01 Name of the DB2 Connect LU

 SECURITY_OUT P

 ENCRYPTPSWDS N

 USERNAMES O

 Updating SYSIBM.IPNAMES
If you want to permit inbound database connection requests for TCP/IP nodes, you can
use an SQL command such as the following to update this table:

INSERT INTO SYSIBM.IPNAMES (LINKNAME) VALUES(' ')

Configuring DB2 for MVS/ESA
Before you can use the DB2 Connect connection, your DB2 for MVS/ESA Administrator
must configure DB2 for MVS/ESA to permit connections from the DB2 Connect
workstation. To configure DB2 for MVS/ESA, the following tables need to be updated:

 ¹ SYSIBM.SYSUSERNAMES

 ¹ SYSIBM.SYSLUNAMES

 ¹ SYSIBM.SYSLUMODES

The sections that follow contain examples of commands to update these tables. Work
with your DB2 Administrator to determine the options required for your DB2 for
MVS/ESA system.
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 Updating SYSIBM.SYSUSERNAMES
If you want to use secondary authorization IDs, you can use the following SQL
command to update this table:

INSERT INTO SYSIBM.SYSUSERNAMES VALUES('I','ADBUSER','NYX1GW01',' ',' ');

Result:

 COLUMN EXAMPLE REMARK

 ====== ======= ======

 Type I

 Authid ADBUSER

LU Name NYX1GW01 Name of the DB2 Connect LU

 NewAuthID (blank)

 Password (blank)

USERNAME types are: O (outbound translation), I (inbound translation), B (both
inbound and outbound) and blank (no authorization ids are translated, and no password
is sent to the server).

 Updating SYSIBM.SYSLUNAMES
If you want to restrict access by LU name, you can use an SQL command such as the
following to update this table:

INSERT INTO SYSIBM.SYSLUNAMES VALUES('NYX1GW01','IBMRDB','A','N',' ','I');

Result:

 COLUMN EXAMPLE REMARK

 ====== ======= ======

LUNAME NYX1GW01 Name of the DB2 Connect LU

 SYSMODENAME IBMRDB

 USERSECURITY A

 ENCRYPTPSWDS N

 MODESELECT

 USERNAMES I

Alternatively, just insert a blank row, and this will allow any incoming DB2 Connect LUs
to be accepted.

 Updating SYSIBM.SYSLUMODES
You can use an SQL command such as the following to update this table:

INSERT INTO SYSIBM.SYSLUMODES VALUES ('NYX1 ', 'IBMRDB', 150, 'Y');
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where:

¹ NYX1 = PU name of server involved

¹ IBMRDB = name of VTAM logon mode

¹ 150 = max. number of conversations

¹ Y = number of sessions preallocated at startup. This can also be left as N, or blank
(the default) for deferred at startup.

Configuring TCP/IP for DB2 for OS/390
This section tells you how to configure TCP/IP communications between your DB2
Connect workstation and DRDA servers running DB2 for OS/390 Version 5.1. It
assumes that:

¹ You are connecting to a single host database via TCP/IP. Multiple host connections
will be handled in exactly the same way, although the port number and service
number required in each case may be different.

¹ The target database resides on DB2 for OS/390 Version 5.1.

¹ All the necessary software prerequisites are installed.

¹ DB2 clients have been set up as required.

These examples use the default port number 446 which has been defined for DRDA.

 Collecting Information
Before you can use DB2 Connect over a TCP/IP connection, you must collect some
information about both the DRDA host and the DB2 Connect workstation. For each
DRDA host server that you are connecting to via TCP/IP, you must know in advance:

¹ The location of the TCP/IP services file at the DB2 Connect workstation:

– On a UNIX system, the location of this file is usually /etc/services.

– On OS/2 Warp with IBM TCP/IP for OS/2 Version 3 the location of this file is
usually \mptn\etc\services. If you have LAPS and TCP/IP, the location is
usually \tcpip\etc\services.

– On Windows NT, the location of this file may be
\winnt\system32\drivers\etc\services or \tcpip\etc\services.

¹ The location of the TCP/IP hosts file at the DB2 Connect workstation:

– On a UNIX system, the location of this file is usually /etc/hosts.

– On OS/2 Warp with MPTN and IBM TCP/IP for OS/2 Version 3, the location of
this file is usually \mptn\etc\hosts. If you have LAPS and TCP/IP, the location
is usually \tcpip\etc\hosts.
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– On Windows NT, the location of this file may be
\winnt35\system32\drivers\etc\hosts, \winnt\system32\drivers\etc\hosts,
or \tcpip\etc\hosts.

You may use a Domain Name Server to avoid maintaining this file on multiple
systems.

¹ The locations of the equivalent files at the target DB2 for OS/390 host.

¹ The TCP/IP port number defined to DB2 for OS/390. (Note that the associated
service name information is not exchanged between the DB2 Connect workstation
and DB2 for OS/390). Port number 446 has been registered for DRDA, and this is
the port number used in these examples.

¹ The TCP/IP addresses and host names for both the host and the DB2 Connect
workstation.

¹ The target database name of the database you will connect to at the DB2 for
OS/390 host. (This is the same as the LOCATION NAME of the database).

¹ The user ID and password to be used when issuing CONNECT requests for the
database at the host.

Refer to your local network administrator and your DB2 for OS/390 administrator for
help getting this information. Use one copy of the example work sheet, Table 14, to
plan each TCP/IP connection between DB2 Connect and a DRDA host server.

 Example Worksheet

Table 14 (Page 1 of 2). Example Worksheet for Planning TCP/IP Connections to DB2 for
OS/390

Ref. Description Sample Value Your Value

User Information

.TCP-1/ User Name A.D.B.User

.TCP-2/ Contact Info (123)-456-7890

.TCP-5/ User ID ADBUSER

.TCP-6/ Database Type db2390

.TCP-7/ Connection type (must
be TCPIP).

TCPIP TCPIP

Network Elements at the Host

.TCP-8/ Host name MVSHOST

.TCP-9/ Host IP address 9.21.152.100

.TCP-10/ Service name db2inst1c

.TCP-11/ Port number 446

.TCP-12/ Target database name NEW_YORK3

.TCP-13/ User ID

.TCP-14/ Password

Network Elements at the DB2 Connect Workstation

.TCP-18/ Host name mcook02
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Notes:

1. If a DB2 Universal Database server is also installed on the same workstation as
DB2 Connect, then the port numbers and service names defined should be the
same: they are shared by DB2 Connect and DB2 Universal Database.

2. Target database name (item 12) is the DB2 for OS/390 LOCATION NAME.

3. TM_DATABASE is required only if you will use two-phase commit.

4. To obtain the host's IP address (item 9), enter at the host:

TSO NETSTAT HOME

5. To obtain the port number (item 11), look for DSNL004I in the DB2 master address
space or system log. Port number 446 has been registered for DRDA, and this is
the port number used in these examples.

Table 14 (Page 2 of 2). Example Worksheet for Planning TCP/IP Connections to DB2 for
OS/390

Ref. Description Sample Value Your Value

.TCP-19/ IP address 9.21.27.179

.TCP-20/ Service name db2inst1c

.TCP-21/ Port number 446

DB2 Directory Entries (at the DB2 Connect workstation)

.TCP-30/ Node name MVSIPNOD

.TCP-31/ Database name nyc3

.TCP-32/ Database alias mvsipdb1

.TCP-33/ DCS database name nyc3

.TCP-34/ TM_DATABASE 1ST_CONN
(recommended)

Configuring the TCP/IP Connection
Use the manual steps in this section to complete the configuration and make the
connection.

Complete the Worksheet:  Complete a copy of the example worksheet for each
TCP/IP host:

1 Fill in the values to be used for the TCP/IP address and hostname of the DB2 for
OS/390 host (items 8 and 9).

2 Fill in the values to be used for the TCP/IP address and hostname of the DB2
Connect workstation (items 18 and 19).

3 Determine the port number or service name to be used for the connection (items
10 and 11, or 20 and 21).
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4 Determine the host database name that you will connect to (the DB2 for OS/390
LOCATION name (item 12).

5 Determine the values to be used for user ID and PASSWORD when connecting
to the host database.

6 Determine the value to be used for TM_DATABASE  at the DB2 Connect
workstation, item 34. In most cases we recommend 1ST_CONN (the default is
NULL ).

Note that some additional planning considerations may apply, for example if you are
using DCE. See the DB2 Connect User's Guide.

Update the DB2 for OS/390 Host:  At your DB2 for OS/390 host:

1 Verify the host address or the host name.

2 Verify the port number or the service name.

3 Update the services file with the correct port number and service name if
necessary.

4 Update the hosts file (or the Domain Name Server used by the DB2 for OS/390
system) with the hostname and IP address of the DB2 Connect workstation if
necessary.

5 Ensure the new definitions are active before attempting to test the connection.
Refer to your host network administrator or change control staff if necessary.

6 Check with the DB2 for OS/390 administrator that you have a valid user ID,
password, and database LOCATION NAME.

7 PING the DB2 Connect workstation, using the correct port number if that option is
supported by TCP/IP on the host system. For example:

ping remote_host_name -p port_number

Update the DB2 Connect Workstation:  At your DB2 Connect workstation:

1 Verify the host name. Enter the hostname command at a system prompt. This will
return the TCP/IP host name for the DB2 Connect workstation.

2 Verify the host address. Use the ping command, for example:

 ping myhost

This will return the host address.

3 Verify the port number. Examine the TCP/IP services file on the workstation (see
above for location information).

4 Verify the service name. Same as the previous step.

5 Update the services file with the correct port number and service name if
necessary.
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6 Update the hosts file (or the Domain Name Server used by the DB2 Connect
workstation) with the hostname and IP address of the DB2 for OS/390 system.
This may not need to be done if it has already been defined there. Check with
your network administrator.

7 Ensure the new definitions are active before attempting to test the connection.
Refer to your local network administrator or change control staff if necessary.

8 Check with the local DB2 administrator that you have a valid user ID and
password for use when accessing DB2 Connect. You will need this in order to
update the local Database Manager Configuration, as well as the DB2 Database,
Node, and Data Connection Services directories, prior to issuing a CONNECT
statement for the host database.

9 PING the DB2 for OS/390 host, using the correct port number if that option is
supported by TCP/IP on the DB2 Connect workstation:

ping MVS_host_name -p port_number

Update the DB2 Connect Configuration:  At a command line prompt, issue the
following command to update the Database Manager Configuration:

db2 update dbm config using tm_database "1st_conn"

where TM_DATABASE can have one of the following settings:

¹ 1ST_CONN the first database that a connection is established to will be used as
the Transaction Manager database for transactions. If this option is used, then the
first database connected to must be either a DB2 Universal Database Version 5
database, or a DB2 for OS/390 Version 5.1 database. This is the recommended
setting.

¹ database_name the named database that is connected to will be used. If this
option is used, we recommend that the named database should be either a DB2
Universal Database Version 5 database, or a DB2 for OS/390 Version 5.1
database.

Note:  TM_DATABASE cannot be left to default. If no TM_DATABASE value is
provided then any CONNECT issued will fail with SQLCODE 865. If you want
more information about TM_DATABASE options, refer to Administration Guide.

Update the DB2 Connect Directories

1 At a command line prompt, issue the following command to catalog the DB2 for
MVS/ESA node:

db2 catalog tcpip node MVSIPNOD remote MVSHOST server dbs2inst1c

where:

¹ MVSIPNOD is the local DB2 Connect node name to be used for the host.

¹ MVSHOST is the eight-character TCP/IP host name for the DB2 for OS/390
host. TCP/IP name lookup must resolve this name to the correct destination
Internet address, either through an entry in the local hostsfile on the DB2
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Connect workstation, or via a Domain Name Server (DNS) referenced by

the DB2 Connect workstation.

¹ db2inst1c is either the service name or the port number defined at the DB2
Connect workstation. This must resolve to the same port number as that
defined for use by DB2 Connect at the DB2 for MVS/ESA host.

2 Create entries for the Database and Data Connection Services directories, as
follows (this shows the values used in the sample worksheet):

db2 catalog dcs database NYC3 as NEW_YORK3

db2 catalog database NYC3 as MVSIPDB1 at node MVSIPNOD authentication dcs

 where:

¹ MVSIPDB1 is the DB2 Connect database alias for the host database.

¹ NYC3 is the DB2 Connect database name for the host database.

¹ MVSIPNOD is the DB2 Connect node name for the host.

¹ NEW_YORK3 is the DB2 for OS/390 LOCATION NAME for the target
database.

| CONNECT and BIND:  Finally, connect to the DRDA Server and bind the utilities and
| applications to the DRDA server using commands similar to the following in the
| command line processor:

| connect to MVSIPDB1 user USERID using PASSWORD

| bind path/bnd/@ddcsmvs.lst blocking all

| sqlerror continue messages ddcsmvs.msg grant public

|  disconnect all

| where path corresponds to the DB2PATH registry value.

These commands are described in detail in the Command Reference.

Preparing DB2 for AS/400 for DB2 Connect

DB2 Connect gives applications on remote systems access to data in your DB2 for
AS/400 system. In order to set up the connection, the person installing DB2 Connect
needs the following information:

¹ The local network name. You can get this information by entering DSPNETA.

¹ The local adapter address. You can get this information by entering
WRKLIND (*trlan) .

¹ The mode name. You can get a list of mode names by entering WRKMODD. If the
mode IBMRDB has been defined on your OS/400 system, you should use it.

¹ The local control point name. You can get this information by entering DSPNETA.

  Chapter 29. Configuring DRDA Hosts for DB2 Connect 245



¹ The remote transaction program name. The default (defined by DRDA) is
X'07'6DB (X'07F6C4C2'). The default is always used by DB2 for AS/400. If
entering a hexadecimal number is not convenient, an alias is QCNTEDDM.

¹ The relational database name. You can get this information by entering
DSPRDBDIRE. This will display a list. The line containing *LOCAL in the Remote
Location column identifies the RDBNAME which must be defined to the client.

Here is an example screen:

� �
Display Relational Database Directory Entries

Position to . . . . . .

Type options, press Enter.
 5=Display details 6=Print details

 Relational Remote
 Option Database Location Text
 _ __________________
 _ DLHX RCHAS2FA
 _ JORMT2FA JORMT2FA
 _ JORMT4FD JORMT4FD
 _ JOSNAR7B RCHASR7B
 _ RCHASR7B *LOCAL
 _ RCHASR7C RCHASR7C
 _ RCH2PDH3 RCHASDH3
 _ R7BDH3SNA RCH2PDH3
 _ RCHASDH3 RCHASDH3

� �

When you have obtained these parameters from OS/400, enter your values into the
worksheet that follows:

For further information about how to set up DB2 for AS/400 as an application server,
refer to the online DB2 Connectivity Supplement provided with your DB2 Connect
product.

More detailed information can also be found in the DRDA Connectivity Guide.

Table 15. Configuration Parameters from OS/400

Item Parameter Example Your value

A-1 Local network name SPIFNET  

A-2 Local adapter address 400009451902  

A-3 Mode name IBMRDB  

A-4 Local control point name SYD2101A  

A-5 Remote transaction program X'07F6C4C2'(default)  

A-6 Relational database name NEW_YORK3  
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Preparing DB2 for VSE & VM

For information about how to set up DB2 for VSE & VM as an application server, refer
to the online DB2 Connectivity Supplement.

More detailed information can also be found in the DRDA Connectivity Guide.
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Appendix A. How the DB2 Library Is
Structured

The DB2 Universal Database library consists of SmartGuides, online help, and books.
This section describes the information that is provided, and how to access it.

To access product information online, you can use the Information Center. You can
view task information, DB2 books, troubleshooting information, sample programs, and
DB2 information on the Web. See “Information Center” on page 261 for details.

 SmartGuides

SmartGuides help you complete some administration tasks by taking you through each
task one step at a time. SmartGuides are available through the Control Center. The
following table lists the SmartGuides.

Note:  Not all SmartGuides are available for the partitioned database environment.

SmartGuide Helps you to... How to Access...

Add Database Catalog a database on a client workstation. From the Client Configuration
Assistant, click on Add .

Create Database Create a database, and perform some basic
configuration tasks.

From the Control Center, click with the
right mouse button on the Databases
icon and select Create ->New.

Performance
Configuration

Tune the performance of a database by
updating configuration parameters to match your
business requirements.

From the Control Center, click with the
right mouse button on the database
you want to tune and select Configure
performance .

Backup Database Determine, create, and schedule a backup plan. From the Control Center, click with the
right mouse button on the database
you want to backup and select
Backup ->Database using
SmartGuide .

Restore Database Recover a database after a failure. It helps you
understand which backup to use, and which logs
to replay.

From the Control Center, click with the
right mouse button on the database
you want to restore and select
Restore ->Database using
SmartGuide .
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SmartGuide Helps you to... How to Access...

Create Table Select basic data types, and create a primary
key for the table.

From the Control Center, click with the
right mouse button on the Tables  icon
and select Create ->Table using
SmartGuide .

Create Table Space Create a new table space. From the Control Center, click with the
right mouse button on the Table
spaces  icon and select Create ->Table
space using SmartGuide .

 Online Help

Online help is available with all DB2 components. The following table describes the
various types of help. You can also access DB2 information through the Information
Center. For information see “Information Center” on page 261.

Type of Help Contents How to Access...

Command Help Explains the syntax of
commands in the command
line processor.

From the command line processor in interactive mode,
enter:

? command

where command is a keyword or the entire command.

For example, ? catalog  displays help for all the
CATALOG commands, while ? catalog database
displays help for the CATALOG DATABASE command.

Control Center Help Explains the tasks you can
perform in a window or
notebook. The help includes
prerequisite information you
need to know, and
describes how to use the
window or notebook
controls.

From a window or notebook, click on the Help  push
button or press the F1 key.
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Type of Help Contents How to Access...

Message Help Describes the cause of a
message, and any action
you should take.

From the command line processor in interactive mode,
enter:

? XXXnnnnn

where XXXnnnnn is a valid message identifier.

For example, ? SQL30081  displays help about the
SQL30081 message.

To view message help one screen at a time, enter:

? XXXnnnnn | more

To save message help in a file, enter:

? XXXnnnnn > filename.ext

where filename.ext is the file where you want to save
the message help.

SQL Help Explains the syntax of SQL
statements.

From the command line processor in interactive mode,
enter:

help  statement

where statement is an SQL statement.

For example, help  SELECT displays help about the
SELECT statement.

SQLSTATE Help Explains SQL states and
class codes.

From the command line processor in interactive mode,
enter:

? sqlstate or ? class-code

where sqlstate is a valid five-digit SQL state and the
class-code is first two digits of the SQL state.

For example, ? 08003 displays help for the 08003 SQL
state, while ? 08 displays help for the 08 class code.
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 DB2 Books

The table in this section lists the DB2 books. They are divided into two groups:

Cross-platform books  These books contain the common DB2 information for
UNIX-based and Intel-based platforms.

Platform-specific books  These books are for DB2 on a specific platform. For example,
for DB2 on OS/2, on Windows NT, and on the UNIX-based platforms, there
are separate Quick Beginnings books.

Most books are available in HTML and PostScript format, and in hardcopy that you can
order from IBM. The exceptions are noted in the table.

If you want to read the English version of the books, they are always provided in the
directory that contains the English documentation.

You can obtain DB2 books and access information in a variety of different ways:

View See “Viewing Online Books” on page 258.
Search See “Searching Online Books” on page 259.
Print See “Printing the PostScript Books” on page 259.
Order See “Ordering the Printed DB2 Books” on page 260.

Book Name Book Description Form Number

File Name

Cross-Platform Books

Administration Getting Started Introduces basic DB2 database administration
concepts and tasks, and walks you through the
primary administrative tasks.

S10J-8154

db2k0x50

Administration Guide Contains information required to design, implement,
and maintain a database to be accessed either locally
or in a client/server environment.

S10J-8157

db2d0x51

API Reference Describes the DB2 application programming interfaces
(APIs) and data structures you can use to manage
your databases. Explains how to call APIs from your
applications.

S10J-8167

db2b0x51

CLI Guide and Reference Explains how to develop applications that access DB2
databases using the DB2 Call Level Interface, a
callable SQL interface that is compatible with the
Microsoft ODBC specification.

S10J-8159

db2l0x50

Command Reference Explains how to use the command line processor, and
describes the DB2 commands you can use to manage
your database.

S10J-8166

db2n0x51
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Book Name Book Description Form Number

File Name

DB2 Connect Enterprise Edition
Quick Beginnings

Provides planning, migrating, installing, configuring,
and using information for DB2 Connect Enterprise
Edition. Also contains installation and setup
information for all supported clients.

S10J-7888

db2cyx51

DB2 Connect Personal Edition
Quick Beginnings

Provides planning, installing, configuring, and using
information for DB2 Connect Personal Edition.

S10J-8162

db2c1x51

DB2 Connect User's Guide Provides concepts, programming and general using
information about the DB2 Connect products.

S10J-8163

db2c0x51

DB2 Connectivity Supplement Provides setup and reference information for
customers who want to use DB2 for AS/400, DB2 for
OS/390, DB2 for MVS, or DB2 for VM as DRDA
Application Requesters with DB2 Universal Database
servers, and customers who want to use DRDA
Application Servers with DB2 Connect (formerly
DDCS) application requesters.

Note:  Available in HTML and PostScript formats
only.

No form number

db2h1x51

Embedded SQL Programming
Guide

Explains how to develop applications that access DB2
databases using embedded SQL, and includes
discussions about programming techniques and
performance considerations.

S10J-8158

db2a0x50

Glossary Provides a comprehensive list of all DB2 terms and
definitions.

Note:  Available in HTML format only.

No form number

db2t0x50

Installing and Configuring DB2
Clients

Provides installation and setup information for all DB2
Client Application Enablers and DB2 Software
Developer's Kits.

Note:  Available in HTML and PostScript formats
only.

No form number

db2iyx51

Master Index Contains a cross reference to the major topics
covered in the DB2 library.

Note:  Available in PostScript format and hardcopy
only.

S10J-8170

db2w0x50

Messages Reference Lists messages and codes issued by DB2, and
describes the actions you should take.

S10J-8168

db2m0x51

DB2 Replication Guide and
Reference

Provides planning, configuring, administering, and
using information for the IBM Replication tools
supplied with DB2.

S95H-0999

db2e0x52

Road Map to DB2 Programming Introduces the different ways your applications can
access DB2, describes key DB2 features you can use
in your applications, and points to detailed sources of
information for DB2 programming.

S10J-8155

db2u0x50
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Book Name Book Description Form Number

File Name

SQL Getting Started Introduces SQL concepts, and provides examples for
many constructs and tasks.

S10J-8156

db2y0x50

SQL Reference Describes SQL syntax, semantics, and the rules of the
language. Also includes information about
release-to-release incompatibilities, product limits, and
catalog views.

S10J-8165

db2s0x51

System Monitor Guide and
Reference

Describes how to collect different kinds of information
about your database and the database manager.
Explains how you can use the information to
understand database activity, improve performance,
and determine the cause of problems.

S10J-8164

db2f0x50

Troubleshooting Guide Helps you determine the source of errors, recover
from problems, and use diagnostic tools in
consultation with DB2 Customer Service.

S10J-8169

db2p0x50

What's New Describes the new features, functions, and
enhancements in DB2 Universal Database, Version
5.2, including information about Java-based tools.

S04L-6230

db2q0x51

Platform-Specific Books

Building Applications for UNIX
Environments

Provides environment setup information and
step-by-step instructions to compile, link, and run DB2
applications on a UNIX system.

S10J-8161

db2axx51

Building Applications for
Windows and OS/2
Environments

Provides environment setup information and
step-by-step instructions to compile, link, and run DB2
applications on a Windows or OS/2 system.

S10J-8160

db2a1x50

DB2 Personal Edition Quick
Beginnings

Provides planning, installing, migrating, configuring,
and using information for DB2 Universal Database
Personal Edition on OS/2, Windows 95, and the
Windows NT operating systems.

S10J-8150

db2i1x50

DB2 SDK for Macintosh Building
Your Applications

Provides environment setup information and
step-by-step instructions to compile, link, and run DB2
applications on a Macintosh system.

Note:  Available in PostScript format and hardcopy
for DB2 Version 2.1.2 only.

S50H-0528

sqla7x02

DB2 SDK for SCO OpenServer
Building Your Applications

Provides environment setup information and
step-by-step instructions to compile, link, and run DB2
applications on a SCO OpenServer system.

Note:  Available for DB2 Version 2.1.2 only.

S89H-3242

sqla9x02

DB2 SDK for SINIX Building
Your Applications

Provides environment setup information and
step-by-step instructions to compile, link, and run DB2
applications on a SINIX system.

Note:  Available in PostScript format and hardcopy
for DB2 Version 2.1.2 only.

S50H-0530

sqla8x00
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Book Name Book Description Form Number

File Name

Quick Beginnings for OS/2 Provides planning, installing, migrating, configuring,
and using information for DB2 Universal Database on
OS/2. Also contains installing and setup information
for all supported clients.

S10J-8147

db2i2x50

Quick Beginnings for UNIX Provides planning, installing, configuring, migrating,
and using information for DB2 Universal Database on
UNIX-based platforms. Also contains installing and
setup information for all supported clients.

S10J-8148

db2ixx51

Quick Beginnings for Windows
NT

Provides planning, installing, configuring, migrating,
and using information for DB2 Universal Database on
the Windows NT operating system. Also contains
installing and setup information for all supported
clients.

S10J-8149

db2i6x50

DB2 Extended Enterprise Edition
for UNIX Quick Beginnings

Provides planning, installing, configuring, and using
information for DB2 Universal Database Extended
Enterprise Edition for UNIX.

This book supercedes the DB2 Extended Enterprise
Edition Quick Beginnings for AIX book, and is suitable
for use with all versions of DB2 Extended Enterprise
Edition that run on UNIX-based platforms.

S99H-8314

db2v3x51

DB2 Extended Enterprise Edition
for Windows NT Quick
Beginnings

Provides planning, installing, configuring, and using
information for DB2 Universal Database Extended
Enterprise Edition for Windows NT.

S09L-6713

db2v6x51

Notes:

1. The character in the sixth position of the file name indicates the language of a
book. For example, the file name db2d0e50 indicates that the Administration Guide
is in English. The following letters are used in the file names to indicate the
language of a book:

2. For late breaking information that could not be included in the DB2 books:

¹ On UNIX-based platforms, see the Release.Notes file. This file is located in the
DB2DIR/Readme/%L directory, where %L is the locale name and DB2DIR is:

Language Identifier Language Identifier
Brazilian Portuguese B Japanese J
Bulgarian U Korean K
Czech X Norwegian N
Danish D Polish P
English E Russian R
Finnish Y Simp. Chinese C
French F Slovenia L
German G Spanish Z
Greek A Swedish S
Hungarian H Trad. Chinese T
Italian I Turkish M
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– /usr/lpp/db2_05_00 on AIX
– /opt/IBMdb2/V5.0 on HP-UX, Solaris, SCO UnixWare 7, and SGI.

¹ On other platforms, see the RELEASE.TXT file. This file is located in the directory
where the product is installed.

Viewing Online Books
The manuals included with this product are in Hypertext Markup Language (HTML)
softcopy format. Softcopy format enables you to search or browse the information, and
provides hypertext links to related information. It also makes it easier to share the
library across your site.

You can use any HTML Version 3.2-compliant browser to view the online books.

To view online books:

¹ If you are running DB2 administration tools, use the Information Center. See
“Information Center” on page 261 for details.

¹ Use the open file function of your Web browser. The page you open contains
descriptions of and links to DB2 books:

– On UNIX-based platforms, open the following page:

 file:/INSTHOME/sqllib/doc/%L/html/index.htm

where %L is the locale name.

– On other platforms, open the following page:

 sqllib\doc\html\index.htm

The path is located on the drive where DB2 is installed.

You can also open the page by double-clicking on the DB2 Online Books
icon. Depending on the system you are using, the icon is in the main product
folder or the Windows Start menu.

Note:  The DB2 Online Books  icon is only available if you do not install the
Information Center.

Setting up a Document Server
By default the DB2 information is installed on your local system. This means that each
person who needs access to the DB2 information must install the same files. To have
the DB2 information stored in a single location, use the following instructions:

1. Copy all files and sub-directories from \sqllib\doc\html on your local system to a
web server. Each book has its own sub-directory containing all the necessary
HTML and GIF files that make up the book. Ensure that the directory structure
remains the same.
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2. Configure the web server to look for the files in the new location. For information,
see Setting up DB2 Online Documentation on a Web Server at:

 http://www.software.ibm.com/data/pubs/papers/db2html.html

3. If you are using the Java version of the Information Center, you can specify a base
URL for all HTML files. You should use the URL for the list of books.

4. Once you are able to view the book files, you should bookmark commonly viewed
topics such as:

¹ List of books
¹ Tables of contents of frequently used books
¹ Frequently referenced articles like the ALTER TABLE topic

 ¹ Search form.

For information about setting up a search, see the What's New book.

Searching Online Books
To search for information in the HTML books, you can do the following:

¹ Click on Search the DB2 Books  at the bottom of any page in the HTML books.
Use the search form to find a specific topic.

¹ Click on Index  at the bottom of any page in an HTML book. Use the Index to find a
specific topic in the book.

¹ Display the Table of Contents or Index of the HTML book, and then use the find
function of the Web browser to find a specific topic in the book.

¹ Use the bookmark function of the Web browser to quickly return to a specific topic.

¹ Use the search function of the Information Center to find specific topics. See
“Information Center” on page 261 for details.

Printing the PostScript Books
If you prefer to have printed copies of the manuals, you can decompress and print
PostScript versions. For the file name of each book in the library, see the table in “DB2
Books” on page 254.

Note:  Specify the full path name for the file you intend to print.

On OS/2 and Windows platforms:

1. Copy the compressed PostScript files to a hard drive on your system. The files
have a file extension of .exe and are located in the x:\doc\language\books\ps

directory, where x: is the letter representing the CD-ROM drive and language is the
two-character country code that represents your language (for example, EN for
English).
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2. Decompress the file that corresponds to the book that you want. The result from
this step is a printable PostScript file with a file extension of .psz.

3. Ensure that your default printer is a PostScript printer capable of printing Level 1
(or equivalent) files.

4. Enter the following command from a command line:

 print filename.psz

On UNIX-based platforms:

1. Mount the CD-ROM. Refer to your Quick Beginnings manual for the procedures to
mount the CD-ROM.

2. Change to /cdrom/doc/%L/ps directory on the CD-ROM, where /cdrom is the mount
point of the CD-ROM and %L is the name of the desired locale. The manuals will
be installed in the previously-mentioned directory with file names ending with
.ps.Z.

3. Decompress and print the manual you require using the following command:

 ¹ For AIX:

zcat filename | qprt -P PSPrinter_queue

¹ For HP-UX, Solaris, or SCO UnixWare 7:

zcat filename | lp -d PSPrinter_queue

¹ For Silicon Graphics IRIX and SINIX:

zcat < filename | lp -d PSPrinter_queue

where filename is the name of the full path name and extension of the compressed
PostScript file and PSprinter_queue is the name of the PostScript printer queue.

For example, to print the English version of Quick Beginnings for UNIX on AIX, you
can use the following command:

zcat /cdrom/doc/en/ps/db2ixe50.ps.Z | qprt -P ps1

Ordering the Printed DB2 Books
You can order the printed DB2 manuals either as a set, or individually. There are three
sets of books available. The form number for the entire set of DB2 books is
SBOF-8915-00. The form number for the set of books updated for Version 5.2 is
SBOF-8921-00. The form number for the books listed under the heading "Cross-Platform
Books" is SBOF-8914-00.

Note:  These form numbers only apply if you are ordering books that are printed in the
English language.

You can also order books individually by the form number listed in “DB2 Books” on
page 254. To order printed versions, contact your IBM authorized dealer or marketing
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representative, or phone 1-800-879-2755 in the United States or 1-800-IBM-4YOU in
Canada.

 Information Center

The Information Center provides quick access to DB2 product information. You must
install the DB2 administration tools to obtain the Information Center.

Depending on your system, you can access the Information Center from the:

¹ Main product folder
¹ Toolbar in the Control Center
¹ Windows Start menu
¹ Help menu of the Control Center

 ¹ db2ic command.

The Information Center provides the following kinds of information. Click on the
appropriate tab to look at the information:

Tasks Lists tasks you can perform using DB2.

Reference Lists DB2 reference information, such as keywords, commands,
and APIs.

Books Lists DB2 books.

Troubleshooting Lists categories of error messages and their recovery actions.

Sample Programs Lists sample programs that come with the DB2 Software
Developer's Kit. If the Software Developer's Kit is not installed,
this tab is not displayed.

Web Lists DB2 information on the World Wide Web. To access this
information, you must have a connection to the Web from your
system.

When you select an item in one of the lists, the Information Center launches a viewer to
display the information. The viewer might be the system help viewer, an editor, or a
Web browser, depending on the kind of information you select.

The Information Center provides some search capabilities so you can look for specific
topics, and filter capabilities to limit the scope of your searches.

For a full text search, follow the Search DB2 Books link in each HTML file, or use the
search feature of the help viewer.
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The HTML search server is usually started automatically. If a search in the HTML
information does not work, you may have to start the search server via its icon on the
Windows or OS/2 desktop.

Refer to the release notes if you experience any other problems when searching the
HTML information.
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Appendix B. National Language Support
(NLS)

This section contains information about configuring national language support for the
DB2 Connect product, and includes information on:

¹ Which languages are supported by DB2 Connect Enterprise Edition and DB2
Connect Personal Edition.

¹ How DB2 Connect handles the conversion of data between unalike systems.

¹ How to customize your DB2 Connect workstation for your particular national
language environment.

¹ How to customize your host Coded Character Set Identifier (CCSID) setting.

Code Page and Language Support

During installation of DB2, the country, codepage and regional settings are established.
You can, however, change these settings after installing DB2. This includes changing
regional settings such as code page, country language (for monetary, date, and
numeric formatting) and time zone. When a new connection to a database is made, the
database manager uses these new values.

Table 16 on page 264 shows the languages into which the DB2 messages are
translated.

Note:  The code page values in the table that follows are also used as directory names
on DB2 CD-ROMs. For example, a reference to x:\language\win32\install

would be x:\en\win32\install for English. For more detailed information on
the languages and code pages support, refer to the Administration Guide.

| You must ensure that your regional settings are set correctly. DB2 may not
| produce the expected results if the country, code page, or regional settings
| are incorrect for the intended language.
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Table 16. Languages and Code Pages

Country Code Language Country Code Language

BG Bulgarian HU Hungarian

BR Brazilian
Portuguese

IL Hebrew

CN Simplified Chinese
(PRC)

IT Italian

CZ Czech JP Japanese

DE German KR Korean

DK Danish NO Norwegian

EN English PL Polish

ES Spanish RU Russian

FI Finnish SE Swedish

FR French SI Slovenian

GR Greek TR Turkish

TW Traditional Chinese
(Taiwan)

Conversion of Character Data

When character data is transferred between machines, it must be converted to a form
that the receiving machine can use.

For example, when data is transferred between the DB2 Connect workstation and a
DRDA server, it is usually converted from a workstation code page to a host CCSID,
and vice versa. If the two machines use different code pages or CCSIDs, code points
are mapped from one code page or CCSID to the other. This conversion is always
performed at the receiver.

Character data sent to a database consists of SQL statements and input data.
Character data sent from a database consists of output data. Output data that is
interpreted as bit data (for example, data from a column declared with the FOR BIT
DATA clause) is not converted. Otherwise all input and output character data is
converted if the two machines have different code pages or CCSIDs.

For example, if DB2 Connect is used to access DB2 for OS/390 or DB2/MVS data, the
following happens:

1. DB2 Connect sends an SQL statement and input data to OS/390 or MVS.
2. DB2 for OS/390 converts the data to an EBCDIC CCSID and processes it.
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3. DB2 for OS/390 sends the result back to the DB2 Connect workstation.
4. DB2 Connect converts the result to an ASCII or ISO code page and returns it to

the user.

The table that follows shows the conversions that are supported between code pages
(on the workstation) and CCSIDs (on the host).

For more detailed information about supported code page conversions, refer to the
Administration Guide.

Table 17. Workstation Code Page to Host CCSID Conversion

Host CCSIDs Code Page Countries

037, 273, 277, 278, 280, 284,
285, 297, 500, 871,
1140-1149

437, 819, 850, 858, 860,
863, 1004, 1051, 1252,
1275

Albania, Australia, Austria,
Belgium, Brazil, Canada,
Denmark, Finland, France,
Germany, Iceland, Ireland,
Italy, Latin America,
Netherlands, New Zealand,
Norway, Portugal, South
Africa, Spain, Sweden,
Switzerland, UK, USA

423, 875 737, 813, 869, 1253, 1280 Greece

870 852, 912, 1250, 1282 Croatia, Czech Republic,
Hungary, Poland, Romania,
Serbia/Montenegro (Latin),
Slovakia, Slovenia

1025 855, 866, 915, 1251, 1283 Bulgaria, FYR Macedonia,
Russia, Serbia/Montenegro
(Cyrillic)

1026 857, 920, 1254, 1281 Turkey

424 862, 916, 1255 Israel - see note 3 below

420 864, 1046, 1089, 1256 Arabic countries - see note 3
below

838 874 Thailand

930, 939, 5026, 5035 932, 942, 943, 954, 5039 Japan

937 938, 948, 950, 964 Taiwan

933, 1364 949, 970, 1363 Korea

935, 1388 1381, 1383, 1386 People's Republic of China

1112, 1122 921, 922 Estonia, Latvia, Lithuania

1025 915, 1131, 1251, 1283 Belarus

1123 1124, 1125, 1251 Ukraine
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Notes:

1. Code page 1004 is supported as code page 1252.

2. In general, data can be converted from a code page to a CCSID and back again to
the same code page with no change. The following are the only exceptions to that
rule:

¹ In double-byte character set (DBCS) code pages, some data containing
user-defined characters may be lost.

¹ For single-byte code pages defined within mixed-byte code pages, and for
some newer single-byte code pages, characters that do not exist is both the
source and the target may be mapped to substitution characters and then lost
when the data is converted back to the original code page.

| 3. For bidirectional languages, a number of special "BiDi CCSIDs" have been defined
| by IBM and are supported by DB2 Connect Version 5.2.

| If the bidirectional attributes of the database server are different from those of the
| client you can use these special CCSIDs to manage the difference.

| Refer to the Administration Guide for details of these special CCSIDs. Refer to the
| Release Notes for DB2 Connect Version 5.2 for detailed information about how to
| set them up for DRDA host connections.

| Bidirectional CCSID Support

| The following BiDi attributes are required for correct handling of Bidirectional data on
| different platforms:

| - Text type (LOGICAL vs VISUAL)

| - Shaping (SHAPED vs UNSHAPED)

| - Orientation (RIGHT-TO-LEFT vs LEFT-TO-RIGHT)

| - Numeral shape (ARABIC vs HINDI)

| - Symmetric swapping (YES or NO)

| Since defaults on different platforms are not the same, problems appear when DB2
| data is sent from one platform to another. For example, Windows platforms use
| LOGICAL UNSHAPED data, while data on OS/390 is usually in SHAPED VISUAL
| format. Therefore, without any support for these attributes data sent from DB2 for
| OS/390 to DB2 UDB on a Windows 32-bit operating systems workstation displays
| incorrectly.
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|  Bidirectional-specific CCSIDs
| The following bidirectional Coded Character Set Identifiers (CCSID) have been defined
| and are implemented with DB2 UDB:

| CCSID - Code - String

| - Page - Type

|  -------+--------+----------

|  00420 420 4

|  00424 424 4

|  08612 420 5

|  08616 424 6

|  12708 420 7

|  X'3F00' 856 4

|  X'3F01' 862 4

|  X'3F02' 916 4

|  X'3F03' 424 5

|  X'3F04' 856 5

|  X'3F05' 862 5

|  X'3F06' 916 5

|  X'3F07' 1255 5

|  X'3F08' 1046 5

|  X'3F09' 864 5

|  X'3F0A' 1089 5

|  X'3F0B' 1256 5

|  X'3F0C' 856 6

|  X'3F0D' 862 6

|  X'3F0E' 916 6

|  X'3F0F' 1255 6

|  X'3F10' 420 6

|  X'3F11' 864 6

|  X'3F12' 1046 6

|  X'3F13' 1089 6

|  X'3F14' 1256 6

|  X'3F15' 424 8

|  X'3F16' 856 8

|  X'3F17' 862 8

|  X'3F18' 916 8

|  X'3F19' 420 8

|  X'3F1A' 420 9

|  X'3F1B' 424 10

|  X'3F1C' 856 10

|  X'3F1D' 862 10

|  X'3F1E' 916 10

|  X'3F1F' 1255 10

|  X'3F20' 424 11

|  X'3F21' 856 11

|  X'3F22' 862 11

|  X'3F23' 916 11

|  X'3F24' 1255 11
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| Where CDRA String Types are defined:

| String - Text - Numerical - Orientation - Shaping - Symmetrical

| Type - Type - Shape - - - Swapping

|  ---------+-------+------------+-------------+-----------+-------------

| 4 Visual Arabic LTR Shaped OFF

| 5 Implicit Arabic LTR Unshaped ON

| 6 Implicit Arabic RTL Unshaped ON

|  7(*) Visual Arabic Contextual(*) Unshaped-Lig OFF

| 8 Visual Arabic RTL Shaped OFF

|  9 Visual Passthru RTL Shaped ON

|  10 Implicit Contextual-L ON

|  11 Implicit Contextual-R ON

| Note:  Field orientation is left-to-right (LTR) when the first alphabetic character is a
| Latin one, and right-to-left (RTL) when it is a bidirectional (RTL) character.
| Characters are unshaped, but LamAlef ligatures are kept, and not broken into
| constituents.
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 Appendix C. Naming Rules

Go to the section that describes the naming rules that you require information on:

¹ “General Naming Rules”
¹ “Database, Database Alias, and Catalog Node Names” on page 270
¹ “Object Names” on page 270
¹ “Usernames, Group Names, and Instance Names” on page 271
¹ “DB2SYSTEM Naming Rules” on page 272
¹ “Workstation Names (nname)” on page 272
¹ “Password Rules” on page 272

General Naming Rules

Unless otherwise specified, all names can include the following characters:

¹ A through Z

Note:  When used in most names, characters A through Z are converted from
lowercase to uppercase.

¹ 0 through 9
 ¹ @
 ¹ #
 ¹ $
 ¹ _ (underscore)

Unless otherwise specified, all names must begin with one of the following characters:

¹ A through Z
 ¹ @
 ¹ #
 ¹ $

Do not use SQL reserved words to name tables, views, columns, indexes, or
authorization IDs. A list of SQL reserved words is included in the SQL Reference.
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Database, Database Alias, and Catalog
Node Names

Database names are the identifying names assigned to databases in the database
manager.

Database alias names are synonyms given to remote databases. Database aliases
must be unique within the System Database Directory in which all aliases are stored.

When naming a database or database alias, see “General Naming Rules” on page 269.

In addition, the name you specify can contain 1 to 8 characters.

Notes:

1. To avoid potential problems, do not use the special characters @, #, and $ in a
database name if you intend to have a client remotely connect to a host database.
Also, because these characters are not common to all keyboards, do not use them
if you plan to use the database in another country.

2. On Windows NT systems, ensure that no instance name is the same as a service
name.

 Object Names

Database objects include:

 ¹ Tables
 ¹ Views
 ¹ Columns
 ¹ Indexes
¹ User-defined functions (UDFs)
¹ User-defined types (UDTs)

 ¹ Triggers
 ¹ Aliases
 ¹ Table spaces
 ¹ Schemas

When naming database objects, see “General Naming Rules” on page 269.

In addition, the name you specify:

¹ Can contain 1 to 18 characters
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¹ Cannot be any of the SQL reserved words that are listed in the SQL Reference.

Note:  Using delimited identifiers, it is possible to create an object that violates these
naming rules; however, subsequent use of the object could result in errors.

For example, if you create a column with a + or − sign included in the name and
you subsequently use that column in an index, you will experience problems
when you attempt to reorganize the table. To avoid potential problems with the
use and operation of your database, do not violate these rules.

Usernames, Group Names, and Instance
Names

Usernames are the identifiers assigned to individual users. When naming users,
groups, or instances, see “General Naming Rules” on page 269.

In addition, the name you specify:

¹ Can contain 1 to 8 characters

¹ Cannot be any of the following:

 – USERS
 – ADMINS
 – GUESTS
 – PUBLIC
 – LOCAL

¹ Cannot begin with:

 – IBM
 – SQL
 – SYS

¹ Cannot include accented characters

¹ In general, when naming users, groups, or instances:

– On OS/2, use uppercase names.
– On Windows 32-bit operating systems, use any case.
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Workstation Names (nname)

A workstation name is used to specify the NetBIOS name for a database server or
database client that resides on the local workstation. This name is stored in the
database manager configuration file. The workstation name is known as the workstation
nname. When naming workstations, see “General Naming Rules” on page 269.

In addition, the name you specify:

¹ Can contain 1 to 8 characters;
¹ Cannot include &, #, and @;
¹ Must unique within the network.

DB2SYSTEM Naming Rules

DB2SYSTEM names are used by DB2 to identify a physical DB2 machine, system, or
workstation within a network. On OS/2, you must specify the DB2SYSTEM name during
install. On Windows 32-bit operating systems, you do not need to specify a
DB2SYSTEM name; the DB2 setup program detects the NT Computer name and
assigns it to DB2SYSTEM.

When creating a DB2SYSTEM name, see “General Naming Rules” on page 269.

In addition, the name you specify:

¹ Must be unique within a network;
¹ Can contain a maximum of 21 characters.

 Password Rules

When determining passwords on OS/2 and Windows 3.x, the password you specify can
consist of a maximum of 8 characters. On all other operating systems, the word or
name you specify can consist of a maximum of 18 characters.
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Appendix D. List Files, Bind Files, and
Packages

 This appendix lists the bind files contained in different .lst files shipped with the
product. Although the contents of these lists are similar for each platform, the bind
packages are generated specifically for each platform. each package name can be
mapped back to the client platform.

Note that the Bind function in the DB2 Client Configuration Assistant and in the DB2
Data Sources Setup tool (included in DB2 Connect Personal Edition) choose the correct
bind files for you automatically.

Note:  In the following tables, under the Package Name  columns, each DB2 bind
package is represented as follows. For example, in the file name SQLabxYz:

¹ SQL identifies the bind package as a DB2 utility,
¹ ab identifies the utility,
¹ x represents the last digit of the year the product became available,
¹ Y represents the platform of the client,
¹ z represents the modification level.

Users on OS/2, Windows 32-bit operating systems, and AIX systems can use the
ddcspkgn  command to determine the package name for for individual bind files or list
(.lst) files. This command is found in the bin directory under the DB2 installation
directory. For example, on an AIX system, enter the following command with the bind
file in the local directory:

 /sqllib/bin/ddcspkgn db2ajgrt.bnd

The following list maps Y values to platforms:

xAz Clients for AIX
xHz Clients for HP-UX
xUz Clients for Solaris
xXz Clients for SINIX
xPz Clients for Power PC
xDz Clients for OS/2
xWz Clients for Windows
xNz Clients for Windows 32-bit operating systems
xMz Clients for Macintosh
xSz Clients for SCO OpenServer
xGz Clients for Silicon Graphics
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List Files Associated with DRDA Servers

The following table lists which bind files are included in the .lst file associated with a
particular DRDA host. The package associated with each bind file is also listed:

DRDA Server List File

OS/390 and MVS ddcsmvs.lst

VSE ddcsvse.lst

VM ddcsvm.lst

OS/400 ddcs400.lst

Table 18 (Page 1 of 2). DRDA Bind Files and Packages

Component Bind File
Name

Package
Name

MVS VM/VSE OS/400

DB2 Call Level Interface

Isolation level CS db2clics.bnd sqll1xyz yes yes yes

Isolation level RR db2clirr.bnd sqll2xyz yes yes yes

Isolation level UR db2cliur.bnd sqll3xyz yes no yes

Isolation level RS db2clirs.bnd sqll4xyz no no yes

Isolation level NC db2clinc.bnd sqll5xyz no no yes

Using MVS table
names

db2clims.bnd sqll7xyz yes no no

Using OS/400 table
names (OS/400 3.1 or
later)

db2clias.bnd sqllaxyz no no yes

Using VSE/VM table
names

db2clivm.bnd sqll8xyz no yes no

Command Line Processor

Isolation level CS db2clpcs.bnd sqlc2xyz yes yes yes

Isolation level RR db2clprr.bnd sqlc3xyz yes yes yes

Isolation level UR db2clpur.bnd sqlc4xyz yes yes yes

Isolation level RS db2clprs.bnd sqlc5xyz no no yes

Isolation level NC db2clpnc.bnd sqlc6xyz no no yes

REXX

Isolation level CS db2arxcs.bnd sqla1xyz yes yes yes

Isolation level RR db2arxrr.bnd sqla2xyz yes yes yes

Isolation level UR db2arxur.bnd sqla3xyz yes yes yes

Isolation level RS db2arxrs.bnd sqla4xyz yes yes yes
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Note:  If your DB2 for MVS/ESA system has APAR PN60988 installed (or if it is a later
release than Version 3 Release 1), you can add the bind files for isolation level
NC to the ddcsmvs.lst file.

Table 18 (Page 2 of 2). DRDA Bind Files and Packages

Component Bind File
Name

Package
Name

MVS VM/VSE OS/400

Isolation level NC db2arxnc.bnd sqla5xyz no no yes

Utilities

Export db2uexpm.bnd sqlubxyz yes yes yes

Import db2uimpm.bnd sqlufxyz yes yes yes
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Appendix E. Changing Your MVS Password

| DB2 Connect now provides an ability to change user passwords. This facility is
| especialy usefull for situations where host security service such as RACF is used to
| authenticate users. Previously changing host password would require users to log in to
| a TSO session to change their password. With the new password maintenace support
| provided by the DB2 Connect products users can issue SQL CONNECT statement from
| DB2 Command Line Processor (CLP), use PASSWORD button on DB2 Client
| Configuration Assistant (CCA), or press CHANGE button on the ODBC login dialog to
| change their host password.

| Changing MVS passwords from DB2 Connect workstations connected to DB2 for
| OS/390 V5.1 via TCP/IP does not require special set up on either MVS host or the DB2
| Connect workstation. Changing of MVS passwords on host systems conencted via
| SNA, however, does require that a special password expiration management program
| be set up on the host and that DB2 Connect workstation be configured to comunicate
| with this host program.

| The host password expiration management program is provided as part of the following
| MVS program products:

| ¹ MVS/ESA SP Version 4.2 or higher (password expiration management is a part of
| the APPC/MVS component)

¹ CICS/ESA Version 3.3 or higher

and have IBM Resource Access Control Facility (RACF) 1.9.2 installed.

You need to:

1 Configure the host's transaction program to receive your requests for password
expiration maintenance.

2 Configure your DB2 Connect workstation for communications with the host
transaction program.

Configuring the Host for Password
Expiration Management

Setting up Password Expiration Management facilities on MVS hosts is the
responsibility of MVS system programmers and is beyond the scope of this book. The
following publications provide detailed documentation:
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¹ MVS/ESA SP V5.x Planning: APPC Management, GC28-1503

¹ MVS/ESA SP V5.x APPC/MVS Handbook for the OS/2 Administrator, GC28-1504

¹ MVS/ESA SP V4.3 Planning: APPC Management, GC28-1110

¹ MVS/ESA SP V4.2 APPC/MVS Handbook for the OS/2 Administrator, GC28-1133

¹ CICS/ESA: RACF Security Guide (CICS 4.1), SC33-1185

¹ CICS/ESA: CICS-APPC Password Expiration Management Guide (CICS 3.3),
SC33-0921

¹ APPC Security MVS/ESA CICS/ESA OS/2, GG24-3960.

Configuring the DB2 Connect Workstation
for Password Expiration Management

Once the host password expiration management transaction program is configured you
will need to configure your DB2 Connect workstation to communicate with the host
program. This configuration involves two steps:

1. Define a symbolic destination name for the host password maintenance program in
the SNA subsystem on your DB2 Connect workstation.

| 2. Record this symbolic destination name in the DCS directory for the databases that
| reside on this host system.

Step 1. Define Symbolic Destination Name
How you define symbolic destination name for the host password expiration
management program depends on what SNA subsystem you are using:

¹ If you are using an SNA subsystem that can be configured by the DB2 Client
Configuration Assitant (CCA) then you should use CCA to configure this symbolic
destination name. You will need to obtain the LU name for the password expiration
management program from your MVS administrator.

¹ If your SNA subsystem can not be configured using DB2 CCA you should follow
documentation provided with your SNA subsystem to configure the symbolic
destination name. You will need to obtain the following information from your MVS
administrator:

– Network name for the host that you are connecting to

– LU name for the host password expiration management program

When configuring symbolic destination name you will also need to specify
x'06F3F0F1' (hexadecimal number) for the Transaction Program (TP) name and
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set security to "NONE". You can specify mode such as #INTER or any other mode
that your MVS may sugest to you.

Step 2. Record Symbolic Destination Name in
the DCS Directory

| If you are running DB2 Connect on a platform that provides DB2 CCA then you should
| use DB2 CCA to update your DCS directory with the symbolic destination name for the
| host password expiration management program. You should be able to do this
| regardless of the SNA subsystem on your DB2 Connect workstation.

| You can also use catalog dcs database command (from DB2 CLP) to record the
| symbolic destination name in the DCS directory. For example:

|  catalog dcs database db1 as dsn_db_1 parms ",,,,,,,CHGPWD_SDN=pempgm"

| records "pempgm" as the symbolic destination name that is to be used when users
| request to change passwords for database "db1".
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 Appendix F. Notices

Any reference to an IBM licensed program in this publication is not intended to state or
imply that only IBM’s licensed program may be used. Any functionally equivalent
product, program or service that does not infringe any of IBM’s intellectual property
rights may be used instead of the IBM product, program, or service. Evaluation and
verification of operation in conjunction with other products, except those expressly
designated by IBM, is the user’s responsibility.

IBM may have patents or pending patent applications covering subject matter in this
document. The furnishing of this document does not give you any license to these
patents. You can send license inquiries, in writing, to the

IBM Director of Licensing,
 IBM Corporation,

500 Columbus Avenue,
Thornwood, NY, 10594

 USA.

Licensees of this program who wish to have information about it for the purpose of
enabling: (i) the exchange of information between independently created programs and
other programs (including this one) and (ii) the mutual use of the information which has
been exchanged, should contact:

IBM Canada Limited
 Department 071

1150 Eglinton Ave. East
North York, Ontario

 M3C 1H7
 CANADA

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

This publication may contain examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.
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 Trademarks

The following terms are trademarks or registered trademarks of the IBM Corporation in
the United States and/or other countries:

ACF/VTAM
ADSTAR
AISPO
AIX
AIXwindows
AnyNet
APPN
AS/400
CICS
C Set++
C/370
DATABASE 2
DatagLANce
DataHub
DataJoiner
DataPropagator
DataRefresher
DB2
Distributed Relational Database Architecture
DRDA
Extended Services
FFST
First Failure Support Technology
IBM
IMS
Lan Distance

MVS/ESA
MVS/XA
NetView
OS/400
OS/390
OS/2
PowerPC
QMF
RACF
RISC System/6000
SAA
SP
SQL/DS
SQL/400
S/370
System/370
System/390
SystemView
VisualAge
VM/ESA
VSE/ESA
VTAM
WIN-OS/2

Trademarks of Other Companies

The following terms are trademarks or registered trademarks of the companies listed:

C-bus is a trademark of Corollary, Inc.

HP-UX is a trademark of Hewlett-Packard.

Java, HotJava, Solaris, Solstice, and Sun are trademarks of Sun Microsystems, Inc.

Microsoft, Windows, Windows NT, Visual Basic, and the Windows logo are trademarks
or registered trademarks of Microsoft Corporation.
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PC Direct is a trademark of Ziff Communications Company and is used by IBM
Corporation under license.

SCO is a trademark of The Santa Cruz Operation.

SINIX is a trademark of Siemens Nixdorf.

UNIX is a registered trademark in the United States and other countries licensed
exclusively through X/Open Company Limited.

Other company, product, or service names, which may be denoted by a double asterisk
(**), may be trademarks or service marks of others.
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 Index

Numerics
2PC (two-phase commit support) 9

A
Access Profile

creating 218
using 218

accounting information
sending to DRDA server 139

Administrator name
valid names 33

APPC
configuring on Windows 3.x 49
configuring with the Data Sources Setup tool 49
software requirements 24
support on OS/2

Communications Manager for OS/2 61
Communications Server for OS/2 61

support on Windows NT
Communications Server for Windows NT 83, 93
Communications Server for Windows NT SNA

Client 105
IBM Communications Server for NT 53
IBM Communications Server for NT SNA

Client 53
Integrated SNA Support 53, 77
Microsoft SNA Client 121

application development
using ODBC 149

application programs
binding 49

application types
supported 3

authority
levels 141

B
bidirectional CCSID support 266
Bidirectional language support 9, 266
bind files and package names 273
BIND rules

BIND rules (continued)
DYNAMICRULES 8

binding
utilities and applications 148

book
road map xii

C
CCSIDs 264
CD-ROM

installing DB2 Universal Database 29, 30
character substitution 266
Client Configuration Assistant

administering clients communications 133
changing privileges 143
client profiles 134

exporting 220
using 219

discover 223
discovering databases 134
overview 53
searching the network 133, 221
setting configuration parameters 177, 225
using access profiles 218

client profile
exporting 220

CLP
See using the command line processor (CLP)

code page conversion exceptions 266
code page conversions 263
code pages 264
Coded Character Set Identifier (CCSID) 263
Command Center

entering DB2 commands 161
entering SQL statements 161

commands
db2set 166
echo 167, 168
set 167

communication protocols
APPC 25, 61
Named Pipes 26
NetBIOS 26
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communication protocols (continued)
TCP/IP 25, 26

configuring for DRDA host access 240
communications

configuring the client 133
managing

Client Configuration Assistant 133
Communications Server for Windows NT

configuring manually 83, 93
version required 83, 93

Communications Server for Windows NT SNA Client
configuring manually 105
version required 105

components
selecting

on Windows 3.x 41
on Windows NT 34

configuration parameters
dft_account_str 139
setting DB2 143, 165, 177
SYSADM_GROUP 143

configuring
APPC

for OS/2 61
host communications

overview 59
ODBC driver 152, 154

configuring client communications
setting configuration parameters 177
using the Client Configuration Assistant 133

configuring communications
using Client Configuration Assistant 133

configuring server communications
setting DB2COMM 218

connecting to a database 142
connections to DRDA hosts

direct to DRDA host 14, 240
overview of scenarios 13
through communications gateway 15, 240

conversion 264
conversion exceptions 266
country code page support 264

D
data conversion

CCSIDs 264
code pages 264

data conversion exceptions 266

data source definitions
defining 49
importing 51
sharing 50

Data Source Setup tool
changing MVS password with 277
using 49

data types supported by DB2 Connect Version 5.2 10
database

naming rules 270
database alias

naming rules 270
database objects

naming rules 270
DB2 Connect

configuring on OS/2 61
overview 3
supported application types 3

DB2 Connect Enterprise Edition
configuration planning 21
memory requirements 21
when to use 15

DB2 Connect Personal Edition
host communications

OS/2 24
Windows 3.x 26
Windows 95 25
Windows NT 24, 25

installing on Windows 3.x 41
operating systems supported 24
software requirements 24

DB2 Extended Enterprise Edition
disk requirements 22

DB2 for MVS/ESA
updating system tables 237, 238

DB2 Installer
See installation

DB2 library
books 254
Information Center 261
language identifier for books 257
late breaking information 257
online help 252
ordering printed books 260
printing PostScript books 259
searching online books 259
setting up document server 258
SmartGuides 251
structure of 251
viewing online books 258
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DB2 server, definition xi
DB2 Universal Database

getting started 141
installing on OS/2 30

DB2 Workgroup Edition
disk requirements 22

db2.ini file
environment keywords 169

DB2ACCOUNT 140
DB2DMNBCKCTLR

registry value 172
db2set command

using 166
DCE 7
dft_account_str 139
Discovery

choosing a discovery method 223
searching the network 221
setting Discovery parameters 225

disk requirements
client 22
server 22

Distributed Relational Database Architecture (DRDA)
connections

configuring TCP/IP 240
double-byte characters 266
DRDA server

sending accounting information 139

E
enhancements in DB2 Connect Version 5.2 7
environment variables

DB2INSTANCE 174
db2instprof 174
db2path 174

F
files

bind files 273
list files 273

fixed disks
hardware requirements 22

G
GET SNAPSHOT support for DB2 Connect 9

H
hardware requirements

fixed disk 22
host character sets 263

I
information

road map xii
installation

CID using SystemView LAN 38, 207
clients

OS/2 29
disk requirements

client 22
server 22

errors 38, 207
log 38, 207
servers

OS/2 29
unattended

OS/2 189, 195
Windows 3.x 189
Windows 95 199
Windows NT 199

instances
naming restrictions 271

Integrated SNA Support
configuring manually 77

J
Java, running programs 155
JDBC

See ?
JDBC, running programs 155

L
LANG environment variable 263
language support 263
list files 273
logging off the system 141
logging on to the system 141

M
managing connections

client
using the Client Configuration Assistant 133
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managing connections (continued)
server

using the Client Configuration Assistant 133
manuals

See book
Microsoft ODBC Driver Manager 151
Microsoft SNA Client

configuring 121
version required 121

Microsoft Transaction Server support 8

N
naming rules

database 270
database alias 270
database objects 270
general 269
groups 271
instance names 271
password 272
userids 271
username 34, 271
workstation name (nname) 272

National language support 264
National Language Support (NLS)

bidirectional CCSID support 266
codepage support 263
configuring 263
determining codepage 264

NetBIOS
supports SEARCH discovery 224

network scenarios 13
new data types supported by DB2 Connect Version

5.2 10
NLS

See National Language Support (NLS)

O
ODBC

registering the driver manager 151
running ODBC-enabled applications 149
running programs 149

ODBC performance 8
odbcad32.exe 151
OS/400

commands
DSPNETA 245
DSPRDBDIRE 246
WRKLIND 65, 245

OS/400 (continued)
commands (continued)

WRKMODD 65, 245

P
parameters

SYSADM_GROUP 143
password

changing on MVS 277
naming rules 272

passwords
change support through DRDA 8
changing 7

planning
DB2 configuration 18
DB2 Connect configuration 16

privileges
required 143

product
descriptions 3
overview 3

profile registry
using 165

R
registering

ODBC driver manager 151
registry value

DB2DMNBCKCTLR 172
registry values

db2account 139, 140, 170
db2clientadpt 176
db2clientcomm 176
db2codepage 171
db2comm 174
db2country 171
db2dbdft 171
db2dirpathname 176
db2discoverytime 171
db2include 172
db2instdef 172
db2nbadapters 175
db2netreq 175
db2options 172
db2route 176
db2slogon 172
db2timeout 172
db2tracename 173
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registry values (continued)
db2traceon 173
db2trcflush 173
db2trcsyserr 173
db2yield 174
general 170
setting 165

remote installation
OS/2 195

Netfinity Server 195
response files

OS/2 191
Windows 3.x 191
Windows 32-bit operating systems 202

restrictions
instance name 271

running applications
database client 147
ODBC considerations 149

S
SCO 10
Set Client API 9
setting

environment variables 165
setting up client communications

using the Client Configuration Assistant 133
setting up document server 258
SNA

configuring Communications Server for Windows NT
manually 83, 93

configuring Communications Server for Windows NT
SNA Client manually 105

configuring Integrated SNA Support on Windows
3.x 49

configuring Microsoft SNA Client manually on
Windows 121

configuring Wall Data Rumba manually on Windows
NT 49

configuring with the Data Sources Setup tool 49
software registration 144
software requirements

communication protocols 23
DB2 Connect 23

stored procedures 8
Syncpoint manager (SPM) 9

configuration 10
SYSADM

privileges
controlling 143

SYSADM_GROUP parameter 143
SYSPLEX support 8
System Monitor 9

T
TCP/IP

configuring DB2 for OS/390 for 232
configuring host connections 13, 49, 54, 240
set with db2set 174
software requirements 24, 26
supports SEARCH discovery 224

territory 263
two-phase commit support 9

U
UDFs 8
unattended installation

OS/2 195
Netfinity Server 195

Windows 32-bit operating systems
Server Management System (SMS) 207

user privileges
See privileges

User Profile Management (UPM)
adding users 179
administering users 179
logon command 179
passwords 179

username
naming rules 271

using the command line processor (CLP)
connecting to a database 142

utilities
binding 49, 147

V
VTAM

DB2 Connect uses independent LU 72
sample definitions 233
sample logon mode table entry 236
sample PU and LU definitions 235

W
Wall Data Rumba

configuring manually 77
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XA applications (two-phase commit support) 10
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 Contacting IBM

This section lists ways you can get more information
from IBM.

If you have a technical problem, please take the time to
review and carry out the actions suggested by the
Troubleshooting Guide before contacting DB2 Customer
Support. Depending on the nature of your problem or
concern, this guide will suggest information you can
gather to help us to serve you better.

For information or to order any of the DB2 Universal
Database products contact an IBM representative at a
local branch office or contact any authorized IBM
software remarketer.

Telephone

If you live in the U.S.A., call one of the following
numbers:

¹ 1-800-237-5511 to learn about available service
options.

¹ 1-800-IBM-CALL (1-800-426-2255) or
1-800-3IBM-OS2 (1-800-342-6672) to order
products or get general information.

¹ 1-800-879-2755 to order publications.

For information on how to contact IBM outside of the
United States, see Appendix A of the IBM Software
Support Handbook. You can access this document by
accessing the following page:

http://www.ibm.com/support/

then performing a search using the keyword “handbook.”

Note that in some countries, IBM-authorized dealers
should contact their dealer support structure instead of
the IBM Support Center.

World Wide Web
http://www.software.ibm.com/data/
http://www.software.ibm.com/data/db2/library/

The DB2 World Wide Web pages provide current DB2
information about news, product descriptions, education
schedules, and more. The DB2 Product and Service
Technical Library provides access to frequently asked
questions, fixes, books, and up-to-date DB2 technical
information. (Note that this information may be in English
only.)

Anonymous FTP Sites
ftp.software.ibm.com

Log on as anonymous. In the directory /ps/products/db2,
you can find demos, fixes, information, and tools
concerning DB2 and many related products.

Internet Newsgroups
comp.databases.ibm-db2, bit.listserv.db2-l

These newsgroups are available for users to discuss
their experiences with DB2 products.

CompuServe
GO IBMDB2  to access the IBM DB2 Family forums

All DB2 products are supported through these forums.

To find out about the IBM Professional Certification
Program for DB2 Universal Database, go to
http://www.software.ibm.com/data/db2/db2tech/db2cert.html
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